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Information on Use
Precautions When Displaying a Still Image

A still image may cause permanent damage to the TV screen.
Do not display a still image and partially still image on the LED panel for more than 2 hours as it can cause screen 
image retention. This image retention is also known as screen burn. To avoid such image retention, reduce the degree of 
brightness and contrast of the screen when displaying a still image.

Watching the LED TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen.  
Playing a DVD or a game console may cause a similar effect to the screen.  
Damages caused by the above effect are not covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. 
To prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images. 

WARNINGS:
Image retention, commonly known as screen burn-in, can occur on most types of television if the same image is displayed continuously. 
The most common causes of image retention are logos that remain stationary on the TV screen. These logos are common on many 
programmes received via a Set-top Box.
To reduce this risk, avoid displaying still images for long durations and lower the brightness or contrast settings to decrease the 
intensity of the picture. Extended viewing of movies and programs in aspect ratios that are different from the aspect ratio of the TV may 
cause image retention. Always endeavour to avoid black borders top or bottom by using the zoom function. This will help eliminate the 
black borders and fit the picture to the entire area of the screen. Using a video game console may cause image retention and is not 
recommended. When using a PC input, avoid displaying still images for long durations and reduce the brightness or contrast settings to 
decrease the intensity of the picture.

IMPORTANT:
Image retention issues are not covered by your Samsung® warranty.

Digital TV (DVB-T) Notice

Functionalities related to Digital TV(DVB) are only available in countries/areas where DVB-T (MPEG2 and MPEG4 AVC) 
digital terrestrial signals are broadcasted or where you are able to access to a compatible DVB-C(MPEG2 and MPEG4 
AAC) cable- TV service. Please check with your local dealer the possibility to receive DVB-T or DVB-C signal.
DVB-T is the DVB European consortium standard for the broadcast transmission of digital terrestrial television and 
DVBC is that for the broadcast transmission of digital TV over cable. However, some differentiated features like EPG 
(Electric Programme Guide), VOD (Video on Demand) and so on, are not included in this specification. So, they cannot be 
workable at this moment.
Although this TV set meets the latest DVB-T and DVB-C standards, as of [August, 2008], the compatibility with future 
DVB-T digital terrestrial and DVB-C digital cable broadcasts cannot be guaranteed.
Depending on the countries/areas where this TV set is used some cable-TV providers may charge an additional fee for 
such a service and you may be required to agree to terms and conditions of their business.
Some Digital TV functions might be unavailable in some countries or regions and DVB-C might not work correctly with 
some cable service providers.
For more information, please contact your local Samsung customer care centre.
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EnglishTrademark & Label License Notice

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 
incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.

DivX® Certified to play DivX® video, including premium content.

Symbol

Note

One-Touch Button

TOOL Button

Press

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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Getting Started
Installing the Stand

1	 Attach your LED TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

2	 Fasten screws at position 1 and then fasten screws at position 2. 
Stand the product up and fasten the screws. If you fasten the screws with the LED 
TV placed down, it may lean to one side.
The stand is installed for models with the screen size of 37 inch and above.

■
■

■

■

■

Disconnecting the Stand
1	 Remove four screws from the back of the TV.								     

2	 Separate the stand from the TV.
Two or more people should carry the TV.								     

3	 Cover the bottom hole with the cover.								      

■

1 2 3

1

2
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Installing the Wall Mount Kit
Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the Wall 
Mount items. Contact a technician for assistance when installing the wall mounted bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or 
others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.
Remove the stand and cover the bottom hole with a cap and fasten with two screws.

■

■

Assembling the Cables
Stand Type

Enclose the cables in the Holder-Wire Cable so that the cables are not visible through the transparent stand.

Wall-Mount Type

■

1

3

2

1

3

2

1

1
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Anti-Theft Kensington Lock
The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer. Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately. 
The location of the Kensington Lock may be different depending on its model.

1	 Insert the locking device into the Kensington slot on the LED TV (1) and turn it in 
the locking direction (2).

2	 Connect the Kensington Lock cable (3).

3	 Fix the Kensington Lock to a desk or a heavy stationary object.

■
■

Preparing before installing Wall-Mount
To install a wall-mount, use the Holder-Ring 1.

Case A. Installing the SAMSUNG Wall-Mount Case B. Installing another company’s Wall-Mount

Securing the Installation Space
Keep the required distances between the product and other objects (e.g. walls) to ensure proper ventilation. 
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature of the product.
Install the product so the required distances shown in the figure are kept.

When using a stand or wall-mount, use parts provided by Samsung Electronics only.
If you use parts provided by another manufacturer, it may result in a problem with the product or an injury due to the product falling.
If you use parts provided by another manufacturer, it  may result in a problem with the product or fire due to an increase in the internal 
temperature of the product due to poor ventilation.

The appearance may differ depending on the product.

When installing the product with a stand When installing the product with a wall-mount

10 cm

10 cm

10 cm

10 cm

10 cm10 cm

10 cm

■

■

3

1

2
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Securing the TV to the Wall
Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. 
In particular, ensure your children do not hang over or destabilize the TV; 
doing so may cause the TV to tip over, causing serious injuries or death. 
Follow all safety precautions provided on the included Safety Flyer. For 
added stability, install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling:

1	 Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 
screws have been firmly installed onto the wall.

You may need additional material such as an anchor depending on the type of 
wall.
Since the necessary clamps, screws, and string are not supplied, please 
purchase these additionally.

2	 Remove the screws from the centre back of the TV, put the screws into the clamps, 
and then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications:

For a 32 ~ 40 Inch LED TV: M6 X L15
For a 40 ~ 55 inch LED TV : M8 X L30

3	 Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Untie the string before moving the TV.

4	 Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.

■

■

■

■
�
�

■
■

■

Wall

Wall
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Accessories
Please make sure the following items are included with your LED TV. If any items are missing, contact your dealer.

Remote Control & Batteries 
(AAA x 2)

Mini Remote Control &
Batteries (3V) Cover-Bottom Cleaning Cloth

User Manual Stand Screw X 5 Programme CD Holder-Wire Cable
(Depending on the model)

Component Cable SCART Cable Holder-Ring (4ea) Holder-Wire Stand

Holder-Wire (3ea) AV Cable

■

The items colour and shape may vary depending on the model.
Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice in order to enhance product performance.

■
■

(M4 X L10)
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Viewing the Control Panel
The product colour and shape may vary depending on the model.
The front panel buttons can be activated by touching it with your finger.

■

■

Speakers

Aim the remote control towards 
this spot on the TV.
Press to turn the TV on and off.

Toggles between all the available input 
sources.  
In the on-screen menu, use this button as 
you would use the ENTERE button on 
the remote control.

Press to see an on-screen 
menu of your TV’s features.

Press to increase or decrease the 
volume. In the on-screen menu, use 
the Y buttons as you would use 
the ◄ and ► buttons on the remote 
control.

Press to change channels. In the 
on-screen menu, use the z 
buttons as you would use the 
▼ and ▲ buttons on the remote 
control.
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Viewing the Connection Panel
The product colour and shape may vary depending on the model.

1	 KENSINGTON LOCK (depending on the model)
	 The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to use a 

locking device, contact the dealer where you purchased the TV.
The location of the Kensington Lock may be different depending on its model.
When connecting, use the appropriate connector.

2	 LAN
	 Connect a LAN cable to this port to connect to the Network.
3	 ANT IN
	 Connects to an antenna or cable TV system.
4	 EXT (RGB)
	 Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.

When connecting, use the appropriate connector.
In EXT Mode, DTV Out supports MPEG SD Video and Audio only.
Input/Output Specification

Connector Input Output
Video Audio (L / R) RGB Video + Audio (L / R)

EXT O O O Only TV or DTV output is available.

■

■
■

■
■
■

21 3 4 65

9

0

!

0

@

#

7

8

[TV Rear Panel]

Power Input
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5	 AV IN [VIDEO] / [R-AUDIO-L]
	 Video and audio inputs for external devices, such as a camcorder or VCR.

When connecting, use the appropriate connector.
6	 COMPONENT IN 
	 Connects Component video / audio.

When connecting, use the appropriate connector.
7	 PC IN
	 Connects to the video output jacks on your PC.

If your PC supports an HDMI connection, you can connect this to the HDMI IN 1(DVI), 2, 3 or 4 terminal.
If your PC supports a DVI connection, you can connect this to the HDMI IN 1(DVI) / PC/DVI AUDIO IN terminal.

8	 PC/DVI AUDIO IN
	 Connect to the audio output jack on your PC.
	 DVI audio outputs for external devices.
9	 HDMI IN 1(DVI), 2, 3, 4
	 Connects to the HDMI jack of a device with an HDMI output.

No sound connection is needed for an HDMI to HDMI connection.
Use an HDMI cable which is smaller than 14mm.
What is HDMI?

HDMI(High-Definition Multimedia Interface), is an interface that enables the transmission of digital audio and video 
signals using a single cable.
The difference between HDMI and DVI is that the HDMI device is smaller than DVI’s one.

The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable Box 
/ Satellite receiver (Set-Top Box) supporting HDMI versions older than 1.3 are connected. When connecting an older HDMI 
cable and there is no sound, connect the HDMI cable to the HDMI IN 1(DVI) jack and the audio cables to the PC/ DVI AUDIO 
IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / Cable Box / 
Satellite receiver (Set-Top Box) to confirm the HDMI version, then request an upgrade.
Use the HDMI IN 1(DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI adapter (DVI to 
HDMI) for video connection and the PC/DVI AUDIO IN jacks for audio. When using an HDMI / DVI cable connection, you must 
use the HDMI IN 1(DVI) jack.
HDMI cables that are not 1.3 may cause annoying flicker or no screen display.

0	 USB1(HDD) / USB2
	 Connector for software upgrades and Media Play, etc. 
	 You can connect to Samsung’s network wirelessly using the ‘Samsung Wireless LAN Adapter’ (Sold separately).

For USB HDD, use the USB1 (HDD) port.
!	 DIGITAL AUDIO OUT (OPTICAL)
	 Connects to a Digital Audio component such as a Home theatre receiver.

When a Digital Audio System is connected to the DIGITAL AUDIO OUT (OPTICAL) jack: Decrease the volume of the TV and 
adjust the volume level with the system’s volume control.
5.1CH audio is possible when the TV is connected to an external device supporting 5.1CH.
When the receiver (home theatre) is set to On, you can hear sound output from the TV’s Optical jack. When the TV is displaying a 
DTV(air) signal, the TV will send out 5.1 channel sound to the Home theatre receiver. When the source is a digital component such 
as a DVD / Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) and is connected to the TV via HDMI, only 2 channel sound 
will be heard from the Home Theatre receiver. If you want to hear 5.1 channel audio, connect the digital audio out jack on DVD / 
Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) directly to an Amplifier or Home Theatre, not the TV.

@	 COMMON INTERFACE Slot
Insert CI (Common Interface) card into the slot.
When not inserting ‘CI CARD’ in some channels, ‘Scrambled Signal’ is displayed on the screen.
The pairing information containing a telephone number, CI CARD ID, Host ID and other information will be displayed in about 
2~3 minutes. If an error message is displayed, please contact your service provider.
When the channel information configuration has finished, the message ‘Updating Completed’ is displayed, indicating that the 
channel list is now updated.

You must obtain a CI CARD from a local cable service provider. Remove the CI CARD by carefully pulling it out with 
your hands since dropping the CI CARD may cause damage to it.
Insert the CI-Card in the direction marked on it.
The place of the COMMON INTERFACE Slot may be different depending on its model. 
CAM is not supported in some countries and regions, check with your authorized dealer.
The CI+ function is only applicable to LE********P. 
If you have some problems, please contact to service provider.

#	 EX-LINK
	 Connector for service only.

■

■

■
■

■
■
■

�

�
■

■

■

■

■

■
■

■
■
■

■

�

�
�
�
�
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Connections

OPTICAL (Digital)

AUDIO (Analog)

Be
st

No
rm

al

Digital Audio connection

Digital Audio System

Using an Optical Cable

OPTICAL

HD connection

Using an HDMI Cable
HDMI OUT

Using a D-Sub Cable
PC OUTAUDIO OUT

HD connection

Using an HDMI/DVI Cable

DVI OUTAUDIO OUT

BN68-01985L_Eng-1.indd   14 2009-03-27   �� 6:42:47



15

English
Getting Started

Mini Remote Control
The Mini Remote Control is a simplified remote control that consists of the power, 
channel and volume buttons only.

1	 Television Standby button.
This button only works when you press it for longer than 1.5 seconds.

2	 < : Next channel / > : Previous channel		   

3	 + : Volume up / – : Volume down 

4	 IrDA transmitter
Use the Mini Remote Control so that this part faces the TV.

Installing Batteries in the Remote Control
Normal Remote Control

1	 Lift the cover at the back of the remote control upward as shown in the figure.		
			

2	 Install two AAA size batteries. 
Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside 
the compartment.

3	 Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using 
the remote control for a long time. (Assuming typical TV usage, the batteries 
should last for about one year.) OPERATION

Mini Remote Control

1	 Turn the battery cover counterclockwise to unlock it and then separate the battery 
cover.					   

2	 Insert the corresponding 3V Lithium battery. 

3	 Place the battery cover into the remote control aligning it with the grooves and then 
turn the battery cover clockwise to lock the cover.

If the remote control doesn’t work, check the following:
Is the TV power on? 
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?OPERATION

■

■

■

■

■

■
�
�
�
�
�

1
4

2

3

2

3

OPEN

CLOSE
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Teletext Functions (p. 83)

0 Teletext mode selection 
(LIST / FLOF) 5 Teletext reveal 3 Teletext previous page

8 Teletext store : Exit from the Teletext display 6 Teletext index
4 Teletext size selection 1 Teletext sub page 9 Teletext hold

Colour buttons Fastext topic selection 2 Teletext next page 7 Teletext cancel

Viewing the Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

■

■

■

Turns the TV on and off.

Press to change the channel.

Press to switch to your 
favourites channels. (p. 22)

Press to display information 
on the TV screen. (p. 18)

Displays the main on-screen 
menu. 
Use to quickly select frequently 
used functions.

Press to use various internet 
services to view useful formation 
and entertaining content. (p. 70)

Use these buttons in the 
Channel list, Internet@TV, 
Media Play menu, etc.
Press to increase or decrease 
the volume.
Alternately select Teletext, 
Double, or Mix. (p. 83)

Displays the Channel List on 
screen. (p. 22)
Use these buttons in the Media 
Play and Anynet+ modes. (∏: 
This remote can be used to control 
recording on Samsung recorders 
with the Anynet+ feature)

Selects the TV mode directly. 
(p. 83) 

Pressing the ON/OFF @ light 
button toggles between on and 
off. When the remote control is 
on, and a button is pressed on 
the remote control, the remote 
control buttons will be lit for a 
moment. (Using the remote 
control with the ON/OFF @ 
light button set to On will reduce 
the battery usage time.)

Enables you to return to the 
previous channel you were 
watching.

Displays the Electronic 
Programme Guide (EPG).  
(p. 21)
Returns to the previous menu.

Use to select on-screen menu 
items and change menu values.

Press to exit the menu.

Press to change channels.

Press to display and select the 
available video sources. (p. 40)
Press to temporarily cut off the 
sound. (p. 41)
Allows you to play music files, 
pictures, and movies. (p. 44) 
This function enables you to 
view the Content Library. (p. 61)

Displays the Digital subtitle. 
(p. 31)

Audio Description selection.  
(p. 28)
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Basic Operation
Placing Your Television in Standby Mode
Your set can be placed in standby mode in order to reduce the power consumption. The standby mode can be useful when 
you wish to interrupt viewing temporarily (during a meal, for example).

Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and 
subsequently.

1	 Press the POWERP button. 
You can also use the POWERP button on the TV.
The message Select the OSD Language. is displayed.

2	 Press the ENTERE button. Select the appropriate language by pressing the  
▲ or ▼ button. Press the ENTERE button to confirm your choice.

3	 Press the ◄ or ► button to select Store Demo or Home Use, then the 
ENTERE button.

We recommend setting the TV to Home Use mode for the best picture in your 
home environment.
Store Demo mode is only intended for use in retail environments.
If the unit is accidentally set to Store Demo mode and you want to return to 
Home Use (Standard): Press the volume button on the TV. When the volume 
OSD is displayed, press and hold the MENU button on the TV for 5 seconds.

4	 Press the ENTERE button. Select the appropriate country by pressing the  
▲ or ▼ button. Press the ENTERE button to confirm your choice.

5	 Press the ▲ or ▼ button to select Air or Cable, then press the ENTERE button.
Air: Air antenna signal.
Cable: Cable antenna signal.

6	 Press the ▲ or ▼ button to select the channel source to memorize.  
Press the ENTERE button to select Start.

When setting the antenna source to Cable, a step appears allowing you to 
set a value for the digital channel search. For more information, refer to pages 
19~20..
Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
The channel search will start and end automatically.

7	 Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then press 
the ENTERE button.

If you select Manual, Set current date and time is displayed. 
If you have received a digital signal, the time will be set automatically. If not, 
select Manual to set the clock.

8	 The description for the connection method providing the best HD screen quality is 
displayed. Check the description and press the ENTERE button.

9	 Press the ◄ or ► button to select See Product Guide or Watch TV. Press the 
ENTERE button.

See Product Guide: You are moved to the Product Guide where you can 
view the introduction to the main functions of your new HDTV.
Watch TV: You can watch the set broadcasting channel.

■
■

■

■
■

■
■

■

■
■
■
■

■
■

■

■

Press the ENTERE button 
at any time to interrupt the 
memorization process.

■

1	 Press the POWERP button on the remote control.
The screen is turned off and a red standby indicator appears on your set.

2	 To switch your set back on, simply press the POWERP button again.
Do not leave your set in standby mode for long periods of time (when you are away on holiday, for example). It is best to 
unplug the set from the mains and aerial.

■

■

Select the OSD Language.

Menu Language             : English                                   ▶

E Enter

Plug & Play
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If you want to reset this feature...

1	 Press the MENU button.  
Press the ▲ or ▼ button to select Setup, then press the ENTERE button.

2	 Press the ENTERE button again to select Plug & Play.

3	 Enter your 4 digit PIN number. 
The default PIN number of a new TV set is ‘0-0-0-0’.
If you want to change PIN number, use the Change PIN function. 

Viewing the Display
The display identifies the current channel and the status of certain audio-video 
settings.

1	 Press the INFO button on the remote control. 
The TV will display the channel, the type of sound, and the status of certain picture 
and sound settings.

Press the INFO button once more or wait approximately 10 seconds and the 
display disappears automatically.

■
■

■

The Plug & Play feature is only 
available in the TV mode.

■

Press the INFO button to viewing 
the information. 

■

DTV Air

15
abc1

18:00 ~ 6:00 

18:11 Thu 6 Jan 

 Life On Venus Avenue
Unclassified
No Detaild Information

E Watch
 '  Information

Plug & Play		  ▶

Language	 : English
Time
Broadcast
Security
Network
General

Setup
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Using the Menus
Viewing the Menus
Menu provides one button access for controlling your TV. It enables you to perform a variety of tasks intuitively with a control 
panel on the screen rather than a variety of remote control button presses.

Operation the Menu
The access step may differ depending on the selected menu.

1	 Press the MENU button. 
The menu is displayed on the screen.

2	 Press the ▲ or ▼ button to select one of the icons. 
Press the ENTERE button to access the icon’s sub-menu.

3	 Press the ▲ or ▼ button to move to items in the menu. 
Press the ENTERE button to enter items in the menu.

4	 Press the ▲/▼/◄/► button to change the selected items. 
Press the RETURNR button to return to the previous menu.

5	 Press the EXITe button to exit from the menu.

■

Channel Menu
Channel

Option Description
Country Analogue Channel

You can change the country for analogue channels.

Digital Channel
You can change the country for digital channels.
The PIN number input screen appears. Enter your 4 digit 
PIN number.

❑

❑

Auto Store You can scan for the frequency ranges available to you 
(and availability depends on your country). Automatically 
allocated programme numbers may not correspond to 
actual or desired programme numbers.
Scans for all channels with active broadcast stations and 
stores them in the TV’s memory.

If a channel is locked using the 
Child Lock function, the PIN 
input window appears.

■

Country		  ▶

Auto Store
Manual Store
Cable Search Option
Full Guide
Mini Guide
Default Guide	 : Full Guide
Channel List

Channel
MENU button

Display the main on-screen menu.

ENTERE / Direction button
Move the cursor and select an item. 

Select the currently selected item. 
Confirm the setting.

RETURN button
Return to the previous menu.

EXIT button
Exit the on-screen menu.
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Option Description

Auto Store Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue 
channels.
Digital: Digital channels.
Analogue: Analogue channels.

When selecting Cable → Digital & Analogue 
or  Cable → Digital:
Provide a value to scan for cable channels.

Search Mode → Full / Network /Quick
Quick
Network ID: Displays the network 
identification code.
Frequency: Displays the frequency 
for the channel. (Differs in each 
country)
Modulation: Displays available 
modulation values.
Symbol Rate: Displays available 
symbol rates.

❑

■

■
■

■
■
�

�

�

�

Manual Store Scans for a channel manually and stores it in the TV’s 
memory.

Digital Channel
Manual store for digital channels.

Channel: Set the Channel number using the ▲, ▼ or 
number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or 
number (0~9) buttons.

When it has finished, channels are updated in the channel 
list.

Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a 
channel): Sets the programme number using the ▲, ▼ 
or number (0~9) buttons.
Colour System → Auto / PAL / SECAM / NTSC4.43: 
Sets the colour system value using the ▲ or ▼ button.
Sound System → BG / DK / I / L: Sets the sound 
system value using the ▲ or ▼ button.
Channel (When you know the number of the channel 
to be stored): Press the ▲ or ▼ button to select C (Air 
channel) or S (Cable channel). Press the ► button, then 
press the ▲, ▼ or number (0~9) buttons to select the 
required number.

You can also select the channel number directly by 
pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect 
the sound standard required.

Search (When you do not know the channel numbers): 
Press the ▲ or ▼ button to start the search. The tuner 
scans the frequency range until the first channel or the 
channel that you selected is received on the screen.
Store (When you store the channel and associated 
programme number): Set to OK by pressing the 
ENTERE button.

❑

■

■
■

❑

■

■

■

■

�

�

■

■

Cable Search Option 
(depending on the 
country)

Sets additional search options such as the frequency and 
symbol rate for cable network searches.

Freq.Start (Frequency Start): Set the start frequency 
(Differs in each country)
Freq.Stop (Frequency Stop): Set the stop frequency 
(Differs in each country)
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

■

■

■
■

If a channel is locked using the 
Child Lock function, the PIN 
input window appears.
Digital Channel is only available 
in DTV mode.

■

■

Analogue Channel is only 
available in analogue TV mode.
Channel mode

P (Programme mode): 
When completing tuning, the 
broadcasting stations in your 
area have been assigned 
to position numbers from 
P00 to P99. You can select 
a channel by entering the 
position number in this 
mode.
C (Air channel mode): 
You can select a channel 
by entering the assigned 
number to each air 
broadcasting station in this 
mode.
S (Cable channel mode): 
You can select a channel 
by entering the assigned 
number for each cable 
channel in this mode.

■

■
�

�

�

If you want to stop Auto Store, 
press the ENTERE button.
The Stop Auto Store? message 
will be displayed. Select Yes by 
pressing the ◄ or ► button, then 
press the ENTERE button.

■
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Full Guide /  
Mini Guide /  
Default Guide

The EPG (Electronic Programme Guide) information is 
provided by the broadcasters. Programme entries may 
appear blank or out of date as a result of the information 
broadcast on a given channel. The display will dynamically 
update as soon as new information becomes available.

Full Guide
Displays the programme information as time ordered One 
hour segments. Two hours of programme information is 
displayed which may be scrolled forwards or backwards in 
time.

❑

Mini Guide
The information of each programme is displayed by each 
line on the current channel Mini Guide screen from the 
current programme onwards according to the programme 
starting time order.

Default Guide → Mini Guide / Full Guide
You can decide whether to display either the Mini Guide 
or the Full Guide when the GUIDE button on the remote 
control is pressed.

❑

❑

Using the Full / Mini Guide

To... Then...

Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.

Exit the guide Press the Blue button

If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press the 
◄, ► button to select Cancel Schedules, the scheduling is cancelled with the clock icon gone. 

View programme information
Select a programme of your choice by pressing the ▲, ▼, ◄, ► button. 
Then press the INFO button when the programme of your choice is highlighted.
The programme title is on the upper part of the screen centre. 

Please click on INFO button for the detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 
Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the highlighted 
programme are included on the detailed information. “...” will be appeared if the summary is long.

Toggle between the Mini Guide and Full Guide Press the Red button repeatedly.

In Full Guide 
Scrolls backwards quickly (24 hours). 
Scrolls forwards quickly (24 hours).

Press the Green button repeatedly.
Press the Yellow button repeatedly.

In Mini Guide
Display previous page quickly.
Display next page quickly.

Press the Green button.
Press the Yellow button.

You can also display the guide 
menu simply by pressing the 
GUIDE button. (To configure 
the Default Guide, refer to the 
descriptions.)

■

1 2 3

4 5 6

7 8

0

9

P

(Red) 

Full Guide

E Watch     Information     Mini Guide     +24 Hours     Exit

DTV Cable 900 f tn                         2:10 Tue 1 Jun
Freshmen On Campus 
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
40 with Dynamite MC
The Distillery
Smash Hits! Sunday

900       f tn
901       ITV Play
902       Kerrang!
903       Kiss
904       oneword
905       Hits▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

  900

E Watch     Information     Full Guide     Next Page     Exit

Mini Guide DTV Cable 900 f tn

Street Hypnosis
Booze Britain

2:00
2:30
5:00

Freshmen On Campus

▼

Full Guide

Mini Guide
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Channel List Using this menu, you can add / delete or set favourites 
channels and use the programme guide for digital 
broadcasts.

All Channels
Shows all currently available channels.

Added Channels
Shows all added channels.

Favourites
Shows all favourite channels.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels 
or Favourites screen by pressing the ▲ / ▼ buttons, and 
pressing the ENTERE button. Then you can watch the 
selected channel. 

Using the Colour buttons with the Channel List
Red (Channel Type): Toggle between your TV, Radio, 
Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. 
You can perform the add/delete or add to favourites/
delete from favourites function for multiple channels at 
the same time. Select the required channels and press 
the Yellow button to set all the selected channels at 
the same time. The c mark appears to the left of the 
selected channels.

Channel List Option Menu (in All Channels / 
Added Channels / Favourites)

Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel 
status.

Add / Delete
You can delete or add a channel to display the channels you 
want.

All deleted channels will be shown on All Channels 
menu.
You can also delete a channel to the Added Channels or 
Favourites menu in the same manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. 
You can also set the add to (or delete from) Favourite by 
selecting Tools → Add to Favourite (or Delete from 
Favourite).
The “*” symbol will be displayed and the channel will 
be set as a favourite.
All favourite channels will be shown on Favourites 
menu.

Lock / Unlock
You can lock a channel so that the channel cannot be 
selected and viewed. 

This function is available only when the Child Lock is set 
to On. 
The PIN number input screen appears. Enter your 4 digit 
PIN number.
The default PIN number of a new TV set is “0-0-0-0”. You 
can change the PIN, by selecting Change PIN from the 
menu.
The “\” symbol will be displayed and the channel will be 
locked.

❑

❑

❑

❑

■

■
■

■
■

❑

■

■

❑

T

■

■

❑

■

■

■

■

A gray-coloured channel 
indicates the channel has been 
deleted.
The Add menu only appears for 
deleted channels.

■

■

TOOLS (Tools): Displays 
the Delete (or Add), Add to 
Favourite (or Delete from 
Favourite), Lock (or Unlock), 
Timer Viewing, Edit Channel 
Name, Edit Channel Number, 
Sort, Select All (or Deselect 
All), Auto Store menu. (The 
Options menus may differ 
depending on the situation.)

■

Channel Status Display Icons
A: An Analogue channel.
c: A channel selected by 
pressing the Yellow button.
*: A channel set as a 
Favourite.
(: A programme currently 
being broadcast.
\: A locked channel.
): A reserved programme

■
�
�

�

�

�
�

You can select these options by 
simply pressing the CH LIST 
button on the remote control.
To select the favourites channels 
you have set up, press the FAV.
CH button on the remote control.

■

■

All Channels

824          UKTV Gold
825          UKTV style

A 1     C --
A 2          C --
A 3          C --
A 4          C --
A 5          C --
A 6          C --
A 7          C --
A 8          C --

            All         Channel Type    Zoom    Select   T Tools

Delete
Add to Favourite
Lock
Timer Viewing
Edit Channel Name
Sort

                                       �
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Only Analogue TV channels can 
be fine tuned.

■

The names of digital 
broadcasting channels are 
automatically assigned and 
cannot be renamed.

■

You can only select Deselect 
All when there is a selected 
channel.

■

If a channel is locked using the 
Child Lock function, the PIN 
input window appears.

■

Only memorized channels can 
be reserved.

■

Programmed

1 / 1 / 2009

13:59   5  TV1   ) 

18:59     2    TV3    ) The Equalizer
20:59     2    TV3    ) McMillan & Wife
21:59     2    TV3    ) M.Spillane’s mike 

            All        Zoom    Select   T Tools    E Information

Change Info
Cancel Schedules
Information
Select All

                                       

Channel
Option Description

Channel List Timer Viewing
If you reserve a programme you want to watch, the channel 
is automatically switched to the reserved channel in the 
Channel List; even when you are watching another channel. 
To reserve a programme, set the current time first. 

You can set the channel, day, month, year, hour and 
minute directly by pressing the number buttons on the 
remote control.
Reserving a programme will be shown in the 
Programmed menu.
Digital Programme Guide and Viewing Reservation:  
When a digital channel is selected, and you press 
the ► button, the Programme Guide for the channel 
appears. You can reserve a programme according to the 
procedures described above.

Edit Channel Name (analogue channels only)
Channels can be labelled so that their call letters appear 
whenever the channel is selected.

Edit Channel Number (digital channels only)
You can also edit the channel number by pressing the 
number buttons on the remote control.

Sort (analogue channels only)
This operation allows you to change the programme 
numbers of the stored channels. This operation may be 
necessary after using the auto store.

Select All / Deselect All
Select All: You can select all the channels in the 
channel list.
Deselect All: You can deselect all the selected 
channels.

Auto Store
For detailed procedures on setting up options, refer to 
pages 19~20.

Channel List Option Menu (in Programmed)
You can view, modify or delete a reservation.
Press the TOOLS button to use the option menu.

Change Info
Select to change a viewing reservation.

Cancel Schedules
Select to cancel a viewing reservation.

Information
Select to view a viewing reservation. 
(You can also change the reservation information.)

Select All
Select all reserved programmes.

❑

■

■

■

❑

❑

❑

❑
■

■

❑

❑

❑

❑

❑

Channel Mode When press the P >/< button, Channels will be switched 
within the selected channel list.

Added Ch.
Channels will be switched within the memorized channel list.

Favourite Ch.
Channels will be switched within the favourite channel list.

❑

❑

Fine Tune If the reception is clear, you do not have to fine tune the 
channel, as this is done automatically during the search and 
store operation. If the signal is weak or distorted, you may 
have to fine tune the channel manually.

Fine tuned channels that have been saved are marked 
with an asterisk ‘*’ on the right-hand side of the channel 
number in the channel banner.
To reset the fine-tuning, select Reset by pressing the  
▲ or ▼ button and then press the ENTERE button.

■

■
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7

 U Move    L Adjust     E Enter     R Return

      ▲
Backlight
      ▼

Picture Menu
Picture

Option Description
Mode Selects the type of picture settings that best correspond to 

your viewing preferences or requirements. Presets a higher 
brightness, contrast, and sharpness to the picture.

Dynamic
Recommended for use in bright room conditions. 

Standard
Recommended for use in a normal viewing condition.

Natural
Adds more punch and contrast to the image than the 
Standard mode.

Movie
Corresponding to the conditions used in movie, 
recommended for use in darker viewing conditions.

■

■

■

■

Backlight /  
Contrast /  
Brightness /  
Sharpness /  
Colour /  
Tint(G/R)

Your television has several setting options that allow you to 
control the picture quality.

Backlight
Adjusts the brightness of LED back light.

Contrast
Increases or decreases the brightness in white areas of the 
picture. Too little contrast and the picture may seem dark; 
too much contrast and the picture will lose details in white 
images.

Brightness
Increases or decreases the overall brightness of the 
picture, but best used to adjust the black level of the image. 
Too little brightness and shadow detail will be lost; too much 
brightness and blacks will be gray and washed out. 

Sharpness
Increases or decreases the apparent detail in the picture. 
Too little sharpness and the image might look soft. Too 
much sharpness can add false edges to objects or can 
make noise more noticeable.  

Colour
Increases or decreases colour saturation levels in the 
picture. Too little colour and the image will be black and 
white (undersaturated); too much colour and the image will 
look oversaturated and cartoonish.

Tint(G/R)
Changes the picture hue from reddish to a greenish 
appearance.

■

■

■

■

■

■

Advanced Settings Samsung’s new TVs allow you to make even more precise 
picture settings than previous models.

Black Tone → Off / Dark / Darker / Darkest
Increases the picture’s shadow detail by lightening the 
black level (ie changing the gamma) at low levels. This is 
most commonly used for watching movies with dark scenes 
to keep the picture from appearing washed out in bright 
rooms.

Dynamic Contrast → Off / Low / Medium / High
Increases or decreases the difference between the 
brightest and darkest portions of the image with changing 
scenes. Shadows are more visible with dark scenes, while 
contrast is enhanced with bright scenes. 

■

■

Press the TOOLS button to 
display the Tools menu. You 
can also set the picture mode 
by selecting Tools → Picture 
Mode.

■

Only analogue TV, Ext., AV 
modes of the PAL system, 
you cannot use the Tint(G/R) 
Function.
When you make changes to 
Backlight, Contrast, Brightness, 
Sharpness, Colour or Tint(G/
R), the OSD will be adjusted 
accordingly.
In PC mode, you can only make 
changes to Backlight, Contrast 
and Brightness.
Settings can be adjusted and 
stored for each external device 
you have connected to an input 
of the TV.
The energy consumed during use 
can be significantly reduced if the 
brightness level of the picture is 
lowered, which will reduce the 
overall running cost.

■

■

■

■

■

Mode	 : Standard	 ▶

Backlight	 : 7
Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings

Picture

Natural is not available in PC 
mode.

■

Black Tone	 : Off		  ▶
Dynamic Contrast	 : Medium
Gamma	 : 0
Colour Space	 : Native
White Balance
Flesh Tone	 : 0
Edge Enhancement	 : On

U Move     E Enter     R Return

Advanced Settings
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Advanced Settings Gamma
Changes the rate at which images ramp or fade from light 
to dark. Recommended for advanced users only. 

Colour Space
Increases or decreases the visible colour range for red, 
green and blue. Recommended for advanced users only.  

Auto: The TV will choose the colour range that 
is closest to the range used during TV and movie 
production.
Native: Displays the most enhanced, vibrant 
colours possible. 
Custom: Provides precise saturation and colour 
point adjustment of Red, Green, Blue, Yellow, 
Cyan, and Magenta. Recommended for advanced 
users only. 

White Balance
You can adjust the colour temperature for more natural 
picture colours.

R, G, B-Offset: Fine tunes the white balance, or 
colour ‘temperature’ in dark areas by changing the 
individual values of R, G, B. Recommended for 
advanced users only.
R, G, B-Gain: Fine tunes the white balance, or 
colour ‘temperature’ in the light areas by changing 
the individual values of R, G, B.  Recommended for 
advanced users only.
Reset: Resets the colour space to the default 
values.

Flesh Tone
Adjusts the colour of flesh tones. Increasing the value 
creates a more reddish picture. Decreasing the value 
creates a more greenish picture. 

Edge Enhancement 
Increases or decreases the emphasis at object edges.  

xvYCC  
Setting the xvYCC mode to on increases detail and colour 
space when watching movies from an external device (ie. 
DVD player) connected to the HDMI or Component IN 
jacks.

■

■

�

�

�

■

�

�

�

■

■

■

Picture Options Colour Tone
Selects a preset white balance, or ‘colour temperature’ 
setting, to provide either a reddish or bluish hue, dependant 
upon your personal preference.

Cool: Selects a white balance, or colour 
‘temperature’ with a bluish hue. Skin tones may 
have less warmth but whites will seem brighter. 
Recommended when watching normal TV 
broadcasting in a bright room.
Normal: Selects the white balance, or colour 
“temperature” with a less bluish, more reddish hue. 
Suitable for most viewing environments and programs.
Warm1, Warm2, Warm3: Selects a redder, warmer 
hue that more closely matches the setting on monitors 
used in the production of TV and movie content. 
Recommended when watching movie and dramatic 
TV content. The lowest setting is best used for black & 
white content. 

■

�

�

�

Advanced Settings is available in 
Standard or Movie mode.
In PC mode, you can only make 
changes to Dynamic Contrast, 
Gamma and White Balance from 
among the Advanced Settings 
items.
Colour is available when Colour 
Space is set to Custom.
In Colour, you can adjust the RGB 
values for the selected colour.
To reset the adjusted RGB value, 
select Reset.

■

■

■

■

■

xvYCC is available when the 
picture mode is set to Movie, and 
the external input is set to HDMI or 
Component mode.
This function may not be 
supported depending on your 
external device.

■

■

In PC mode, you can only make 
changes to the Colour Tone and 
Size from among the items in 
Picture Options.
Warm1, Warm2 or Warm3 is 
only activated when the picture 
mode is Movie.

■

■

Colour Tone	 : Normal		  ▶
Size	 : Auto Wide
Screen Mode	 : 16:9
Digital NR	 : Auto
HDMI Black Level	 : Normal
Film Mode	 : Off
100Hz Motion Plus	 : Standard
	 ▼

U Move     E Enter     R Return

Picture Options
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Picture Options Size
Changes the screen shape in terms of height and width. 
Also known as Aspect Ratio.

Auto Wide: Enables the correct picture size to 
match the original video signal.
16:9: Sets the picture aspect ratio to fill the screen.  
Wide Zoom: Enlarges the middle part of the 
picture.
Zoom: Magnifies the picture contents horizontally 
and vertically.
4:3: Sets the picture aspect ratio to 4:3 with black 
or gray side bars.
Screen Fit: Matches every pixel of the original 
image to a pixel on the TV screen (aka 1:1 pixel 
mapping) to show the entire image.   

Wide Zoom: Press the ► button to select 
Position, then press the ENTERE button.  
Press the ▲ or ▼ button to move the picture up / 
down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, 
then press the ENTERE button. Press the ▲ or 
▼ button to move the picture up and down. Then 
press the ENTERE button. Press the ► button 
to Select Size, then press the ENTERE button. 
Press the ▲ or ▼ button to magnify or reduce the 
picture size in the vertical direction. Then press the 
ENTERE button.
After selecting Screen Fit in HDMI (1080i / 1080p) 
or Component (1080i / 1080p) mode: Select 
Position by pressing the ◄ or ► button. Use the 
▲, ▼, ◄ or ► button to move the picture. 
Reset: Press the ◄ or ► button to select Reset, 
then press the ENTERE button. You can initialize 
the setting.
If you use the Screen Fit function with HDMI 720p 
input, 1 line will be cut at the top, bottom, left and 
right as in the Overscan function.
When Double (À, Œ) mode has been set in PIP, 
the Picture Size cannot be set.

Screen Mode
When setting the picture size to Auto Wide in a 16:9 wide 
TV, you can determine the picture size you want to see the 
4:3 WSS (Wide Screen Service) image or nothing. Each 
individual European country requires different picture size 
so this function is intended for users to select it.

16:9: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more 
than 4:3.
Zoom: Magnify the size of the picture vertically on 
screen.
4:3: Sets the picture to 4:3 normal mode.

Digital NR → Off / Low / Medium / High / Auto
Can reduce the grain effect or level of video snow seen in 
images coming from poor quality sources.

HDMI Black Level → Normal / Low
Adjusts the black level in the picture according to the type 
of signal being transmitted through HDMI. 

Film Mode
Applies the appropriate video processing needed to 
achieve the best picture quality for watching movies.

Off: Turn the Film Mode function off.
Auto1: Improves the picture quality for fast motion 
scenes.  
Auto2: Allows a smoother text motion on fast 
motion scenes. 

■

�

�
�

�

�

�

●

●

●

●

●

■

�
�

�

�
■

■

■

�
�

�

This function is active only when 
an external device is connected to 
the TV via HDMI (RGB signals).

■

Film Mode is supported in TV, 
AV, COMPONENT(480i / 1080i) 
and HDMI(480i / 1080i).

■

Depending on the input source, 
the picture size options may vary.
The items available may differ 
depending on the selected mode.
In PC Mode, only 16:9 and 4:3 
mode can be adjusted.
Settings can be adjusted and 
stored for each external device 
you have connected to an input 
of the TV.
Temporary image retention may 
occur when viewing a static image 
on the set for more than two 
hours.

■

■

■

■

■

Press the TOOLS button to 
display the Tools menu. You can 
also set the size by selecting 
Tools → Picture Size.

■

This function is available in Auto 
Wide mode.
This function is not available in 
PC, Component or HDMI mode.

■

■
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Picture
Option Description

Picture Options 100Hz Motion Plus → Off / Clear / Standard / Smooth 
/ Custom / Demo

Removes drag from fast scenes with a lot of movement to 
provide a clearer picture.
If you enable 200 Hz Motion Plus, noise may appear on 
the screen. If this occurs, set 100Hz Motion Plus to Off.

Off: Switches 100Hz Motion Plus off.
Clear: Sets 100Hz Motion Plus to minimum.
Standard: Sets 100Hz Motion Plus to medium.
Smooth: Sets 100Hz Motion Plus to maximum.
Custom: Adjusts the blur and judder reduction 
level to suit your preference.

Blur Reduction: Adjusts the blur reduction level 
from video sources.
Judder Reduction: Adjusts the judder reduction 
level from video sources when playing films.
Reset: Reset the custom settings.

Demo: Displays the difference between 100Hz 
Motion Plus on and off modes.

Blue Only Mode 
Helps to adjust the colour and tint controls when used with 
colour bar test patterns. Recommended for qualified picture 
alignment specialists only.  Available only when the Picture 
Mode is set to Movie or Standard. 

■

�
�
�
�
�

●

●

●
�

■

Picture Reset Resets all picture settings to the default values.
Reset Picture Mode: Current picture values return to 
default settings.

■

Picture (In the PC mode)
Option Description

Auto Adjustment Use the Auto Adjust function to have the TV set 
automatically adjust the video signals it receives.
The function also automatically fine-tunes the settings and 
adjusts the frequency values and positions.

Screen Coarse / Fine
The purpose of picture quality adjustment is to remove or 
reduce picture noise. If the noise is not removed by Fine-
tuning alone, then adjust the frequency as best as possible 
(Coarse) and Fine-tune again. After the noise has been 
reduced, readjust the picture so that it is aligned on the 
centre of screen.

PC Position
Adjust the PC’s screen positioning if it does not fit the TV 
screen. 
Press the ▲ or ▼ button to adjusting the Vertical-Position. 
Press the ◄ or ► button to adjust the Horizontal-Position.

Image Reset
You can replace all image settings with the factory default 
values.

■

■

■

Blue Only Mode is available 
when the picture mode is set to 
Movie or Standard.

■

Preset: Press the SOURCE button 
to select PC mode.
This function does not work in 
DVI-HDMI mode.

■

■

Press the TOOLS button to 
display the Tools menu. You can 
also set the Auto Adjustment 
by selecting Tools → Auto 
Adjustment.

■
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Sound Menu
Sound

Option Description
Mode Standard: Selects the normal sound mode.

Music: Emphasizes music over voices.
Movie: Provides the best sound for movies.
Clear Voice: Emphasizes voice over other sounds.
Custom: Recalls your customized sound settings.

■
■
■
■
■

Equalizer The sound settings can be adjusted to suit your personal 
preferences.

Mode: Selects the sound mode among the predefined 
settings.
Balance L/R: Adjusts the balance between the right and 
left speaker.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth 
Adjustment): To adjust the level of different bandwidth 
frequencies.
Reset: Resets the equalizer settings to the default values.

■

■

■

■
SRS TruSurround HD SRS TruSurround HD is a patented SRS technology that 

solves the problem of playing 5.1 multichannel content 
over two speakers. TruSurround delivers a compelling, 
virtual surround sound experience through any two-speaker 
playback system, including internal television speakers.  
It is fully compatible with all multichannel formats.

Audio Language You can change the default value for audio languages. 
Displays the language information for the incoming stream.

While viewing a digital channel, this function can be 
selected.
You can only select the language among the actual 
languages being broadcast.

■

■

Audio Format When sound is emitted from both the main speaker and 
the audio receiver, a sound echo may occur due to the 
decoding speed difference between the main speaker 
and the audio receiver. In this case, use the TV Speaker 
function.

While viewing a digital channel, this function can be 
selected.
The Audio Format appears according to the broadcasting 
signal.

■

■

Audio Description This is an auxiliary audio function that provides an 
additional audio track for visually challenged persons. 
This function handles the Audio Stream for the AD (Audio 
Description), when it is sent along with the Main audio from 
the broadcaster. Users can turn the Audio Description On or 
Off and control the volume.

Audio Description
Turn the audio description function on or off.

Volume
You can adjust the audio description volume.

Volume is active when Audio Description is set 
to On.
While viewing a Digital channel, this function can 
be selected.

■

■

�

�

Auto Volume Each broadcasting station has its own signal conditions, 
and so it is not easy to adjust the volume every time the 
channel is changed. This feature lets you automatically 
adjust the volume of the desired channel by lowering the 
sound output when the modulation signal is high or by 
raising the sound output when the modulation signal is low.

Speaker Select When you watch TV with it connecting to a Home theatre, 
turn the TV speakers off so you can listen to sound from the 
Home theatre’s (external) speakers.

External Speaker: Used to listen to the sound of the 
External (Home Theatre) Speakers.
TV Speaker: Used to listen to the sound of the TV 
Speakers.

■

■

The volume buttons and MUTE 
buttons do not operate when the 
Speaker Select is set to External 
Speaker.
If you select External Speaker 
in the Speaker Select menu, the 
sound settings will be limited.

■

■

Press the TOOLS button to 
display the Tools menu. You can 
also configure the sound mode 
by selecting Tools → Sound 
Mode.

■

Press the AD button on the 
remote control to select Off or 
On.

■

Press the TOOLS button to 
display the Tools menu. You can 
also set the SRS TruSurround 
HD by selecting Tools → SRS 
TS HD.

■

Mode	 : Custom	 ▶

Equalizer
SRS TruSurround HD	 : Off
Audio Language	 : ----
Audio Format	 : ----
Audio Description
Auto Volume	 : Off
Speaker Select	 : TV Speaker

Sound
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Selecting the Speaker

TV’s Internal Speakers Audio Out (Optical) to Sound 
System

RF / AV / Component / PC / HDMI RF / AV / Component / PC / HDMI
TV Speaker Sound Output Sound Output

External 
Speaker Mute Sound Output

Video No Signal Mute Mute

Sound
Option Description

Sound Select When the PIP feature is activated, you can listen to the 
sound of the sub (PIP) picture.

You can select this option when PIP is set to On.■

Sound Reset You can restore the Sound settings to the factory defaults.
Reset Sound Mode: Current sound values return to default 
settings.

Selecting the Sound Mode
You can set the sound mode in the Tools menu. When you set to Dual l ll, the current sound 
mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 
Stereo

Mono MONO
Automatic change

Stereo STEREO ↔ MONO
Dual DUAL 1 ↔ DUAL 2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual MONO ↔ DUAL 1 
DUAL 2 DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound 
signal.
This function is only available in TV mode.

■
■

■

Press the TOOLS button to 
display the Tools menu. You can 
also set the sound of the sub 
picture by selecting Tools → PIP 
→ Sound Select.

■

Sound Reset

 L Move     E Enter     R Return

Cancel sound reset.

Reset All Reset Sound Mode Cancel
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Setup Menu
Setup

Option Description
Language You can set the menu language.

Time Clock
Setting the clock is necessary in order to use the various timer 
features of the TV. If you disconnect the power cord, you have 
to set the clock again.

Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time 
from the digital broadcast.
Manual: Set the current time to a manually specified time.

Clock Set
You can set the current time manually.

This function is only available when Clock Mode is set 
to Manual.
You can set the day, month, year, hour and minute 
directly by pressing the number buttons on the remote 
control.

Sleep Timer
The sleep timer automatically shuts off the TV after a preset 
time (30, 60, 90, 120, 150 and 180 minutes).

To cancel the Sleep Timer function, select Off.

Timer 1 / Timer 2 / Timer 3
Three different on / off timer settings can be made.
You must set the clock first.

On Time
Set the hour, minute, and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to 
Activate.)

Off Time
Set the hour, minute, and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to 
Activate.)

Volume
Set the desired volume level.

Source → TV / USB
You can select the TV or USB device content to be played 
when the TV turns on automatically. Select TV or USB. (Make 
sure that an USB device is connected to your TV.)

Antenna (when Source is set to TV)
Select ATV or DTV.

Channel (when Source is set to TV)
Select the desired channel.

Contents (when Source is set to USB)
You can select a folder on the USB Device with music or photo 
files to be played when the TV turns on automatically.

If the folder name is too long, the folder cannot be 
selected.
If you are using two of the same type USB device, be 
sure the folder names are different so the correct USB 
is read.

Repeat
Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or 
Manual.

When Manual is selected, press the ► button to select 
the desired day of the week. Press the ENTERE button 
over the desired day and the c mark will appear.
You can set the hour, minute and channel by pressing the 
number buttons on the remote control.

❑

■

�

�
■

�

�

❑

■

❑

■

■

■

■

■

■

■

�

�

■

�

�

On Time	

L Move    U Adjust    E Enter     R Return

Timer 1

Off Time

Volume

00 00 Inactivate

00 00 Inactivate

10
Source Antenna Channel

TV ATV 0

Repeat
Once

Sun Mon Tue Wed Thu Fri Sat

Auto Power Off 
When you set the timer on, the 
television will eventually turn off, 
if no controls are operated for 3 
hours after the TV was turned on 
by the timer. This function is only 
available in timer on mode and 
prevents overheating, which may 
occur if a TV is on for too long 
time.

■

The current time will appear 
every time you press the INFO 
button.

■

Depending on the broadcast 
station and signal, the auto time 
may not be set correctly. If this 
occurs, set the time manually.
The Antenna or cable must be 
connected in order to set the time 
automatically.

■

■

Press the TOOLS button to 
display the Tools menu. You 
can also set the sleep timer by 
selecting Tools → Sleep Timer.

■

Plug & Play

Language	 : English	 ▶

Time
Broadcast
Security
Network
General

Setup

When there is only one photo file 
in the USB the Slide Show will 
not play.

■
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Setup
Option Description

Broadcast Subtitle
You can activate and deactivate the subtitles. Use this 
menu to set the Subtitle Mode. Normal under the menu is 
the basic subtitle and Hard of hearing is the subtitle for a 
hearing-impaired person.

Subtitle
Switches subtitles on or off.

Mode 
Sets the subtitle mode.

Subtitle Language
Set the subtitle language.

If the programme you are watching does not support 
the Hard of hearing function, Normal automatically 
activates even though Hard of hearing mode is 
selected.
English is the default in cases where the selected 
language is unavailable in the broadcast.

Digital Text 
If the programme is broadcast with digital text, this feature 
is enabled.

MHEG (Multimedia and Hypermedia Information Coding 
Experts Group)  
An International standard for data encoding systems 
used in multimedia and hypermedia. This is at a higher 
level than the MPEG system which includes data-linking 
hypermedia such as still images, character service, 
animation, graphic and video files as well as multimedia 
data. MHEG is user runtime interaction technology 
and is being applied to various fields including VOD 
(Video-On-Demand), ITV (Interactive TV), EC (Electronic 
Commerce), tele-education, tele-conferencing, digital 
libraries and network games.

Teletext Language
You can set the Teletext language by selecting the language 
type.

English is the default in cases where the selected 
language is unavailable in the broadcast.

Preference
Primary Audio Language / Secondary Audio 
Language / Primary Subtitle Language / Secondary 
Subtitle Language / Primary Teletext Language / 
Secondary Teletext Language 
Using this feature, users can select one of the languages. 
The language selected here is the default when the user 
selects a channel 
If you change the language setting, the Subtitle 
Language, Audio Language, and the Teletext Language 
of the Language menu are automatically changed to the 
selected language. 
The Subtitle Language, Audio Language, and the Teletext 
Language of the Language menu show a list of languages 
supported by the current channel and the selection is 
highlighted. If you change this language setting, the 
new selection is only valid for the current channel. The 
changed setting does not change the setting of the 
Primary Subtitle Language, Primary Audio Language, or 
the Primary Teletext Language of the Preference menu.

❑

■

■

■

�

�

❑

■

❑

■

❑

■

You can select these options 
simply by pressing the SUBT. 
button on the remote control.

■
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Child Lock is available only in 
TV mode.
The default PIN number of a new 
TV set is 0-0-0-0. 

■

■

If you forget the PIN code, press 
the remote control buttons in the 
following sequence, which resets 
the PIN to 0-0-0-0: POWER 
(Off) → MUTE → 8 → 2 → 4 → 
POWER (On).

■

Setup
Option Description

Broadcast Common Interface
CI Menu

This enables the user to select from the CAM-provided 
menu.
Select the CI Menu based on the menu PC Card.

Application Info.
This contains information on CAM inserted in the CI slot 
and displays it. The Application Info inserting is about the 
CI CARD. You can install the CAM anytime whether the TV 
is ON or OFF.
1.	 Purchase the CI CAM module by visiting your nearest 

dealer or by phone.
2.	 Insert the CI CARD into the CAM in the direction of the 

arrow until it fits.
3.	 Insert the CAM with the CI CARD installed into the 

common interface slot.  
(Insert the CAM in the direction of the arrow, right up to 
the end so that it is parallel with the slot.)

4.	 Check if you can see a picture on a scrambled signal 
channel.

❑

■

■

Security Child Lock
This feature allows you to prevent unauthorized users, such 
as children, from watching unsuitable programme by muting 
out video and audio.

Before the setup screen appears, the PIN number input 
screen appears. Enter your 4 digit PIN number.
You can change the PIN by selecting Change PIN from 
the menu.
You can lock some channels in Channel List.

Parental Lock > Parental Rating
This feature allows you to prevent unauthorized users, 
such as children, from watching unsuitable programme by 
a 4-digit PIN (Personal Identification Number) code that is 
defined by the user.

The Parental Rating item differs depending on the 
country.
Before the setup screen appears, the PIN number input 
screen appears. Enter your 4 digit PIN number.
You can change the PIN by selecting Change PIN from 
the menu.
When the parental ratings are set, the “\” symbol is 
displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.

Change PIN
You can change your personal ID number that is required to 
set up the TV.

Before the setup screen appears, the PIN number input 
screen appears. Enter your 4 digit PIN number.

❑

■

■

■

❑

■

■

■

■

■
■

❑

■

Network Network Type / Network Setup
For detailed procedures on setting up options, refer to 
pages 37~39.

❑
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Setup
Option Description

General Game Mode
When connecting to a game console such as PlayStation™ 
or Xbox™, you can enjoy a more realistic gaming 
experience by selecting game menu.

If Game Mode is On:
Picture mode is automatically changed to Standard 
and cannot be changed.
Sound mode is automatically changed to Custom 
and cannot be changed. Adjust the sound using the 
equalizer.
The Reset Sound function is activated. Selecting 
the Reset function after setting the equalizer resets 
the equalizer settings to the factory defaults.

BD Wise
Provides the optimal picture quality for SAMSUNG DVD, 
Blu-ray and Home Theatre products which support BD 
Wise. You can enjoy a richer picture when using them 
connected to this Samsung TV.

Connect SAMSUNG products that have BD Wise using 
an HDMI cable.
When the BD Wise set to On, the picture mode is 
automatically changed to the optimal resolution.
BD Wise is available in HDMI mode.

Energy Saving 
This feature adjusts the brightness of the TV in order to 
reduce power consumption. When watching TV at night, 
set the Energy Saving mode option to High to reduce eye 
fatigue as well as power consumption.

Menu Transparency
You can set the Transparency of the menu.

Melody
A melody sound can be set to come on when the TV is 
powered On or Off.

The Melody does not play
When no sound is output from the TV because the 
MUTE button has been pressed.
When no sound is output from the TV because the 
volume has been reduced to minimum with the 
volume (-) button.
When the TV is turned off by Sleep Timer function.

Light Effect
You can turn the LED on/off on the front of TV. Turn it off to 
save power or if the LED bothers you.
Set the Light Effect to Off to reduce the power 
consumption.

Off: LED is always Off.
In Standby: LED is On when TV is turned off.
Watching TV: LED is On when watching TV.
Always: LED is always On, regardless of TV settings.

❑

■
�

�

�

❑

■

■

■

❑

❑

❑

■
�

�

�

❑

■
■
■
■

Restrictions on game mode 
(Caution)

To disconnect the game 
console and connect another 
external device, set Game 
Mode to Off in the setup 
menu.
Game Mode is not available 
in regular TV, PC and Ext 
mode.
While PIP is in operation, the 
Game Mode function cannot 
be used.

If the picture is poor when 
external device is connected 
to TV, check if Game Mode is 
On. Set Game Mode to Off and 
connect external devices.

■

�

�

�

■

Press the TOOLS button to 
display the Tools menu. You 
can also set the Energy Saving 
option by selecting Tools → 
Energy Saving.

■

The colour of light may very 
depending on the model.

■

LED
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If you turn the TV off while watching 
in PIP mode and turn it on again, the 
PIP window will disappear.
You may notice that the picture in 
the PIP window becomes slightly 
unnatural when you use the main 
screen to view a game or karaoke.
While Internet@TV is in operation, 
the PIP function cannot be used.

■

■

■

PIP	 : On		  ▶
Size	 : Õ
Position	 : Ã
Channel	 : ATV 4

U Move     E Enter     R Return

PIP

Press the TOOLS button to 
display the Tools menu. You 
can also configure PIP related 
settings by selecting Tools → 
PIP.

■

Setup
Option Description

General PIP
You can use the PIP feature to simultaneously watch the 
TV tuner and one external video source. This product has 
one built-in tuner, which does not allow PIP to function in 
the same mode. Please see ‘PIP Settings’ below for details.

If you select the PIP picture sound, refer to page 29.
PIP

You can activate or deactivate the PIP function. 
Size → Õ / Ã / À / Œ

You can select a size of the sub-picture.
Position → Ã / – / — / œ

You can select a position of the sub-picture.
In Double (Œ, À) mode, Position cannot be 
selected.

Channel
You can select the channel for the sub-screen.

❑

■
■

■

■

■

■

PIP Settings

Main picture Sub picture
Component
HDMI1/DVI, HDMI2, HDMI3, HDMI4
PC

TV
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Network Connection
You can set up the Internet Protocol so that you can communicate with various connected networks.

Network Connection - Cable
LAN Connection for a DHCP Environment

The procedures to set up the network using Dynamic Host Configuration Protocol (DHCP) are described below. Since an IP address, 
subnet mask, gateway, and DNS are automatically allocated when DHCP is selected, you do not have to enter them manually.

1	 Connect the LAN port on the rear panel of the TV and the external modem with a LAN Cable.			 

2	 Connect the Modem port on the wall and the external modem with a Modem Cable.

You can connect the LAN via a Sharer (Router).

You can connect the LAN port and the TV directly depending on your network status.

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If the IP address allocation by the DHCP server has failed, turn the external modem off, turn it on again after at least 10 seconds and 
then try again.
For the connections between the external modem and the Sharer (Router), refer to the owner’s manual of the corresponding 
product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router)
You cannot use a manual-connection-type ADSL modem because it does not support DHCP. You have to use an 
automaticconnection-type ADSL modem.

❑

■

■
■

■

■
■

TV Rear PanelThe Modem Port on the Wall External Modem 
(ADSL / VDSL / Cable TV)

1 LAN Cable2  Modem Cable

TV Rear Panel
The Modem Port on the Wall

External Modem 
(ADSL / VDSL / Cable TV) IP Sharer

TV Rear PanelThe LAN Port on the Wall

LAN Cable

LAN CableModem CableLAN Cable
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LAN Connection for Static IP Environment
The procedures to set up the network using a static IP address are described below. You have to manually enter the IP address, subnet 
mask, gateway, and DNS that are provided by your Internet Service Provider (ISP). 

Connect the LAN port on the rear panel of the TV and the LAN port on the wall using the LAN cable.

You can connect the LAN via a Sharer (Router).

The terminals (the position of the port and the type) of the external device may differ depending on the manufacturer.
If you are using a static IP address, your ISP will inform you of the IP address, subnet mask, gateway, and DNS. You must enter 
these values to complete the network settings. If you do not know the values, ask your network administrator.
For the information on how to configure and connect a Sharer (Router), refer to the owner’s manual for the corresponding product.
You can connect the TV to the LAN directly without connecting it through a Sharer (Router).
If you use an IP Sharer (IP Router) that supports DHCP, you can set up the device as either DHCP or static IP.
For the procedures to use a static IP address, ask your Internet Service Provider.

Network Connection - Wireless
You can connect to the network wirelessly through a wireless IP sharer.

Connect the ‘Samsung Wireless LAN Adapter’ into the USB1(HDD) or USB2 terminal of the TV.

You must use the ‘Samsung Wireless LAN Adapter’(WIS09ABGN) to use a wireless network.
Samsung’s Wireless LAN adapter is sold separately. The WIS09ABGN Wireless LAN adapter is offered by select retailers, 
Ecommerce sites and Samsungparts.com.
To use a wireless network, your TV must be connected to a wireless IP sharer. If the wireless IP sharer supports DHCP, your TV can 
use a DHCP or static IP address to connect to the wireless network.
Samsung’s Wireless LAN adapter supports IEEE 802.11A, IEEE 802.11B, IEEE 802.11G, IEEE 802.11N. When you play DLNA 
video over IEEE 802.11B/G connection, the video may not be played smoothly.
If the wireless IP sharer allows you to turn the Ping connection function on/off, turn it on.
Select a channel for the wireless IP sharer that is not currently being used. If the channel set for the wireless IP sharer is currently 
being used by another device nearby, this will result in interference and communications may fail.
If you apply a security system other than the systems listed blow, it will not work with the TV.

When applying the security key for the AP (wireless IP sharer), only the following is supported.
1) Authentication Mode : OPEN, SHARED, WPAPSK, WPA2PSK
2) Encryption Type : WEP, TKIP, AES
When applying the security key for the Ad-hoc mode, only the following is supported.
1) Authentication Mode : SHARED, WPANONE
2) Encryption Type : WEP, TKIP, AES

If your AP supports WPS(Wi-Fi Protected Setup), you can connect to the network via PBC (Push Button Configuration) or PIN 
(Personal Identification Number). WPS will automatically configure the SSID and WPA key in either mode.
If the device isn’t certified, it may not connect to the TV via the ‘Samsung Wireless LAN Adapter’.

■

■
■

■
■
■
■

❑

■
■

■

■

■
■

■
�

�

■

■

TV Rear PanelThe LAN Port on the Wall

1 LAN Cable

TV Rear PanelThe LAN Port on the Wall
IP Sharer

LAN CableLAN Cable

or

TV Rear Panel

The LAN Port on the WallWireless IP sharer

Samsung Wireless
LAN Adapter

LAN Cable
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Broadcast
Security

Network 		  ▶

General

Setup

The menu is activated only if the 
‘Samsung Wireless LAN Adapter’ 
is connected. 

■

Setting the Network
Setup

Option Description

Network Type Select Cable or Wireless as the method to connect to the 
network.

Cable
Connect to the network using a cable.

Wireless
Connect to the network wirelessly.

■

■

Network Setup Cable Network Setup 
(when Network Type is set to Cable)

Please check if the LAN cable is connected.
Internet Protocol Setup → Auto / Manual
Network Test: You can test or confirm the network 
connection status after setting up the network.

Cable Network Setup-Auto
If you connect the LAN cable and it supports DHCP, the 
Internet Protocol (IP) Settings are automatically configured. 
1.	 Set Network Type to Cable.
2.	 Select Cable Network Setup. 
3.	 Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
4.	 Select Network Test to check the network connectivity.

❑

■
�
�

■

When unable to connect to a wired network
If your Internet service provider has registered the MAC address of the device used to 
connect to the Internet for the first time and authenticates the MAC address each time you 
connect to the Internet, your TV may not be able to connect to the Internet as the MAC 
address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices 
other than your PC (such as your TV) to the Internet. If your Internet service provider 
requires an ID or password to connect to the Internet (network), your TV may not be 
able to connect to the Internet. In this case, you have to enter your ID or password when 
connecting to the Internet using an Internet Sharer (Router).
The internet connection may fail due to a firewall problem. In this case, contact your 
Internet service provider. If you cannot connect to the Internet even if you have followed 
the procedures of your Internet service provider, please contact Samsung Electronics.

Internet Protocol Setup	 : Auto		  ▶
Network Test

U Move     E Enter   R Return

Cable Network Setup

IP Address	 :          
Subnet Mask	 :          
Gateway	 :           
DNS Server	 :          
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Setup
Option Description

Network Setup Cable Network Setup-Manual
To connect the TV to the LAN using a static IP address, you 
must set up the Internet Protocol (IP). 
1.	 Set Network Type to Cable.
2.	 Select Cable Network Setup.
3.	 Set Internet Protocol Setup to Manual.
4.	 Set up IP Address, Subnet Mask, Gateway and DNS 

Server.
Press the number buttons on the remote control 
when you set the Network manually.

5.	 Select Network Test to check the network connectivity.
Wireless Network Setup

Internet Protocol Setup → Auto / Manual
Network Test: You can test or confirm the network 
connection status after setting up the network.
Select a network: Access Point: You can select 
the IP sharer to use when using a wireless network.

If a wireless Access Point is not in the Access Point 
list, press the Red button.
When the connection is made, you will be returned 
to the screen automatically.
If you have selected an Access Point with a security 
authentication: The Security Key input screen 
appears. Enter the security key and press the Blue 
button on the remote control.
If security encryption type is WEP, 0~9, A~F will be 
available when you input security key.

Connecting WPS (Wi-Fi Protected Setup)
If Security Key is already set: In access point list, select 
WPS.

You can select PBC, PIN, Security Key.
Connecting by using PBC: Select a PBC (Push 
Button Configuration). Press the PBC button on 
the AP (access point) within 2minutes, and wait for 
connection.
Connecting by using PIN: Select a PIN (Personal 
Identification Number).

The message showing the PIN Code is displayed. 
Input the PIN Code at AP device within 2minutes. 
Select OK and wait for connection.
Try again if connecting operation doesn’t work.
When the connection is not established although 
tried again, reset the access point. Please refer to a 
manual of each access point.

Connecting by using Security Key: When selecting 
Security Key, the input window is displayed. Input 
the security key and press ENTERE button.

Try again if connecting operation doesn’t work.
If Security Key is not set: When security setting 
of AP that supports WPS is NONE, you can select 
PBC, PIN, None Security. None Security is capable 
of connecting to AP directly without using WPC 
function.

Process of PBC, PIN is same as above.  
Refer to if Security Key is already set.
Try again if connecting operation doesn’t work.

■

■
�
�

�

●

●

●

●

■
�

�

●

●
●

�

●
�

●

●

The menu is activated only if the 
‘Samsung Wireless LAN Adapter’ 
is connected. 

■

Wireless Network Setup

 U Move     E Enter     R Return

Select a network 3/9

	 Search
	 Ad-hoc

sson
jee
AP_1
Ap_2

PBC
PIN
Security Key

Cancel

Press the PBC button on the access point.
Access Point Name : AP_1

Press OK After input TV’s Pin code in the access 
point’s setup.
Access Point Name : AP_1
PIN Code : 12345678

CancelOK

Wireless Network Setup

 n Move      `~9 Number     E Enter     R Return

Security Key

	 Number
	 	 Lowercase
	 	 Delete
	 	 Done

A

H

O

V

B

I

P

W

C

J

Q

X

D

K

R

Y

E

L

S

Z

F

M

T

G

N

U

Wireless Network Setup

 U Move     E Enter     R Return

Select a network 3/9

	 Search
	 Ad-hoc

sson
jee
AP_1
Ap_2

PBC
PIN
None Security

Wireless Network Setup

 n Move      `~9 Number     E Enter     R Return

Security Key

	 Number
	 	 Delete
	 	 Done

A B C D E F
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Setup
Option Description

Network Setup Ad-hoc: You can connect to a mobile device 
without an access point through the ‘Samsung 
Wireless LAN Adapter’ by using a peer to peer 
network.
How to connect to new Ad-hoc
1. Choose Select a network, then a device list is 

displayed.
2. While in the device list, press the Blue button on the 

remote or select Ad-hoc. 
The message that means the existing network 
is disconnected is displayed.

3. Input the generated Network Name(SSID) and 
Security Key into the device you want to connect.

How to connect an existing Ad-hoc device
1. Choose Select a network, the device list is 

displayed.
2. Select the device you want in the Device list.
3. If security key was applied, input the security key again.

If network doesn’t operate normally, please 
check the Network Name(SSID) and 
Security Key again. If the Security Key 
is incorrect, it may be the reason for the 
malfunction.

Wireless Network Setup-Auto
If you want to connect AP, AP should support DHCP.  
Only devices which support Ad-hoc mode can be 
connected without DHCP.
1.	 Set Network Type to Wireless.
2.	 Select Wireless Network Setup.
3.	 Set Internet Protocol Setup to Auto.

The Internet Protocol is set automatically.
4.	 Select a network through Select a network.
5.	 Select Network Test to check the network connectivity.

Wireless Network Setup-Manual
1.	 Set Network Type to Wireless.
2.	 Select Wireless Network Setup.
3.	 Set Internet Protocol Setup to Manual.
4.	 Set up IP Address, Subnet Mask, Gateway and DNS 

Server.
Press the number buttons on the remote control 
when you set the Network manually.

5.	 Select Network Test to check the network connectivity.

�

■

■

■

■

Internet Protocol Setup	 : Auto				    ▶
Network Test
Select a network 	 : AP1

U Move     E Enter     R Return

Wireless Network Setup

IP Address	 :          
Subnet Mask	 :          
Gateway	 :           
DNS Server	 :          

Internet Protocol Setup	 : Manual				    ▶
Network Test
Select a network 	 : AP1

U Move     E Enter     R Return

Wireless Network Setup

IP Address	 : 0   0   0   0

Subnet Mask	 : 0   0   0   0

Gateway	 : 0   0   0   0 
DNS Server	 : 0   0   0   0

The existing network system may have limited 
functionality. Do you want to change the network 
connection?

Yes No 

When unable to connect to an AP(Access Point)
Your TV may fail to locate an AP(Access Point) that is configured as a private SSID type. In 
this case, please change the AP settings and try again. If your Internet service provider has 
registered the MAC address of the device used to connect to the Internet for the first time and 
authenticates the MAC address each time you connect to the Internet, your TV may not be able 
to connect to the Internet as the MAC address differs from that of the device (PC).
In this case, ask your Internet service provider about the procedures to connect devices other 
than your PC (such as your TV) to the Internet. If you cannot connect to the Internet even if 
you have followed the procedures of your Internet service provider, please contact a Samsung 
Electronics.
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Input Menu
Input

Option Description

Source List Use to select TV or other external input sources such as 
DVD / Blu-ray players / Cable Box / Satellite receivers 
(Set-Top Box) connected to the TV. Use to select the input 
source of your choice.

TV / Ext. / AV / Component / PC / HDMI1/DVI / HDMI2 / 
HDMI3 / HDMI4 / USB1 / USB2

You can choose only those external devices that 
are connected to the TV. In the Source List, 
connected inputs will be highlighted and sorted to 
the top. Inputs that are not connected will be sorted 
to the bottom.
If USB devices are connected to the USB1(HDD) 
and USB2 jacks, they are displayed as USB1 and 
USB2 in order.
Using the Colour buttons on the remote with the 
Source list.

Red (Refresh): Refreshes the connected external 
devices. Press this if your Source is on and 
connected, but does not appear in the list.
TOOLS (Tools): Displays the Edit Name and 
Information menus.

■

�

�

�

●

●

Edit Name Name the device connected to the input jacks to make your 
input source selection easier.

VCR / DVD / Cable STB / Satellite STB / PVR STB / AV 
Receiver / game / Camcorder / PC / DVI / DVI PC / TV 
/ IPTV / Blu-ray / HD DVD / DMA

When a PC with a resolution of 1920 x 1080@60Hz 
is connected to the HDMI IN 1 port, you should set 
the HDMI IN 1(DVI) mode to DVI PC in the Edit 
Name of the Input mode.
When connecting an HDMI/DVI cable to the HDMI 
IN 1(DVI) port, you should set the HDMI1/DVI 
mode to DVI or DVI PC in the Edit Name of 
the Input mode. In this case, a separate sound 
connection is required.

■

�

�

Press the SOURCE button on 
the remote control to view an 
external signal source. TV mode 
can be selected by pressing the 
TV button.

■

Source List		

Edit Name

Input

PC always stays activated.■

   Refresh     T Tools

Source List

TV

Ext. 	 : - - - -
PC	 : - - - -

AV	 : - - - -
Component	 : - - - -
HDMI1/DVI 	 : - - - -
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Support menu
Support

Option Description

Legal Notice View the Legal Notice and General Disclaimer regarding 
Third Party Contents and Service.

The General Disclaimer may differ depending on the 
country.

■

Product Guide The Product Guide gives you information on the most 
important features of this TV.
The descriptions provided by this function are in English 
only.

Picture Quality Full HD 1080p
100Hz Motion Plus
Picture Mode

Medi@2.0 Internet@TV
Content Library Flash
USB2.0 Movie
DLNA Wireless

Eco-Friendly Energy Saving Mode
Eco Material

Using the Remote Control Buttons in the Product Guide Menu
Button Operations

Yellow Button Shows the contents of the Product Guide sequentially. 
(Auto Play)

◄/► Move the cursor and select an item.
ENTERE Select the currently selected item.
RETURN Return to the previous menu.

EXIT Stop the current function and return to the Product Guide 
main menu.

Support
Option Description

Self Diagnosis Picture Test
If you think you have a picture problem, perform the picture 
test. Check the colour pattern on the screen to see if the 
problem still exists.

Yes: If the test pattern does not appear or there 
is noise in the test pattern, select Yes. Therefore, 
contact Samsung’s call centre for assistance.
No: If the test pattern is properly displayed, select 
No. There may be a problem with your external 
equipment. Please check your connections. If the 
problem still persists, refer to the external device’s 
user manual.

Sound Test
If you think you have a sound problem, please perform the 
sound test. You can check the sound by playing a built-in 
melody sound through the TV.
‘Does the problem still exist with this sound test?’ appears 
on the screen.

Yes: If during the sound test you can hear sound only 
from one speaker or not at all, select Yes. Therefore, 
contact Samsung’s call centre for assistance.
No: If you can hear sound from the speakers, select 
No. There may be a problem with your external 
equipment. Please check your connections. If the 
problem still persists, refer to the external device’s 
user manual.

■

�

�

■

�

�

If you hear no sound from the 
TV’s speakers, before performing 
the sound test, make sure 
Speaker Select is set to TV 
speaker in the Sound menu.

■

The melody will be heard during 
the test even if Speaker Select 
is set to External Speaker or the 
sound is muted by pressing the 
MUTE button.

■

Legal Notice		  ▶

Product Guide
Self Diagnosis
Software Upgrade
HD Connection Guide
Contact Samsung

Support
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If the signal strength meter 
indicates that the signal is weak, 
physically adjust your antenna 
to increase the signal strength. 
Continue to adjust the antenna 
until you find the best position 
with the strongest signal.

■

Current Version	 2009/01/17_000001

By USB			   ▶
By Channel
Standby Mode Upgrade	 : 45 Min	
Alternative Software	 2009/01/16_000000

U Move     E Enter     R Return

Software Upgrade

Support
Option Description

Self Diagnosis Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception 
quality from ‘snowy’ to clear, digital (HDTV) channels have 
either perfect reception quality or you will not receive them 
at all. So, unlike analogue channels, you cannot fine tune 
a digital channel. You can, however, adjust your antenna to 
improve the reception of available digital channels.

■

Software Upgrade Samsung may offer upgrades for the TV’s firmware in the 
future. These upgrades can be performed via the TV when 
it is connected to the Internet, or by downloading the new 
firmware from samsung.com to a USB memory device.

Current Version is the software already installed in 
the TV.
Alternative Software (Backup) shows the previous 
version that will be replaced.
Software is represented as ‘Year/Month/Day_Version’. 
The more recent the date, the newer the software 
version. Installing the latest version is recommended.

By USB
Insert a USB drive containing the firmware upgrade 
downloaded from samsung.com into the TV. Please be 
careful to not disconnect the power or remove the USB 
drive while upgrades are being applied. The TV will turn 
off and turn on automatically after completing the firmware 
upgrade. Please check the firmware version after the 
upgrades are complete (the new version will have a 
higher number than the older version). When software is 
upgraded, video and audio settings you have made will 
return to their default (factory) settings. We recommend you 
write down your settings so that you can easily reset
them after the upgrade.

By Channel
Upgrades the software using the broadcasting signal.

If the function is selected during the software 
transmission period, this function searches for 
available software and downloads the software.
The time required to download the software is 
determined by the signal status.

Standby Mode Upgrade
To continue software upgrade with master power on, 
Select On by pressing the ▲ or ▼ button. 45 minutes after 
entering standby mode, a manual upgrade is automatically 
conducted. Since the power of the unit is turned on 
internally, the screen may be on slightly for the LED 
product. This phenomenon may continue for more than 1 
hour until the software upgrade is completed.

Alternative Software (Backup)
If there is an issue with the new firmware and it is affecting 
operation, you can change the software to the previous 
version.

If software was changed, existing software is 
displayed.
You can change current software to alternative 
software by Alternative Software.

�

�

�

■

■

�

�

■

■

�

�

HD Connection Guide This menu presents the connection method that provides 
the optimal quality for the HD TV. Refer to this information 
when connecting external devices to the TV.

Contact Samsung View this information when your TV does not work properly 
or when you want to upgrade the software. You can view 
the information regarding the call centre, product and 
software file download method.

TV Rear Panel

or

USB Drive
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Connecting a USB Device
1	 Press the POWER button to turn the TV on.					   

	

2	 Connect a USB device containing photo, music and/or movie files to the 
USB1(HDD) or USB2 jack on the side of the TV.		

3	 When the Application selection screen is displayed, press the ENTERE 
button to select Media Play (USB & DLNA).

Using the Remote Control Button in Media Play Menu
Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE

Select the currently selected item. While playing a slide show, 
movie, or music file:
- Pressing the ENTERE button during play pauses the play.
- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music or movie.
RETURN Return to the previous menu.
TOOLS Run various functions from the Photo, Music and Movie menus.

∫ Stop the current slide show, Music or Movie file.
π/μ Jump to previous group/Jump to next group.

INFO Show file information.
MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.

MTP (Media Transfer Protocol) is not supported.
The file system supports FAT16, FAT32 and NTFS.
Certain types of USB Digital camera and audio devices may not be compatible with this TV.
Media Play only supports USB Mass Storage Class devices (MSC). MSC is a Mass Storage Class Bulk-Only Transport device. 
Examples of MSC are Thumb drives, Flash Card Readers and USB HDD (USB HUB are not supported.).
Please connect directly to the USB port of your TV. If you are using a separate cable connection, there may be a USB compatibility 
problem.
Before connecting your device to the TV, please back up your files to prevent them from damage or loss of data. SAMSUNG is not 
responsible for any data file damage or data loss.
Connect a USB HDD to the dedicated port, USB1 (HDD) port. However, if the connected device requires high power, the USB1 (HDD) 
may fail to support the device.
Do not disconnect the USB device while it is loading.
MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.
The sequential JPEG format is supported.
The higher the resolution of the image, the longer it takes to display on the screen.
The maximum supported JPEG resolution is 15360X8640 pixels.
For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.
If sort key is set to Basic View, up to 1000 files can be displayed in each folder. The other sort key can display up to 10000 files.
MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) is a 
technology that supports the creation of content, the distribution and management of the content in an integrated and comprehensive 
way, including the protection of the rights and interests of the content providers, the prevention of the illegal copying of contents, as well 
as managing billings and settlements.
When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen.
If more than 2 PTP devices are connected, you can only use one at a time.
If more than one MSC device is connected, some of them may not be recognized.  
If a device requires high power (more than 500mA or 5V), the USB device may not be supported.
If an over-power (Fail add new device USB1/USB2 Power Overload) warning message is displayed while you are connecting or using a 
USB device, the device may not be recognized or may malfunction.

■
■
■
■

■

■

■

■
■
■
■
■
■
■
■

■
■
■

■

Media Play - USB Device
TV Rear Panel

or

USB Drive

851.86MB/993.02MB Free

Photo

SUM

SUM   Device

PHOTO

e Exit

Music Movie Setup
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Media Play Function
This function enables you to view and listen to photo, music and/or movie files saved on a 
USB Mass Storage Class (MSC) device.

It might not work properly with unlicensed multimedia files.

Entering the Media Play (USB & DLNA) Menu

1	 Press the MENU button. Press the ▲ or ▼ button to select Application, then 
press the ENTERE button.

2	 Press the ▲ or ▼ button to select Media Play (USB & DLNA), then press the 
ENTERE button.

The Media Play (USB & DLNA) menu is displayed.

3	 Press the Red button, then press the ▲ or ▼ button to select the USB Memory. 
Press the ENTERE button.

This function differs depending on the USB Memory Device / DLNA device.
The selected USB device name appears at the bottom left of the screen.

4	 Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then 
press the ENTERE button. 

To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely
You can remove the device safely from the TV.

1	 Press the TOOLS button in the Media Play file list screen, or while a Slide Show, 
music or movie is being played.

2	 Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE 
button.	

3	 Remove the USB device from the TV.

Screen Display

Move to either ‘Sort key List Section’, ‘Group List Section’ or ‘File List Section’ using the Up 
and Down buttons. After selecting a section, press the ◄ or ► buttons to select an item.

■

■

■
■

■

Press the MEDIA.P button on the 
remote control to display the Media 
Play menu.
Press the SOURCE button on the 
remote control to view the source 
list. Then Press the ▲ or ▼ button 
to select USB.

■

■

851.86MB/993.02MB Free

Photo

SUM

SUM   Device

PHOTO

R Return

Music Movie Setup

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TimelineFolderColour

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

Slide Show
Play Current Group
Information
Remove Safely

5/15

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TimelineFolderColour

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

5/15

1File(s) Selected

1

2

3

4 5

6

Sort key List Section

Group List Section

File List Section
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Sorting the Photo List
You can sort photos in the Photo List by a particular standard.

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Photo, then press the ENTERE button. 		

3	 Press the ▲ button to move to the Sort key Section.				  

4	 Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 
Colour, Folder, Preference)

The photos are sorted according to the newly selected sorting standard.

5	 Press the ▼ button to move to the File List Section. Press the ∂ (Play)/
ENTERE button to start the Slide Show in the order you selected.

To move to the previous/next group, press the π (REW) or μ (FF) 
button.
Photo information is automatically set. The colour information extracted from 
a photo file may be different from your expectations. You can change the 
colour and preference.
PTP does not support folder sort mode.

Option Description
Basic View Shows the folders on the USB memory device.  

If you select a folder and press the ENTERE button, only 
the photo files contained in the selected folder are displayed.

When sorted according to the Basic View, you cannot 
set Favourites files.

■

Timeline It sorts and shows photos by date.  
It sorts by year and month from the earliest photo.

Colour Sorts photos by colour. You can change the photo colour 
information

You should set the Use Colour View to on in the Setup 
menu before sorting photos by colour.

■

Folder It Sorts photos by folder. If there are many folders in USB, 
the photos files are shown in order in each folder.  
The photo file in the Root folder is shown first and the others 
are shown in alphabetical order by name.

Preference It Sorts photos by preference (Favourites).  
You can change the photo preferences.

Changing the Favourites Settings.  
Select the desired photo in the Photo list, then press the 
Green button repeatedly until the desired setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only.  
For example, the 3 star setting does not have any priority 
over the one star setting.

■

■
■

■

■

■

■

1	 Current Sort key: This field shows the current standard for sorting files.  
Press the ◄ or ► button to change the standard for sorting files.

2	 View Groups: Shows the detailed groups of the files sorted according the 
selected Sort key. The sort group where the currently selected file is contained is 
highlighted.

3	 Currently selected file: The selected file is the file you can now control.  
Photo and movie files are displayed as thumbnail images.

4	 Current Device: Shows the currently selected device name.  
Press the Red button to select a device.

Red (Device) button: Selects a connected device.
5	 Help Items

Green (Favourites Settings) button: Changes the Favourites Settings 
for the selected file. Press this button repeatedly until the desired value 
appears.
Yellow (Select) button: Selects file from the file list.  
Selected files are marked with a symbol c.  
Press the Yellow button again to cancel a file selection.
TOOLS (Tools) button: Displays the option menus.  
(The option menu changes according to the current status.)

6	 Item Selection Information: Shows the number of files that are selected by 
pressing the Yellow button.	

■

■

■

■

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TimelineFolderColour

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

5/15
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Photo List Option Menu

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Photo, then press the ENTERE button. 		
	

3	 Press the ◄ or ► button to select the desired photo file.
Selecting Multiple Photos

Press the ◄ or ► button to select the desired photo file.  
Then press the Yellow button.
Repeat the above operation to select multiple photo files.
The mark c appears to the selected photo file.

4	 Press the TOOLS button.
The option menu changes according to the current status.

Option Description
Slide Show Using this menu, you can play a Slideshow using the 

photo files on the USB memory device.
Play Current Group Using this menu, you can play a Slideshow using only the 

photo files in the currently selected sorting group.
Change Group Info 
(When the Sort key is the 
Colour)

You can change a selected photo file’s (or group of files) 
colour information in order to move it from one colour 
group to another.

This does not change the actual colour of the photo.
The group information of the current file is updated and 
the photos are moved to the new colour group.
To change the information of multiple files, select the 
files you want by pressing the Yellow button.

■
■

■

Deselect All  
(When at least one file is 
selected)

You can deselect all files.
The c mark indicating the corresponding file is 
selected is hidden.

■

Information The photo file information including the name, the 
size, the resolution, the date modified and the path is 
displayed.

You can view the information of photo files during a 
Slideshow using the same procedures.

■

Remove Safely You can remove the device safely from the TV.

■
�

�
�

■

Press the INFO button to viewing 
the information. 

■

SUM   Device  Favourites Settings    Select   T Tools  R Return

Colour Folder PreferenceTimelineBasic View

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

Slide Show
Play Current Group
Change Group Info
Information

▼

5/15
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Viewing a Photo or Slide Show
Viewing a Slide Show

1	 Press the ▼ button to select the File List Section.	 	 	 	

2	 Press the TOOLS button.	 	 	 	 	 	

3	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE 
button.

All files in the File List Section will be used for the Slide Show.
During the slide show, files are displayed in order from the currently shown 
file.
The Slide Show progresses in the order sorted in the File List Section.
Music files can be automatically played during the Slide Show if the 
Background Music is set to On.
While a photo list is displayed, press the ∂(Play)/ENTERE button on 
the remote control to start slide show.

Slideshow Control Buttons
Button Operations

ENTERE Play/Pause the Slide Show.
∂ Play the Slide Show.
∑ Pause the Slide Show.
∫ Exit Slide Show and return to the photo list.
π/μ Change the Slideshow playing speed.
TOOLS Run various functions from the Photo menus.

Playing Current Group

1	 Press the ▲ button to move to the Sort key Section.	 	 	 	

2	 Press the ◄ or ► button to select a sorting standard. 	 	 	 	

3	 Press the ▼ button to move to the Group List Section.	 	 	 	

4	 Select a group using the ◄ and ► buttons.	 	 	 	 	

5	 Press the ∂ (Play) button. A slideshow begins with the files of the selected 
group.

Alternatively 

1	 Select a Sort key and then in the File List Section, select the photos contained in 
the desired group.

To move to the previous/next group, press the π (REW) or μ (FF) button.

2	 Press the TOOLS button. 	 	 	 	 	 	

3	 Press the ▲ or ▼ button to select Play Current group, then press the 
ENTERE button.

Only the photos in the sorting group including the selected files will be used 
for the Slide Show.

To perform a Slide Show with only the selected Files

1	 Press the ▼ button to select the File List Section.	 	 	 	

2	 Press the ◄ or ► button to select the desired photo in the File List Sectiont.	 	
	

3	 Press the Yellow button.	 	 	 	 	 	

4	 Repeat the above operation to select multiple photos.
The c mark appears to the left of the selected photo.
If you select one file, the Slide Show will not be performed.
To deselect all selected files, press the TOOLS button and select Deselect 
All.

5	 Press the ∂ (Play)/ENTERE button.
The selected files will be used for the Slide Show.

■
■

■
■

■

■

■

■
■
■

■

SUM   Device  Favourites Settings    Select   T Tools  R Return

Basic View TimelineFolderColour

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

Slide Show
Play Current Group
Information
Remove Safely

5/15

Preference

E Pause      ◀▶ Previous / Next     T Tools     R ReturnSUM

1234.jpg                          580x765       2009/12/02       5/15▶  Normal

SUM   Device  Favourites Settings    Select   T Tools  R Return

Basic View TimelineFolderColour

1234.jpg 1235.jpg 1236.jpg 1237.jpg
1233.jpg1232.jpg1231.jpg

5/15

Preference
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Alternatively 

1	 In the File List Section, press the Yellow buttons to select the desired photos.		
	

2	 Press the TOOLS button. 						    

3	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE 
button.

The selected files will be used for the Slide Show.

Slide Show Option Menu

1	 During a slide show (or when viewing a photo), press the TOOLS button to set 
the option.

2	 Press the ▲ or ▼ button to select the desired option, then press the ENTERE 
button.

Option Description
Stop Slide Show /  
Start Slide Show

You can start or stop a Slideshow.

Slide Show Speed You can select the slide show speed.
This function is available only during a slide show.
You can also change the speed of the Slide Show by 
pressing the π (REW) or μ (FF) button during the 
Slide Show.

■
■

Slide Show Effect You can select the screen transition effect used in the 
slideshow.

None / Fade1 / Fade2 / Blind / Spiral / Checker / 
Linear / Stairs / Wipe / Random 
This function is available only during a slide show.

■

Rotate You can rotate photos saved on a USB memory device.
Whenever you press the ◄ button, it rotates by 270˚, 
180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 
180˚, 270˚, and 0˚. 
The rotated file is not saved.

■

■

■
Zoom You can magnify photos saved on a USB memory device. 

(x1 → x2 → x4)
To move the enlarged photo image, press the 
ENTERE button, then press the ▲/▼/◄/► buttons. 
Note that when the enlarged picture is smaller than 
the original screen size, the location change function 
doesn’t work.
The enlarged file is not saved.

■

■
Background Music You can select background music when watching a Slide 

Show.
Background Music

Off: Background music is not played.
On: When the background music is available, if 
you select On, the music is played back. 

BGM Mode
You can select a mode to use for the background music.

BGM Mood
Music with the mood you selected is set as the 
background music.
If you set BGM Mode to Mood, you can select a mood.

Select Music File (0 File(s) Selected)
Only the selected music file is set as the background 
music.
If you set BGM Mode to Selected File, you can select a 
music file.

■
�
�

■

■

■

Picture Setting /  
Sound Setting

You can select the picture and sound settings.

Information The photo file information is displayed.

Remove Safely You can remove the device safely from the TV.

■

To use this feature, there must be 
music and photo files stored on 
the USB device.
Loading music files is needed to 
change BGM mode. Play music 
files in music category to load.

■

■

Stop Slide Show
Slide Show Speed	 :	 Normal
Slide Show Effect	 :	 Fade1
Rotate
Zoom
Background Music
Picture Setting
Sound Setting
Information
	 ▼

U Move     E Enter     e Exit

Tools
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Sorting the Music List
You can sort music files in the Music List by a particular standard.

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Music, then press the ENTERE button.		

3	 Press the ▲ button to move to the Sort key Section. 				  

4	 Press the ◄ or ► button to select a sorting standard. (Basic View, Title, Artist, 
Mood, Genre, Folder, Preference)

The Music files are sorted according to the newly selected sorting standard.

5	 Press the ▼ button to move to the File List Section. Press the ENTERE button 
to start playing music in the order selected by the user.

To move to the previous/next group, press the π (REW) or μ (FF) 
button.
Music information is automatically set. The mood information extracted from 
a music file may differ from the expectations of the user. You can change the 
mood and preference.

Option Description
Basic View Shows the folders of the USB memory device.  

If you select a folder and press the ENTERE button, 
only the music files contained in the selected folder are 
displayed.

When sorted according to the Basic View, you cannot 
set Favourites files.

■

Title Sorts the music titles in symbol/number/alphabet/special 
order, and shows the music file.

Artist Sorts the music file by artist in symbol/number/alphabet/
special order.

Mood Sorts music files by the mood. You can change the music 
mood information.

Genre Sorts music files by the genre.
Folder Sorts music files by the folder. If there are many folders in 

USB, the files are shown in order in each folder.  
The music file in the Root folder is shown first and the 
others are shown in alphabetical order by name.

Preference Sorts music files by preference (Favourites).  
You can change the music files preferences.

Changing the Favourites Setting 
Select the desired music file in the Music list, then 
press the Green button repeatedly until the desired 
setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only.  
For example, the 3 star setting does not have any 
priority over the one star setting.

■

■
■

Music List Option Menu

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Music, then press the ENTERE button. 		
	

3	 Press the ◄ or ► button to select the desired Music file. 
Selecting Multiple Music Files

Press the ◄ or ► button to select the desired music file. Then press the 
Yellow button.
Repeat the above operation to select multiple music files.
The mark c appears to the selected music file.

4	 Press the TOOLS button.
The option menu changes according to the current status.

■

■

■

■
�

�
�

■

If there is no title information 
for a music file, the filename is 
displayed.
If no information is available for the 
Artist, Album, Year, or Genre the 
corresponding item is displayed 
as blank.

■

■

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TitleFolderGenre

I Love You HaHaHa Gold Shine
WayWant MeLies

Glen Hans
Once Ost
2007
Soundtrack

3/37Energetic

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TitleFolderGenre

HaHaHa Gold Shine
WayWant MeLies

I Love You

Glen Hans
Once Ost
2007
Soundtrack

3/37Energetic Play Current Group
Information
Remove Safely
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Option Description
Play Current Group Using this menu, you can only play music files in the 

currently selected sorting group.
Change Group Info 
(When the Sort key is 
Mood)

You can change the mood information of music files.
The group information of the current file is updated and 
the file is moved to the new group.

To change the information of multiple files, select files 
by pressing the Yellow button.

■

Deselect All  
(When at least one file is 
selected)

You can deselect all files.
The c mark indicating the corresponding file is 
selected is hidden.

■

Information The music file information including the name, the size, 
the date modified and the path is displayed.

You can view the music file information during a Play 
Current Group using the same procedures.

■

Remove Safely You can remove the device safely from the TV.

Playing a Music
Playing a Music File

1	 Press the ▼ button to select the File List Section.				  

2	 Press the ◄ or ► button to select a music file to be played.			 
	

3	 Press the ∂ (Play)/ENTERE button.
This menu only shows files with the MP3 file extension. Files with other 
file extensions are not displayed, even if they are saved on the same USB 
device.
The selected file is displayed at the top with its playing time.
To adjust the music volume, press the volume button on the remote control. 
To mute the sound, press the MUTE button on the remote control.
If the sound is odd when playing MP3 files, adjust the Equalizer and SRS 
TruSurround HD in the Sound menu. (An over-modulated MP3 file may 
cause a sound problem.)
The playing duration of a music file may be displayed as ‘00:00:00’ if its 
playing time information is not found at the start of the file.
π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons
Button Operations

ENTERE Play/Pause the music file.
∂ Play the music file
∑ Pause the music file
∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.

Music Function Information Icon

p When all music files in the folder (or the selected file) are 
repeated. Repeat Mode is On.

q When all music files in the folder (or the selected file) are played 
once. Repeat Mode is Off.

■

■
■

■

■

■

Press the INFO button to viewing 
the information. 

■

E Pause      ◀▶ Previous / Next     T Tools     R ReturnSUM

 I Love You HaHaHaWay

▶            00:00:04 / 00:04:04                                       3/37
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Playing the Music Group

1	 Press the ▲ button to move to the Sort key Section.				  

2	 Press the ◄ or ► button to select a sorting standard.				  

3	 Press the ▼ or ENTERE button to move to the Group List Section.		

4	 Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 

1	 Select a sort key and then in the File List Section, select the files contained in 
the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) 
button.

2	 Press the TOOLS button. 						    

3	 Press the ▲ or ▼ button to select Play Current Group, then press the 
ENTERE button.

The music files in the sorting group including the selected file are played.

Playing the selected Music Files

1	 Press the ▼ button to select the File List Section.				  

2	 Press the ◄ or ► button to select the desired music file.				 

3	 Press the Yellow button.			 

4	 Repeat the above operation to select multiple music files.
The c appears to the left of the selected music file.
To deselect all selected files, press the TOOLS button and select Deselect 
All.

5	 Press the ∂ (Play)/ENTERE button.
The selected files will be played.

Music Play Option Menu

Option Description
Repeat Mode You can play music files repeatedly.
Picture Setting /  
Sound Setting

You can configure the picture and sound settings.

Information The music file information is displayed.
Remove Safely You can remove the device safely from the TV.

■

■

■
■

■

Repeat Mode	 ◀            On             ▶
Picture Setting
Sound Setting
Information
Remove Safely

U Move     L Adjust     e Exit

Tools
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Sorting the Movie List
You can sort movies in the Movie List by a particular standard.

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Movie, then press the ENTERE button.		

3	 Press the ▲ button to move to the Sort key Section.				  

4	 Press the ◄ or ► button to select a sorting standard. (Basic View, Timeline, 
Title, Folder, Preference)

The movie files are sorted according to the newly selected sorting standard.  

5	 Press the ∂ (Play)/ENTERE button to play the movie in the order selected.
Movie information is automatically set. You can change the preference.

Option Description
Basic View Shows the folders of the USB memory device.  

If you select a folder and press the ENTERE button, 
only the movie files contained in the selected folder are 
displayed.

When sorted according to the Basic View, you cannot 
set Favourites files.

■

Timeline Sorts movies by date. It sorts by year and month from the 
earliest movie.

Title Sorts and displays the movie titles in symbol/number/
alphabet/special order.

Folder If there are many folders in USB, the movies files are 
shown in order in each folder. The movie file in the 
Root folder is shown first and the others are shown in 
alphabetical order by name.

Preference Sorts movies by preference. (Favourites)  
You can change the movie preferences.

Changing the Favourites Setting 
Select the desired movie file in the movie list, then 
press the Green button repeatedly until the desired 
setting appears.
Up to 3 stars can be selected.
The stars are for grouping purposes only.  
For example, the 3 star setting does not have any 
priority over the one star setting.

■

■
■

Movie List Option Menu

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Movie, then press the ENTERE button.		
	 

3	 Press the ◄ or ► button to select the desired Movie file. 
Selecting Multiple Movie Files

Press the ◄ or ► button to select the desired movie file.  
Then press the Yellow button.
Repeat the above operation to select multiple movie files.
The mark c appears to the selected movie file.

4	 Press the TOOLS button.
The option menu changes according to the current status.

■

■

■
�

�
�

■

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TimelineFolderTitle

ABCD.avi 1235.avi 1236.avi 1237.avi
1233.avi1232.avi1231.avi

5/15

SUM   Device  Favourites Settings    Select   T Tools  R Return

Preference Basic View TimelineFolderTitle

ABCD.avi 1235.avi 1236.avi 1237.avi
1233.avi1232.avi1231.avi

5/15 Play Current Group
Information
Remove Safely
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Option Description
Play Current Group Using this menu, you can only play movie files in the 

currently selected sorting group.
Deselect All  
(When at least one file is 
selected)

You can deselect all files.
The c mark indicating the corresponding file is 
selected is hidden.

■

Information The movie file information including the name, the size, 
the date modified and the path is displayed.

Remove Safely You can remove the device safely from the TV.

Playing a Movie File
Playing a movie file

1	 Press the ▼ button to select the File List Section. 				  

2	 Pressing the ◄ or ► button to select a movie file to be played.			 
	

3	 Press the ∂ (Play)/ENTERE button.
The selected file is played.
The selected file is displayed at the top with its playing time.
The playing duration of a movie file may be displayed as ‘00:00:00’ if its 
playing time information is not found at the start of the file.
You can watch exciting gaming multimedia files, but the gaming function is 
not supported.
Movie doesn’t support subtitles. (for example, not support smi, srt and sub 
files, etc and not support subtitles included in movie files)

Supported Subtitle Formats
Name File extension Format

MPEG-4 time-based text .ttxt XML
SAMI .smi HTML

SubRip .srt string-based
SubViewer .sub string-based
Micro DVD .sub or .txt string-based

Supported Video Formats
File Extension Container Video Decoder Audio codec

*.avi AVI

Divx 3.11

MP3, AC3, LPCM, ADPCM 
(MULAW ALAW)

Divx 4.x
Divx 5.1
Divx 6.0
XviD
H.264 BP
H.264 MP
H.264 HP
MPEG-4 SP
MPEG-4 ASP
Motion JPEG

*.mkv MKV

Divx 3.11

MP3, AC3, LPCM, ADPCM 
(MULAW ALAW), AAC

Divx 4.x
Divx 5.1
Divx 6.0

XviD
H.264 BP
H.264 MP
H.264 HP

MPEG-4 SP
MPEG-4 ASP
Motion JPEG

■
■
■

■

■

E Pause      ◀ ▶ Jump     T Tools     R ReturnSUM

ABC.avi

▶      00:00:01 / 00:05:30                                              3/37

Press the INFO button to viewing 
the information. 

■
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File Extension Container Video Decoder Audio codec

*.asf ASF

Divx 3.11

WMA, MP3, AC3, LPCM, 
ADPCM, (MULAW ALAW), 

AAC

Divx 4.x
Divx 5.1
Divx 6.0

XviD
H.264 BP
H.264 MP
H.264 HP

MPEG-4 SP
MPEG-4 ASP

*.wmv (VC1) Window Media Video v9

*.mp4 MP4 
(SMP4)

H.264 BP

ADPCM, (HE)-AAC, mp3
H.264 MP
H.264 HP

MPEG-4 SP
MPEG-4 ASP

XVID

*.3gp 3GPP

H.264 BP

ADPCM, (HE)-AAC
H.264 MP
H.264 HP

MPEG-4 SP
MPEG-4 ASP

*.vro (ps) VRO / 
VOB

MPEG2 AC3, MPEG, LPCMMPEG1
*.mpg

*.mpeg (ps)
MPEG1 (Programme Stream) AC3, MPEG, LPCMMPEG2 (Programme Stream)

others (ts)
MPEG2 (Transport Stream)

AAC, HE-AAC, MP3, DD+H.264 (Transport Stream)
VC1 (Transport Stream)

Video Play Control Buttons
Button Operations

ENTERE Play/Pause the movie file
∂ Play the movie file
∑ Pause the movie file

TOOLS Run various functions from the Movie menus.
∫ Exit play mode and return to the movie list.

◄ / ► Skip forwards or backwards through the movie file.
▲ / ▼ Move to the first/last of the file.

μ Play the file at double speed. This function may not be supported 
depending on the codec.

Playing the movie group

1	 Press the ▲ button to move to the Sort key Section.				  

2	 Press the ◄ or ► button to select a sorting standard. 				  

3	 Press the ▼ or ENTERE button to move to the Group List Section.		
	

4	 Press the ∂ (Play) button. Only the files of the selected group will start playing.
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Alternatively 

1	 Select a Sort key and then in the File List Section, select the files contained in 
the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) 
button.

2	 Press the TOOLS button. 						    

3	 Press the ▲ or ▼ button to select Play Current Group, then press the 
ENTERE button.

The movie files in the sorting group including the selected file are played.

Playing the selected Movie Files

1	 Press the ▼ button to select the File List Section.				  

2	 Press the ◄ or ► button to select the desired music file.				 

3	 Press the Yellow button. 
The c mark appears to the left of the selected movie file.
To deselect all selected files, press the TOOLS button and select Deselect 
All.

4	 Repeat the above operation to select multiple movie files.			 

5	 Press the ∂ (Play)/ENTERE button.
Only the selected file is played.

Playing Movie continuously (Resume Play)
If you exit the playing movie function, the movie can be played later from the point where it 
was stopped.

1	 Select the movie file you want to play continuously by pressing the ◄ or ► 
button to select it from the File List Section.

2	 Press the ∂ (Play)/ENTERE button.					   

3	 Select Play Continuously (Resume Play) by pressing the Blue button.
The Movie will begin to play from where it was stopped.
If Cont. Movie Play Help function is set On in the Setup menu, a pop-up 
message will appear when you resume play a movie file.M

Movie Play Option Menu
Option Description

Picture Setting /  
Sound Setting

You can configure the picture and sound settings.

Picture Size Fit
Play video at the TV screen size.

Original
Play video at the original size.

■

■

■

■

■
■

■

■
■

Picture Setting
Sound Setting
Picture Size	 :	 Fit
Caption Setting
Information
Remove Safely

U Move     E Enter     e Exit

Tools
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Option Description
Caption Setting You can set the captions for the movie.

Caption 
You can turn the captions for the movie on or off.

Caption Language
You can set the caption language.

Caption Size
You can change the font size of the captions.

Caption Sync
You can adjust the caption sync.

Caption Sync Reset
You can reset the adjusted caption sync.

■

■

■

■

■

Information The movie file information is displayed.
Remove Safely You can remove the device safely from the TV.

Using the Setup Menu
Setup displays the user settings of the Media Play menu.

1	 Press the MEDIA.P button.						    

2	 Press the ◄ or ► button to select Setup, then press the ENTERE button.		
	

3	 Press the ▲ or ▼ button to select the desired option.				  

4	 Press the ◄ or ► button to select the option, then press the ENTERE button.
To exit Media Play mode, press the MEDIA.P button on the remote control.

Option Description
Use Colour View You can select sorting photos by colour. If this option is 

set to On, the loading time may be increased to collect 
colour information from the photos.

Music Repeat Mode Select to repeatedly play music files.
Cont. movie play help Select to display the help pop-up message for continuous 

movie playback.
Get the DivX® VOD 
registration code

Shows the registration code authorized for the TV. If you 
connect to the DivX web site and register the registration 
code with a personal account, you can download VOD
registration file.
If you play the VOD registration using Media Play, the 
registration is completed.

For more information on DivX® VOD, visit www.DivX.
com.

■

Get the DivX® VOD 
deactivation code

When DivX® VOD is not registered, the registration 
deactivation code is displayed.
If you execute this function when DivX® VOD is 
registered, the current DivX® VOD registration is 
deactivated.

Screen Saver Run Time Select to set the waiting time before the screen saver 
appears.

Information Select to viewing the information of the connected device.
Remove Safely You can remove the device safely from the TV.

■

851.86MB/993.02MB Free

Photo

SUM

SUM   Device

SETUP

e Exit

Music Movie Setup

Use Colour View	 ◀               Off	 ▶
Music Repeat Mode	                   On
Cont. movie play help	                   On
Get the DivX® VOD registration code
Get the DivX® VOD deactivation code
Screen Saver Run Time	              4 hours
Information
Remove Safely

U Move    L Adjust    R Return

If this is set to ON, the loading time increases for collecting the colour
information.

SUM   Device
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Media Play-DLNA
Setting the DLNA Network
DLNA allows you to watch pictures, musics and videos saved on your PC or on your TV through a network connection in Media
Play mode. This removes the need to copy them to a USB storage device and then connect the device to your TV.  
To use DLNA, the TV must be connected to the network and the DLNA application must be installed on your PC.

Network Connection Diagram

Network Connection Diagram-Cable

Network Connection Diagram-Wireless

1	 For more information on how to configure your network, refer to page 37.
You are recommended to locate both TV and PC in same subnet. The first 3 parts of the subnet address of the TV and 
the PC IP addresses should be the same and only the last part (the host address) should be changed. (e.g. IP Address: 
123.456.789.**)

2	 Connect the PC to which the Samsung PC Share Manager programme will be installed and the external modem using a 
LAN cable.

You can connect the TV to the PC directly without connecting it through a Sharer (Router).

■

■

LAN

External Modem 
(ADSL/VDSL/Cable TV)

TV
PC

LAN

Wireless IP sharer

LAN Cable

TV
PC

Samsung Wireless
LAN Adapter

TV Rear Panel

LAN
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Installing the DLNA Application
To play content on the PC on the TV, you have to first install the application. To use the DLNA function smoothly, use the
programme in the CD-ROM supplied with the TV or use the Samsung PC Share Manager programme corresponding to the TV
model that can be downloaded from the Samsung web site.

System Requirements

1	 Insert the Programme CD supplied with this TV into your PC.						    

2	 30MB of free hard disk space is needed for the programme installation.
If you share files, up to 30MB of hard disk drive space is required for each 100 files.
If you cancel file sharing, the hard disk drive space used for the thumbnail information is also freed.

Supported Formats
Image: JPEG/ Audio: MP3/ Video: AVI, MKV, ASF, MP4, 3GPP, PS, TS container.  
For detailed supported video formats, refer to page 53. 	

Install the Application

1	 Run the Setup.exe file on the Programme CD supplied with the product.
Alternatively, you can download the file from www.samsung.com.					   

2	 Install the SAMSUNG PC Share Manager as shown in the figures. 

3	 When the installation is complete, the PC Share Manager icon appears on your Desktop.
Double-click the icon to run the programme.

■
■

■

■
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Using the DLNA Application
The Programme Screen Layout

1

3 4 5
6 7

2

1	 Menus: The following application menus 
are provided : File, Share, Server, and 
Help.

2	 Click to share the selected PC server 
folder.

3	 Click to cancel sharing.                                  

4	 Click to refresh the PC folder and files. 

5	 Click to synchronize the share status.

6	 The folders and files of the PC to be 
shared are listed.

7	 Folders shared by the user are listed.

Option Description
File Property

Shows information on the selected file or folder.
Method 1: Select a file or folder and select the File menu and then select the Property 
sub-menu.
Method 2: Select a file or folder, right-click over the selected file or folder and then select 
Property from the pop-up menu.

Exit
Exits the DLNA application.
If you select Exit without applying the changes after changing the shared status, a message will appear 
asking if you want to apply the changed settings to the PC. Select Yes to apply the changes and exit the 
application.

■

�

�

■

<Method 1> <Method 2>
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Option Description
Share Sharing a Folder

You can share a folder from your PC to the TV. The maximum number of folders that can be shared is 32.
Your PC will operate as a server to the TV.

Method 1: Select a folder in My Computer, select the Share menu and then select the Share 
Folder sub-menu.
Method 2: Select a folder in My Computer, right-click over the selected folder and then select 
Share Folder from the popup menu.
Method 3: Locate the mouse pointer over a folder in the My Computer folder list in the left pane 
and drag & drop the folder into the Shared Folders pane. If a message appears asking you to 
confirm the shared folder, select Yes.

■

�

�

�

Cancelling a Shared Folder
You can cancel a shared folder on your PC. Select a folder from the Shared Folder pane and select 
Unshare Folder.

Method 1: Select a folder from the Shared Folder pane, select the Share menu and then select 
Unshare Folder.
Method 2: Select a folder from the Shared Folder pane, right-click over the selected folder and 
then select Unshare Folder from the pop-up menu.
Method 3: Locate the mouse pointer over a folder in the Shared Folder pane and drag&drop 
the folder into the My Computer pane. If a message appears asking you to confirm the 
cancelation, select Yes.

■

�

�

�

Applying the Current Settings
Perform this when synchronization is necessary due to a new shared folder or cancelling a shared folder. 
The Set Changed State menu applies changes to shared folders to the data saved with the PC share 
programme.
Since applying changes to the internal data is a time-consuming process, this function enables users to 
apply changes to the data only when required.
Until the Set Changed State menu is selected, the changed state of the shared folder is not applied to the 
server.
Changes to the shared folders are not applied to your PC until you select the Set Changed State menu.

Method 1: Select the Share menu and select the Refresh DB sub-menu.
Method 2: Click the Set Changed State icon.

■

�
�

<Method 1> <Method 2> <Method 3>

<Method 1> <Method 2> <Method 3>

<Method 1> <Method 2>
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Option Description
Share Setting the Access Permission

To enable the TV to find your PC, the TV must be set to Set Device Policy in the Access Permission 
Settings window. In addition, the PC server and the TV must be on the same subnet.

Method: Select the Share menu and select Set Device Policy. Rejected items are represented 
in gray. You can change the access permissions by using the Allow Accept / Deny button.  
To delete an item, select the item and select Delete Item.

■

�

Server Server
You can run or stop using your PC as a server.

Run DLNA Digital Media Server when Windows Starts
You can determine whether to start the PC server automatically when Windows starts.

Change server name
You can rename the PC server. Enter a new name and click OK. The new name will appear at the top right 
of the window and will appear on the TV.

■

■

■

Help Version
The programme version information message box appears.
■

Using the DLNA Function
Using the DLNA Menu

DLNA (Digital Living Network Alliance) enables content saved on a DLNA server (usually your PC) connected to your TV or over a 
network to be played. Media Play enables playing content saved on a USB memory device connected to the TV, while DLNA enables 
playing content saved on a DLNA server (your PC) connected to your TV or over the network. The procedures to use the content are 
the same as those for Media Play (USB & DLNA).

If you install the PC share manager programme supplied with the TV onto a PC, you can have the PC perform the role of a DLNA 
server over the network.
For the detailed procedures on using the DLNA menu, refer to pages 43~56.

1	 Press the MEDIA.P button on the remote control to display the DLNA menu.					   
	

2	 Press the ◄ or ► button to select an icon (Photo, Music, Movie, Setup), then press the ENTERE button.
To exit DLNA mode, press the MEDIA.P button on the remote control.
DLNA does not support the following functions.

The Background Music and Background Music Setting functions.
Sorting files by preference in the Photo, Music, and Movie folders.
The Change Group Info function.
The Copy / Delete function.
The Remove Safely function.
The REW/FF (π/µ) key functions while a movie is playing.
Function to watch continuously when playing movie.
Playing Movie Continuously (Resume Play) function.

The Skip function may not work with some container such as asf and mkv.
The Divx DRM, Multi-audio, embedded caption does not supported.
Samsung PC Share manager should be permitted by the firewall programme on your PC.
The Skip (◄/► keys) or Pause function may not work while a movie is playing for the DLNA of other manufacturers, 
depending on the corresponding content information.
The playing time may not be displayed while a movie is playing.

■

■

■
■

�
�
�
�
�
�
�
�

■
■
■
■

■
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Anynet+
Connecting Anynet+ Devices

What is Anynet+?
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s remote.
The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung device has this 
feature, check if there is an Anynet+ logo on it.

To connect to a TV

Connect the HDMI IN (1(DVI), 2, 3 or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

To connect to Home Theatre

1	 Connect the HDMI IN (1(DVI), 2, 3 or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using 
an HDMI cable.

2	 Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on 
the Home Theatre.
When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 
Home Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 
DIGITAL AUDIO OUT (OPTICAL) jack on the DVD player or Cable / Satellite Box (ie Anynet Device 1 or 2) directly to 
the Amplifier or Home Theatre, not the TV.
Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.

■

■

■
■
■
■

Anynet+ Device 1

HDMI 1.3 CableHDMI 1.3 CableHDMI 1.3 Cable
HDMI 1.3 Cable

Anynet+ Device 2 Anynet+ Device 3 Anynet+ Device 4
TV

Anynet+ Device 1

HDMI 1.3 Cable

HDMI 1.3 CableHDMI 1.3 CableHDMI 1.3 Cable

TV

HDMI 1.3 Cable

Optical Cable

Anynet+ Device 2 Anynet+ Device 3 Anynet+ Device 4

Home Theatre
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Setting Up Anynet+
Option Description

Setup Anynet+ (HDMI-CEC) 
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must 
be set to On.
When the Anynet+ (HDMI-CEC) function is disabled, all 
the Anynet+ related operations are deactivated.

Auto Turn Off 
Setting an Anynet+ Device to turn Off automatically when 
the TV is turned Off.

The active source on the TV remote must be set 
to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected 
external devices are also turned off when the 
TV is turned off. If an external device is still 
recording, it may or may not turn off.

■

■

�

�

Switching between Anynet+ 
Devices

1	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-
CEC).

2	 Press the ▲ or ▼ button to select Device List, then press the ENTERE button.
Anynet+ devices connected to the TV are listed. If you cannot find a device 
you want, press the red button to scan for devices.

3	 Press the ▲ or ▼ button to select to a particular device and press the ENTERE 
button. It is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the 
Device List menu appears.
Switching to the selected devices may take up to 2 minutes. You cannot 
cancel the operation during the switching operation.
The time required to scan for devices is determined by the number of 
connected devices.
When the device scan is complete, the number of devices found are not 
displayed.
Although the TV automatically searches the device list when the TV is turned 
on via the power button, devices connected to the TV may not always be 
automatically displayed in the device list. Press the Red button to search for 
the connected device.
If you have selected external input mode by pressing the SOURCE button, 
you cannot use the Anynet+ function. Make sure to switch to an Anynet+ 
device by using the Device List.

■

■

■

■

■

■

■

U Move       E Enter       R Return

Anynet+ (HDMI-CEC)	 : On	                                 ▶

Setup

Auto Turn Off	 : Yes

U Move       E Enter       R Return

View TV

Device List

Recording: DVDR
DVDR MENU
DVDR INFO
Receiver: Off
Setup

Press the TOOLS button to 
display the Tools menu. You 
can also display Anynet+ menu 
by selecting Tools → Anynet+ 
(HDMI-CEC).

■

Media Play (USB & DLNA)

Anynet+ (HDMI-CEC)	

Content Library
Internet@TV 
Home Network Centre

Application

U Move       E Enter       R Return

Anynet+ (HDMI-CEC)	 : On

Setup

Auto Turn Off	 : Yes                               ▶
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Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices 
connected to the TV.

Option Description

View TV Anynet+ mode changes to TV broadcast mode.

Device List Shows the Anynet+ device list.

(device_name) Menu Shows the connected device menus. 
E.g. If a DVD recorder is connected, the disc menu of the 
DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. 
E.g. If a DVD recorder is connected, the play menu of the 
DVD recorder will appear.

Recording: (*recorder) Starts recording immediately using the recorder. 
(This is only available for devices that support the 
recording function.)

Stop Recording: (*recorder) Stops recording.

Receiver Sound is played through the receiver.

TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, 
when the menu of the 
corresponding device is displayed 
on the screen.

Numeric buttons
▲/▼/◄/►
ENTERE buttons
Colour buttons
EXIT button

After switching to the device, 
while playing a file

π(Backward search)
μ(Forward search)
∫(Stop) / ∂(Play)
∑(Pause)

Device with built-in
Tuner

After switching to the device, 
when you are watching a TV 
programme

P > / P < button

Audio Device When Receiver is activated Y / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set 
to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV.  
You can control Anynet+ devices only using the TV remote control.
The TV remote control may not work under certain conditions.  
If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, μ operations may differ depending on the device.

■

■
■

■

■
■

If more than one recording 
device is connected, they are 
displayed as (*recorder) and 
if only one recording device is 
connected, it will be represented 
as (*device_name).

■
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Recording
You can make a recording of a TV programme using a Samsung recorder.

1	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-
CEC).	

2	 Press the ▲ or ▼ button to select Recording Immediately and press the 
ENTERE button. Recording begins.

When there is more than one recording device. 
When multiple recording devices are connected, the recording devices are 
listed. Press the ▲ or ▼ button to select a recording device and press the 
ENTERE button. Recording begins.
When the recording device is not displayed select Device List and press the 
Red button to search devices

3	 Press the EXIT button to exit.
You can record the source streams by selecting Recording: (device_name).
Pressing the ∏ button will record whatever you are currently watching. If you 
are watching video from another device, the video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the 
recording device. To properly connect an antenna to a recording device, refer 
to the recording device’s users manual.

Listening through a Receiver 
(Home Theatre)
You can listen to sound through a receiver instead of the TV speaker.

1	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-
CEC).

2	 Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select 
On or Off.

3	 Press the EXIT button to exit.
If your receiver supports audio only, it may not appear in the device list.
The receiver will work when you have properly connected the optical in jack of 
the receiver to the DIGITAL AUDIO OUT (OPTICAL) jack of the TV.
When the receiver (home theatre) is set to On, you can hear sound output 
from the TV’s Optical jack. When the TV is displaying a DTV(air) signal, the 
TV will send out 5.1 channel sound to the Home theatre receiver. When the 
source is a digital component such as a DVD and is connected to the TV via 
HDMI, only 2 channel sound will be heard from the Home Theatre receiver.
If there is a power interruption to the TV when the Receiver is set to On (by 
disconnecting the power cord or a power failure), the Speaker Select may be 
set to External Speaker when you turn the TV on again.

■

■

■
■

■

■
■

■

■

View TV
Device List

Recording: DVDR

DVDR MENU
DVDR INFO
Receiver: Off
Setup

U Move       E Enter       R Return

View TV
Device List
Recording: DVDR
DVDR MENU
DVDR INFO

Receiver: Off

Setup

U Move       E Enter       R Return
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Troubleshooting for Anynet+
Problem Possible Solution

Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ devices 
only.
Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating Media Play,  
Plug & Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices 
again or turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●

●
●
●
●
●
●
●

●

●

I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ 
(HDMI-CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS button 
to show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than Anynet+ 
devices.
Press P >/<, PRE-CH, and FAV.CH to change the TV mode. (Note that the channel 
button operates only when a tuner-embedded Anynet+ device is not connected.) 

●
●

●

The message ‘Connecting to 
Anynet+ device...’ appears on 
the screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a view 
mode.
Use the remote control when the Anynet+ setting or switching to view mode is complete.

●

●

The Anynet+ device does not 
play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is not 
displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables may 
not support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or power 
cord or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV programme cannot be 
recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not output 
through the receiver.

Connect the optical cable between TV and the receiver.●
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Content Library
Using the Content Library
The Content Library allows you to enjoy various content on your TV.
You can use the default content stored in the TV memory or you can enjoy new content using a USB device.

Using the Content Library Menu

1	 Press the MENU button. Press the ▲ or ▼ button to select Application, then 
press the ENTERE button.

2	 Press the ▲ or ▼ button to select Content Library, then press the ENTERE 
button.

The Content Library main menu is displayed.

3	 Press the ◄ or ► button to select an icon (Gallery, Cooking, Game, Children, 
Wellness, Others, Content Management), then press the ENTERE button.

Using the Remote Control Button in Content Library Menu

Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE Select the currently selected item.

RETURN Return to the previous menu.

EXIT Stop the current function and return to the Content Library main 
menu.

< P > /
FAV.CH / CH LIST Stop Content Library mode and Returns to TV mode.

Colour button Keys that provide functions are described on the corresponding page.

- VOL + / MUTE You can control the volume of the played content.

CONTENTS LIBRARY CONTAINS TEXT, GRAPHICS, IMAGES, MULTIMEDIA, AND 
OTHER MATERIALS FOR INFORMATIONAL AND PROMOTIONAL PURPOSES ONLY. 
MATERIALS IN CONTENTS LIBRARY HAS BEEN MODIFIED AND KEEPS BEING 
REVISED AND UPDATED. THE MATERIALS IN THE CONTENTS LIBRARY MAY NOT BE 
SUITABLE FOR ALL AUDIENCES.
INFORMATION IN THE CONTENTS LIBRARY IS PROVIDED ‘AS IS.’ ALTHOUGH THE 
INFORMATION PROVIDED TO YOU IN THE CONTENTS LIBRARY IS OBTAINED OR 
COMPLIED FROM SOURCES WE BELIEVE TO BE RELIABLE, SAMSUNG CANNOT 
AND DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS OR 
COMPLETENESS
OF ANY INFORMATION OR DATA MADE AVAILABLE TO YOU FOR ANY PARTICULAR 
PURPOSE. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL 
SAMSUNG BE HELD LIABLE, WHETHER IN CONTRACT OR TORT, FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY 
FEES, EXPENSES, OR ANY OTHER DAMAGES WHATSOEVER ARISING OUT OF, OR 
IN CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR THE USE OF, THE 
CONTENTS LIBRARY, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

■

Media Play (USB & DLNA)
Anynet+ (HDMI-CEC)	

Content Library

Internet@TV 
Home Network Centre

Application

R Return         e Exit

Gallery

Gallery Cooking Game Children Wellness

BN68-01985L_Eng-1.indd   67 2009-03-27   �� 6:43:15



68

English
Content Library

Using the Contents
You can use enjoy content stored in the TV memory. 

To return to Content Library main menu, press the EXIT button.

Option Description
Gallery This function plays a Slideshow with high resolution 

images and background music and produces various 
atmospheres. Using the Gallery function of the TV, you 
can change your home atmosphere.

The copyrights of the Gallery contents and all issues 
related to them are reserved by TimeSpace, Inc.
Press the ENTERE button to pause the Slideshow, 
and also press the ENTERE button to resume the 
Slideshow.
Press the INFO button to display information on the 
selected photo. (This is not displayed if the photo has 
no information.)

■

■

■

Cooking You can view various recipes and then easily follow them 
step by step. Enjoy these contents which will give you 
great ideas for meals.

The recipes introduced in the Cooking contents on 
the Samsung TV are based on recipes published by 
Anness Publishing.
The copyrights of the Cooking contents and all issues 
related to them are reserved by Practical Pictures.

■

■

Game This category provides entertainment games for the 
whole family.

For the buttons used in the games, refer to the 
directions on the screen.
Colour Buttons for Games

Red: Press to move to the game home screen.
Green: Press to pause the game.
Yellow: Option Key.
Blue: Press to exit the game

■

■
�
�
�
�

Children This is educational and interactive content that children 
can watch repeatedly. 

The copyrights of the Children contents and issues 
related to them reserved by UpToTen.

■

Wellness This is beneficial health management content that 
provides stretching and massage exercises that can be 
enjoyed by the whole family.

The Basic Stretches contents are automatically 
played so that you can easily follow the movements on 
the screen. To move to the previous or next operation, 
press the ◄ or ► button to view the required step. The 
selected item is displayed on the screen.

■

■

R Return         e Exit

Gallery

Gallery Cooking Game Children Wellness
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Using the Content Management
You can select multiple content items by selecting content items repeatedly and pressing the Yellow button.

Option Description
Content Management You can select multiple content items by selecting 

content items repeatedly and pressing the Yellow 
button.

■

My Contents You can check the content saved in the TV memory for 
each subitem of the Content Library.

Select a content item and press the ENTERE button. 
You can play or delete the selected content item.

■

USB You can check the content saved on the USB device for 
each subitem of the Content Library.

Select a content item and press the ENTERE button. 
You can play the selected content item.

Content Library only supports USB Mass 
Storage Class devices (MSC). MSC is a Mass 
Storage Class Bulk-Only Transport device. 
Examples of MSC are Thumb drives and Flash 
Card Readers.
Playing a game using an external USB memory 
device will allow you to save your game 
(depending on the game). Take care as removing 
the USB memory device while saving data to the 
USB memory device may cause the data to be 
lost.
Downloading New Contents 
New content other than the built-in content will be 
provided via the Samsung.com website free of 
charge. When you download the paid contents, you 
need UDN number to download contents. Check 
the UDN number before downloading a new content 
item.

Downloading Content
1.	Visit the www.samsung.com website.
2.	Select a content item in the Contents Download 

page.
3.	Download the contents onto the USB memory 

device.
4.	Go to Content Library main menu by pressing 

CONTENT button or choosing Content Library 
(Menu → Application → Content Library).

5.	Plug the USB memory into USB port on the side of 
the TV.

6.	You can see the content sub item which you 
downloaded.

7.	Select a content item and press the enter button.
8.	You can play the selected content item.

■

�

�

�

■

Setup Screen Saver Run Time: Select to set the waiting 
time before the screen saver appears.
Save UDN: Saves the UDN number to a USB device.

■

■

An NTFS format USB storage 
device does not support saving 
UDN.  
We recommend using a FAT 
format USB storage device.

■

Content 
Management

R Return         e Exit

Game Children Wellness Other Content 
Management

R Return         e Exit

1/1

� �

My Contents

USB

Setup

TV Memory      
17.16GB/189.00MB Available

Gallery

Cooking

Game

Children

Wellness

Others

Content Management > My Contents
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1	 Press the MENU button. Press the ▲ or ▼ button to select Application, then 
press the ENTERE button.

2	 Press the ▲ or ▼ button to select Internet@TV, then press the ENTERE 
button.

Internet@TV starts.

3	 The General Disclaimer is displayed on the screen. Select I accept or I do not 
accept.

For more information on the General Disclaimer, refer to page 41.

4	 The ‘welcome screen’ is the starting point of the Internet@TV guided setup.
If you select Exit Setup, this step is resumed when you press the 
INTERNET@ button.
Select Let’s get started!

5	 Choosing your location allows TV Widgets to use localized content.
Select your country from the list provided.

6	 Accepting the Yahoo!® TV Widget Engine Privacy Policy is required to use 
Internet@TV.

Select OK, I Accept.

7	 Accepting the Yahoo!® TV Widget System Terms of Service is required to use 
Internet@TV. 

Select OK, I Accept.

8	 Enter your name to setup your profile. Each profile has its own list of widgets. 
You can create a profile for each person who uses Internet@TV.

Enter your name and select Save this name.
For more information, refer to page 73.

■

■

■

■

■

■

■

■
■

Internet@TV
If you have some problems while using a widget service, please contact to content provider. In the widget, press the Green button and 
get information of contact or refer to help website for widget provider information. 

Getting Started with Internet@TV
Internet@TV provides an integrated Internet and television experience powered by the Yahoo!® Widget Engine.  
You can monitor financial stocks, share photos with friends and family, and track news and weather all through the Internet@TV service 
on your television.

If Network condition is unstable, this function may not work. Then, TV would be turned off automatically. Otherwise turn off the TV 
using power button.
You may experience slow operation or hesitation when using this function due to network conditions.

When running Internet@TV for the first time, the basic settings proceed automatically.
The first step is to set up your network. For more information on how to configure your network, refer to page 37.
After your network is operational, the Internet@TV software guides you through a step-by-step setup wizard.

What is a Widget?
A TV Widget is a small web application that allows you to easily access your favourite site using the remote control. You can enjoy
various types of information, such as the latest news, weather information, and stock information, etc. on your TV along with your
friends or family members.
Some widgets may not be supported depending on the regulations of the corresponding country.

Some widgets will only support limited services depending on the regulations of the corresponding country.
The colour buttons may work differently depending on the widget.
The operation may not be smooth depending on the network condition.
The Snippet is a symbol of Widget.

What is a Snippet?
A snippet shows a part of the Widget contents such as weather and stock information that the user wants to view.

The snippets are automatically updated in real time.
It may take a few seconds to load the snippet.

■

■

■
■

■
■
■
■

■
■

Press the Internet@ button 
on the remote control to display 
the Internet@TV menu.

■

Welcome to Yahoo!® TV Widgets!

Yahoo! TV Widgets bring the best of the internet to 
your TV! You can get updated weather conditions or 
sports scores, get updated information on stocks, or 
even view full-screen photos and video!

We just need to get a few things set up, and you’ll be 
on your way!

Let’s get started! Exit setup

1

What’s your name?

Each person in the house who 
uses the TV can have their own 
personalized set of widgets.
We’ll keep track of these 
individual widget profiles by the 
name you enter, Enter the name 
YOU want to use now.

Save this name

5

Skip this step Exit setup
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9	 Internet@TV tests the network connection.
If the test fails, configure your network again.
For more information, refer to page 37

10	The guided setup is complete. A tutorial on how to use Internet@TV is next.
Select Continue to view the tutorial.
Select Exit setup to start using Internet@TV now.
To run the tutorial again, select Profile Widget → System Setting → Repeat Tutorial.

11	 Press the INTERNET@ button on the remote control to display the Internet@TV user interface.display

Screen Display

Dock mode
1	 A welcome banner is shown with your profile name in the top right corner.

This banner disappears after a short delay.
2	 The banner highlights two remote control shortcuts.

If you press the blue button (Viewport) on your remote control, the 
display is toggled between ‘Viewport mode’ and ‘Overlay mode’. In 
Viewport mode, the TV or video plays in a scaled-down area with 
graphics outside. In overlay mode, the graphics are displayed on top 
of the TV or video.
If you press the yellow button (Edit Snippet) on your remote control, 
a help window is displayed and the snippet with focus can be edited

3	 Press the INTERNET@ button on the remote control to begin.
The horizontal list at the bottom of your TV screen is called ‘the dock’.
The items in the list are called ‘snippets’.
A snippet is a shortcut which launches a TV Widget.
A TV Widget is an Internet application designed to run on your TV.
Move between snippets by pressing the ◄ or ► buttons on the remote 
control.
Focus is located in the left most region (highlighted in blue).
The dock slides snippets under that focal point.
Launch a TV Widget by pressing the ENTERE button on the remote 
control when its snippet is in focus.
When you add snippets, they form a stack which you can navigate by 
pressing the ▲ or ▼ buttons.
Two special TV Widgets appear in the dock: the Profile Widget and the 
Gallery Widget. These cannot be deleted.
The dock will slide off screen after a timeout period. 

Sidebar mode
1	 Focus on a snippet and press the ENTERE button to launch the TV 

Widget sidebar. The TV Widget logo and Home  are at the top of the 
sidebar.

2	 Current menu is displayed under the TV Widget logo.
To return to a previous screen, select it and press the ENTERE 
button.
You can also press the RETURN button on the remote control.

3	 Current selection is always highlighted in blue. The highlighted button has 
focus and is activated when you press the ENTERE button.

4	 When there is a lot of data, a page control is used.
Current page and total pages are displayed.
Move between pages by pressing ◄ or ► buttons.

5	 The bottom toolbar includes colour buttons that correspond to the red, green, 
yellow and blue buttons on the remote control.

Red button: Close the widget.
Green button: Change the widget’s setting.
Yellow button: Manage your snippets.
Blue button: Size video to fit, or make it full screen.

■
■

■
■
■

■

■

■

■
■
■
■
■

■
■
■

■

■

■

■

■

■
■

■
■
■
■

3

WEATHER Widget Gallery FINANCESigned in as
John

Hello John!
5:15 AM Mon January 19th
 Viewport     Edit Snippet

1

2

3

My Stocks
To remove a stocks symbol, please 
select it from the list below. 

Display Format	 Value
About Yahoo! Finance...

FINANCE

  PAGE 1 OF 2  

^DJI
^IXIC
YHOO
AAPL
INTC
AMZN

Add New Symbol...
Import Symbols From Yahoo!...

1
2

3
4

5
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Editing Snippets in the Dock

1	 Edit a snippet by focusing on it in the dock and pressing the yellow button.

2	 The snippet moves to the Second position and its tile slides up to show the following help text:
Delete (Red button): Remove this TV Widget.  
Deleted widgets can be re-installed using the Widget Gallery.
Move (Blue button): Re-order the snippet. Press the ◄ or ► button to scroll. Press the yellow button to drop into the 
new position.
Done (Yellow button): Exit the Edit Snippet menu.

■

■

■

All content and services accessible through this device belong to third parties and are protected by copyright, patent, trademark 
and/or other intellectual property laws. Such content and services are provided solely for your personal noncommercial use. You may 
not use any content or services in a manner that has not been authorized by the content owner or service provider. Without limiting 
the foregoing, unless expressly authorized by the applicable content owner or service provider, you may not modify, copy, republish, 
upload, post, transmit, translate, sell, create derivative works, exploit, or distribute in any manner or medium any content or services 
displayed through this device.
YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE DEVICE IS AT YOUR SOLE RISK AND THAT THE ENTIRE 
RISK AS TO SATISFACTORY QUALITY, PERFORMANCE AND ACCURACY IS WITH YOU. THE DEVICE AND ALL THIRD 
PARTY CONTENT AND SERVICES ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED. SAMSUNG EXPRESSLY DISCLAIMS ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE DEVICE AND 
ANY CONTENT AND SERVICES, EITHER EXPRESS OR, IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTIES OF 
MERCHANTABILITY, OF SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET 
ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. SAMSUNG DOES NOT GUARANTEE THE ACCURACY, 
VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH 
THIS DEVICE AND DOES NOT WARRANT THAT THE DEVICE, CONTENT OR SERVICES WILL MEET YOUR REQUIREMENTS, 
OR THAT OPERATION OF THE DEVICE OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE. UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN CONTRACT OR TORT, FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER 
DAMAGES ARISING OUT OF, OR IN CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE 
OF THE DEVICE, OR ANY CONTENT OR SERVICE ACCESSED BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
Third party services may be changed, suspended, removed, terminated or interrupted, or access may be disabled at any time, 
without notice, and Samsung makes no representation or warranty that any content or service will remain available for any period 
of time. Content and services are transmitted by third parties by means of networks and transmission facilities over which Samsung 
has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any responsibility or liability for any 
change, interruption, disabling, removal of or suspension of any content or service made available through this device. Samsung 
may impose limits on the use of or access to certain services or content, in any case and without notice or liability.
Samsung is neither responsible nor liable for customer service related to the content and services. Any question or request for 
service relating to the content or services should be made directly to the respective content and service providers.
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Using the Profile Widget
The Profile Widget configures your user profile.
You can set up multiple profiles, and each profile maintains its own list of widgets.
The Switch Profile menu allows you to switch to a different user profile.

At least two profiles must be registered. If you want to add a profile, refer to page 73.

The Profile Settings menu allows you to customize and protect your profile.
User profiles can be customized with a unique Name and an Avatar (a picture used to
represent your profile).
Your profile’s Name and Avatar are displayed in the profile snippet in the dock.
Profiles can be protected by Create Profile PIN.
When setting the PIN for the first time, you can set a Security Question.

The Profile Settings menu can limit access to widgets.
If you forget your Profile PIN you can answer a Security Question that is associated with 
your profile.
A profile that has the Limit Profile indicator turned on will not allow new widgets to be installed.
The Owner PIN must be set to use this function. To set the Owner PIN, refer to page 73.

The System Settings menu allows you to:
Change your Location and set your Zip Code (US only) to tailor the content to your region.
Repeat the Tutorial that was shown during guided setup.
Restore Factory Settings to delete all widget configurations and information.

In the Administrative Controls menu you can:
Set the Screen Saver timeout to avoid screen burn in.
Create Owner PIN and set a Security Question to control other profiles.
Create a new Profile which can be configured with a different set of widgets.
Delete an existing profile.

■

■
■
■
■
■

■

■
■

■
■
■

■
■
■
■

System Settings
Location
Repeat Tutorial
Restore Factory Settings

PROFILE

Signed in as

John

Switch Profile

Sign out of Yahoo!

Administrative Controls

System Settings

Profile Settings

PROFILE

Profile Settings
John
Name

Avatar

Create Profile PIN
Security Question

Security Answer

Limit Profile			   Off

Done
Cancel

PROFILE

Administrative Controls
Screen Saver	 240 Minutes
Create Owner PIN
Create Profile
Remove Profile

PROFILE
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From the Profile Widget you can Sign in to Yahoo!® using your Yahoo! ID.
If you have a Yahoo! ID, you can access your personalized content using the Yahoo!®! TV 
Widgets.
All Yahoo!®! TV Widgets that are installed are automatically signed-in with your profile’s 
Yahoo! ID.
If you have no Yahoo! account, visit www.yahoo.com and create an account.
You may fail to log in with an ID created on the Yahoo website in a country that does not 
support Internet@TV.

About Profile widget
Press the Green button.
You can view a brief description of the Profile Widget, Copyright Policy, Terms of Service, 
and Privacy Policy.

Using the Yahoo!® Widget 
Gallery
Use the Yahoo!® Widget Gallery to add more widgets to your TV.
View available TV Widgets in the following categories:

Latest Widgets: Displays recently updated widgets.
Yahoo!® Widgets: Displays widgets provided by Yahoo!®.
Samsung Widgets: Displays widgets provided by Samsung.
Categories: Displays all widgets by category.
To install a widget, navigate to the detail screen and select Add Widget to My Profile and 
press the ENTERE button. The widget is installed and becomes available in the dock.

Widget Gallery Settings
Press the Green button.

About Yahoo! Widget Gallery...
You can view brief information for the Widget Gallery, Copyright Policy, Terms of Service, and
Privacy Policy.

In the Developer Settings menu You can make your own widget.
For more information on creating your own widget, visit our developer site at http://connectedtv.
yahoo.com/

■

■

■
■

■
■

■
■
■
■
■

Signed in as

John

Switch Profile

Sign out of Yahoo!

Administrative Controls

System Settings

Profile Settings

PROFILE

Sign in to access your Yahoo! data for 
the Yahoo! Widgets in this profile. Use 
the Profile Widget to sign out.

Yahoo! ID

a b c d e f g h i

j k l m n o p q r

s t u v w x y z 0

1 2 3 4 5 6 7 8 9

Next

Cancel

space.@#  ãéì

Yahoo! News
by Yahoo!

Samsung Widgets

Widget Gallery

    

Latest Widgets

Yahoo! Widgets

V 0.9.0

Categories

NEWS

  PAGE 1 OF 2  

NEWS HEADLINES

Top Stories
Business
Potics
Sports
Technology
More Categories

Settings

About Yahoo! Widget Gallery...
Developer Settings

WIDGET GALLERY
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Using the Yahoo!® Weather 
Widget
The Yahoo!® Weather Widget provides updates on your local and favorite weather locations. 
This content dynamically changes with weather conditions.

Press the green button on the remote control to display the Yahoo!® Weather Widget Settings 
menu.
From the Settings menu you can add or remove a city for which you want to view weather 
information.

From the Settings menu:
Add New City by entering the name of the city. Once the search results are displayed, select 
the city you want and press the ENTERE button.
Delete City by selecting the city you want to delete from the city list. Press the ENTERE 
button and confirm the deletion.
Changing the Temperature Indication Mode 
You can change the temperature indication mode to Imperial or Metric. For example, 
Imperial will show temperatures in Fahrenheit and Metric in Celsius.

Create a Snippet for a Favorite City
Select the city from the Yahoo!® Weather Widget’s home page and view the detailed weather 
information.
Press the Yellow button.
Select the Add Snippet menu and press ENTERE to add the city as a snippet.

Delete a Snippet for a City
Launch the snippet.
Press the Yellow button.
Select the Delete Snippet menu and press ENTERE to remove the snippet.

Using the Yahoo!® News Widget
The Yahoo!® News Widget provides the latest headline news for business, entertainment, 
politics, sports, top stories, and many other categories.

Select a category, select a headline within the category, and view a dynamically updated news
summary.

■

■

■

■

■

■

■
■

■
■
■

51°

San Francisco, CA

Sunnyvale, CA

Paris, France

London, England

New York, NY

Sunnyvale
Cloudy

WEATHER

World

NEWS

    
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Using the Yahoo!® Flickr 
Widget
The Flickr Widget can provide you access to your favorite photos from friends and family 
while
watching TV. Share your photos with your family on your big screen TV through a 
slideshow.

Personalize the Flickr Widget by logging in with your Yahoo! ID.
For detailed procedures on log in, refer to page 73.
For more information on Flickr, visit http://www.flickr.com.
Your Photos shows photos you have registered with Flickr website.

To view Flickr photos in a slideshow:
Select a thumbnail of a photo and press the ENTERE button to view the photo’s 
details.
Select Start Slideshow and press the ENTERE button.

To control the slideshow display:
Press the ENTERE button during a slideshow.
The thumbnails of photos are displayed on the bottom of the screen.

When the slideshow control is displayed, you can Pause, Play and Stop the 
slideshow.
If you select the menu and press ENTERE, you can view information for the 
selected photo.

The Your Sets menu allows you to view photos you have classified in Flickr.
The Explore menu allows you to explore photos featured by the Flickr website.  
You can view the photos updated daily.
The Mark as Favorite or Remove From Favorite menu moves photos to your Favorite 
Photos set or removes photos from it.
The Favorite Photos menu allows you to see the photos you have classified as 
favorites.
The Your Contacts menu allows you to see updates from family and friends.

The Your Groups menu allows you to select your favorite groups from the 
Flickr website to share and enjoy photos with the Flickr community of users.
To configure the Yahoo!® Flickr Widget Settings press the Green button on the remote 
control.

The Time Per Slide menu controls the speed of the slideshow.
The Repeat menu will restart the slideshow at the beginning after the last photo is 
shown.

■
■
■
■

■

■

■
■

�

�

■
■

■

■

■

■
■

Your Photos
Your Sets

Explore

Favorite Photos
Your Contacts

Your Groups
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Using the Yahoo!® Finance 
Widget
View stock information and the latest stock news with the Yahoo!® Finance Widget.
Press the green button to set up your stocks.
Use the Add New Symbol menu to enter the name of a new stock.

Select the stock you want to add from the search results and select the Add Symbol menu and 
press the ENTERE button.

The selected stock is added to the My Stocks list.
Use the Import Symbols From Yahoo!® menu to retrieve your Yahoo!® Finance portfolio.

The Merge Symbols menu merges the symbols in the Yahoo!® Finance Widget with 
the symbols from your portfolio.
The Replace Symbols menu deletes the symbols in the Yahoo!® Finance Widget and 
replaces them with the symbols from your portfolio.

Use the Display Format menu to change the stock-price fluctuation transition to Value or 
Percentage.
Create a snippet for a favorite stock.

Select the stock symbol from the Yahoo!® Finance Widget’s home page and view the 
detailed finance information.
Press the Yellow button.
Select the Add Snippet menu and press ENTERE to add the stock as a snippet.

Delete a snippet
Launch the snippet from the dock
Press the yellow button.
Select the Delete Snippet menu and press ENTERE to remove the snippet.

Troubleshooting for Internet@
TV

Problem Possible Solution
Some widget services do not work. Check with that service provider.

In the widget, press the green button and get contact information or refer to help 
website for widget service provider information.
Refer to Help website page.

Some widget contents only have 
English. How can I change the 
language?

Widget content language may be different from widget user interface language.  
It depends on service provider.

After factory reset, Yahoo Widget 
service doesn’t work and warning 
message is displayed.

After factory reset, turn off and on your TV. Then restart Internet@TV.

At the Flickr widget, I logged in my 
account. But, I can’t view my picture.

Visit Yahoo Web site, and activate your Flickr account at your Yahoo! ID.

At the Profile widget, I did change 
location, but the previous setting still 
remains.

Turn off and on your TV. Then restart Internet@TV.
Now, you can enjoy widget services supported in changed location.

■

�
■

�

�

■

■
�

�
�

■
�
�
�

My Stocks
To remove a stocks symbol, plase 
select it from the list below. 

Display Format	 Value
About Yahoo! Finance...

FINANCE

  PAGE 1 OF 2  

^DJI

^IXIC

YHOO
AAPL

INTC

AMZN

Add New Symbol...
Import Symbols From Yahoo!...
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Help Website
Country Website

Austria www.samsung.com → Produkte → Fernseher → medi@2.0 → Internet@TV

Belgium
www.samsung.com → Producten → televisies → medi@2.0 → Internet@TV

www.samsung.com → Produits → téléviseurs → medi@2.0 → Internet@TV

Czech www.samsung.com → Produkty → televizory → medi@2.0 → Internet@TV

Denmark www.samsung.com → Produkter → stue & soveværelse → medi@2.0 → Internet@TV

Finland www.samsung.com → Tuotteet → kodinelektroniikka → medi@2.0 → Internet@TV

France www.samsung.com → Produits → télévisions → medi@2.0 → Internet@TV

Germany www.samsung.com → Privatkunden → Fernseher → medi@2.0 → Internet@TV

Greece www.samsung.com → Προϊόντα → τηλεοράσεις → medi@2.0 → Internet@TV

Hungary www.samsung.com → Termékek → televíziók → medi@2.0 → Internet@TV

Ireland www.samsung.com → Products → Television → medi@2.0 → Internet@TV

Italy www.samsung.com → Prodotti → TV → medi@2.0 → Internet@TV

Netherlands www.samsung.com → Producten → televisies → medi@2.0 → Internet@TV

Norway www.samsung.com → Produkter → hverdagsrom & soverom → medi@2.0 → Internet@TV

Poland www.samsung.com → Produkty → telewizory → medi@2.0 → Internet@TV

Portugal www.samsung.com → Produtos para Consumidores → televisores → medi@2.0 → Internet@TV

Slovakia www.samsung.com → Produkty → televízory → medi@2.0 → Internet@TV

Spain www.samsung.com → Productos → televisores → medi@2.0 → Internet@TV

Sweden www.samsung.com → Produkter → vardagsrum & sovrum → medi@2.0 → Internet@TV

Switzerland
www.samsung.com → Produits → télévisions → medi@2.0 → Internet@TV

www.samsung.com → Produkte → Fernseher → medi@2.0 → Internet@TV

United Kingdom www.samsung.com → Products → Television → medi@2.0 → Internet@TV

Turkey www.samsung.com → Tüketici Ürünleri → televizyon → medi@2.0 → Internet@TV

Estonia www.samsung.com → Klientidele → Televiisorid → medi@2.0 → Internet@TV

Latvia www.samsung.com → Klientiem → Televizori → medi@2.0 → Internet@TV

Lithuania www.samsung.com → Namams → Televizoriai → medi@2.0 → Internet@TV

Russia www.samsung.com → Продукты → Телевизоры → medi@2.0 → Internet@TV

Ukraine www.samsung.com → Потребительские продукты → телевизоры → medi@2.0 → Internet@TV

Approaching step may be changed later on.
It can be different links for special countries.

■
■

BN68-01985L_Eng-1.indd   78 2009-03-27   �� 6:43:18



79

English
Hom

e Netw
ork

Home Network Centre
About the Home Network Centre
The Home Network Centre connects the TV and mobile phones through a network. You can view call arrivals, text message
contents, and schedules set on the mobile phone on the TV using the Home Network Centre. In addition, you can play the media
contents saved on the mobile phones such as videos, photos and music by controlling them onto the TV via the network.

If the device supports DLNA DMC (Digital Media Controller) function, Home Network Centre function is available.
The Samsung SCH-i900 mobile phone supports the Home Network Centre. Other models will be added in the future. 
The mobile device may need additional software installation. For details, refer to each user’s guide.

Connecting to the Home Network Centre
For more information about the network settings, refer to page 37.

Connecting to a Wi-Fi Ad-hoc Network

1	 Connect the ‘Samsung Wireless LAN Adapter’ to the USB1(HDD) or USB2 port of the TV.				  

2	 For more information on how to configure Ad-hoc network, refer to page 37.
For information on configuring the mobile phone’s network settings, refer to the mobile phone manual.

3	 Set up the IP address, SSID and password for the mobile phone in the Ad-hoc Settings of the mobile phone using the Network 
Name (SSID) and Security Key (password) displayed on the TV.

Connecting through a Wire / Wireless IP Sharer

Connect the LAN port of the TV and the Wire/Wireless IP sharer using the LAN cable or connect the USB1(HDD) or USB2 port of the 
TV and the ‘Samsung Wireless LAN Adapter’

For the procedures to set up the wire/wireless sharer and the mobile phone, refer to the manual of the corresponding device.

■
■

■

■

Mobile phone
TV Rear Panel

Samsung Wireless or 
LAN Adapter

or

Mobile phone

Wire/Wireless IP sharer

LAN Cable

or

Mobile phone

Wire/Wireless IP sharer

LAN Cable

Samsung 
Wireless LAN 
Adapter

TV Rear Panel
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Setting Up the Home Network Centre

Option Description

Message Shows a list of mobile phones which have been set up 
with this TV to use the message function (the call arrivals, 
text message contents and schedules set on the mobile 
phone).

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the name from the list. 
If the deleted mobile device turns on or tries to 
connect to the TV, it may be shown on the list.

■

■

■

�

Media Shows a list of mobile phones which is available to 
control media contents (videos, photos, music) from the 
phone.

Besides mobile phone, other mobile devices that 
support DLNA DMC are available

Allowed
Allows the mobile phone.

Denied
Blocks the mobile phone.

Delete
Deletes the mobile phone from the list.

This function just deletes the corresponding 
name on the list. If the deleted mobile device 
turns on or tries to connect to the TV, it may be 
shown on the list.

�

■

■

■

�

Setup Message
You can determine whether to use the message function 
(the call arrivals, text message contents, and schedules 
set on the mobile phone).

Media 
You can select whether to use the media function that 
plays the contents (videos, photos, music) from the 
mobile phone.

TV name
You can set the TV name so as to find it easily on the 
mobile device.

If you selects User Input, you can type the TV 
name by OSK(On Screen Keyboard). You can 
set a name for your TV to be used in the Home 
Network. 

■

■

■

�

Message	 : On

Media	 : On

TV name	 : TV

Home Network Centre 

Message

Media

Setup

 R Return     e Exit

111-1234-5671 	 : Allowed

111-1234-5672	 : Allowed

111-1234-5673 	 : Denied

111-1234-5674 	 : Denied

Home Network Centre 

Message

Media

Setup

 R Return     e Exit

111-1234-5671 	 : Allowed

111-1234-5672	 : Allowed

111-1234-5673 	 : Denied

111-1234-5674 	 : Denied

Home Network Centre 

Message

Media

Setup

 R Return     e Exit
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Using the Message Function
Using this function, you can view the call arrivals, text message contents and schedules
set on the mobile phone through the alarm window while watching TV.

To disable this Message alarm window, set Message to Off in Setup of the Home Network 
Centre.
The alarm window appears for 20 seconds. If no key is pressed or if Cancel is selected, it 
appears up to three times at 5 minute intervals.
If OK is selected, or if OK is not selected while the message is displayed three times, the 
message will be deleted. The message is not deleted from the mobile phone.
The simple alarm window can be displayed, while using some applications such as Media 
Play, Content Library, etc. In this case, to view the contents of the message, switch to TV 
viewing mode.
When the message of an unknown mobile phone is displayed, select the mobile phone in the 
Message item of the Home Network Centre and select Denied to block the phone.

Message View
If a new text message (SMS) arrives while you are watching TV, the alarm window
appears. If you click the OK button, the contents of the message are displayed.

If you select the OK button, the contents of the message are displayed.
If you select the Cancel button, the alarm window appears up to three times at 5 minute 
intervals.

You can configure the viewing settings for the text message (SMS) contents on the 
mobile phone. For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.

Call Arrival Alarm
If a call arrives while you are watching TV, the alarm window appears.

If you select the OK button, the call arrival alarm is confirmed and the alarm window is closed.
If you select the Cancel button, the alarm window appears up to three times at 5 minute 
intervals.

Schedule Alarm
While you are watching TV, the alarm window appears to display the registered
schedule.

If you select the OK button, you can view the contents of the schedule registered on the 
mobile phone.
If you select the Cancel button, the alarm window appears up to three times at 5 minute 
intervals.

You can configure the viewing settings for the schedule contents on the mobile phone. 
For the procedures, refer to the mobile phone manual.
Some special characters may be displayed as blank or broken characters.
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Using the Media Function
An alarm window appears informing the user that the media contents (videos, photos, music) 
sent from the mobile phone will be displayed on the TV.
The contents are played automatically 3 seconds after the alarm window appears.
If you press the RETURN or EXIT button when the alarm window appears, the Media 
Contents are not played.

To turn off the media contents transmission from the mobile phone, set Media to Off in 
Setup of the Home Network Centre.
The contents may not be played on the TV depending on their resolution and format.

Media Play Control Buttons

Button Operations

◄/► Move the cursor and select an item.
While playing a movie file: Skip forwards or backwards through the movie file.

ENTERE
Pressing the ENTERE button during play pauses the play.
Pressing the ENTERE button during pause resumes the play.

RETURN Return to the previous menu.

TOOLS Run various functions from the Photo, Music and Movie menus.

INFO Show file information.

EXIT Stop Media Play mode and Returns to TV mode.

The ENTERE and ◄/► buttons may not work depending on the type of media content.
Using the mobile device, you can control playing media. For details, refer to each user’s guide. 

■

■

■
■

Media will be played from “111-123 4-5671”
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Other Information
Teletext Feature
Most television stations provide written information services via Teletext. The index page of the Teletext service gives you information 
on how to use the service. In addition, you can select various options to suit your requirements by using the remote control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or some 
pages may not be displayed.

■
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1	 : (exit)
	 Exit from the Teletext display.
2	 6 (index)
	 Used to display the index (contents) page at any time while you are viewing Teletext.
3	 5 (reveal)
	 Used to display the hidden text (answers to quiz games, for example). To display normal 

screen, press it again.
4	 4 (size)
	 Press to display the double-size letters in the upper half of the screen. For lower half of the 

screen, press it again. To display normal screen, press it once again.
5	 Colour buttons (red/green/yellow/blue)
	 If the FASTEXT system is used by a broadcasting company, the different topics covered 

on a Teletext page are colour-coded and can be selected by pressing the coloured 
buttons. Press one of them corresponding to the required. The page is displayed 
with other coloured information that can be selected in the same way. To display the 
previous or next page, press the corresponding coloured button.

6	 / (Teletext on/mix)
	 Press to activate Teletext mode after selecting the channel providing the Teletext service. 

Press it twice to overlap the Teletext with the current broadcasting screen.
7	 8 (store)
	 Used to store the Teletext pages.
8	 1 (sub-page)
	 Used to display the available sub-page.
9	 9 (hold)
	 Used to hold the display on a given page if the selected page is linked with several 

secondary pages which follow on automatically. To resume, press it again.
0	 7 (cancel)
	 Used to display the broadcast when searching for a page.
!	 2 (page up)
	 Used to display the next Teletext page.
@	 3 (page down)
	 Used to display the previous Teletext page.
#	 0 (mode)
	 Press to select the Teletext mode (LIST/ FLOF). If you press it in the LIST mode, it switches 

into the List save mode. In the List save mode, you can save Teletext page into list using the 
8(store) button.

The Teletext pages are organized according to six categories:
Part Contents

A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can 
be accessed by:

Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional 
graphics or text. 
Depending upon the transmission, blank side panels can occur when displaying Teletext. 
In these cases, additional graphics or text is not transmitted. 
Older TV’s which do not support version 2.5 are not capable of displaying any additional 
graphics or text, regardless of the Teletext transmission.

■

�
�
�

■

■
■
■

You can change Teletext 
pages by pressing the 
numeric buttons on the 
remote control.

■

Press the TV button to exit 
from the Teletext display.

■
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Using Your TV as a Computer (PC) Display
Setting Up Your PC Software (Based on Windows XP)

The Windows display-settings for a typical computer are shown below. The actual screens on your PC will probably be different, depending 
upon your particular version of Windows and your particular video card. However, even if your actual screens look different, the same basic 
set-up information will apply in almost all cases. (If not, contact your computer manufacturer or Samsung Dealer.)

1	 First, click on ‘Control Panel’ on the Windows start menu.				  
				 

2	 When the control panel window appears, click on ‘Appearance and Themes’ and a display 
dialog-box will appear.			 

3	 When the control panel window appears, click on ‘Display’ and a display dialogbox will 
appear.				  

4	 Navigate to the ‘Settings’ tab on the display dialog-box.
The correct size setting (resolution) - Optimum: 1920 X 1080 pixels.
If a vertical-frequency option exists on your display settings dialog box, the correct value 
is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.

Display Modes
If the signal from the system equals the standard signal mode, the screen is adjusted automatically. If the signal from the system doesn’t 
equal the standard signal mode, adjust the mode by referring to your videocard user guide; otherwise there may be no video. For the display 
modes listed on the next page, the screen image has been optimized during manufacturing.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM  640 x 350 31.469 70.086 25.175 +/-
 720 x 400 31.469 70.087 28.322 -/+

MAC
 640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 720 56.456 74.777 95.750 -/+
1280 x 960 75.231 74.857 130.000 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+ 
1440 x 900 70.635 74.984 136.750 -/+

1680 x 1050 65.290 59.954 146.250 -/+ 
VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 

1280 x 1024 74.620 70.000 128.943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 1(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes 1920x1080.

■
■

■
■
■
■
■
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Troubleshooting: Before Contacting Service 
Personnel
No sound or picture Check that the mains lead has been connected to a wall socket.

Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

●
●
●
●

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

●
●
●

Screen is black and power 
indicator light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

●
●
●

No picture or black and white 
picture

Adjust the colour settings.
Check that the broadcast system selected is correct.

●
●

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

●
●

Blurred or snowy picture, 
distorted sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

●
●

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

●
●
●

‘Check signal cable.’ message is 
displayed

Check that the signal cable is firmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

●
●

On PC mode, ‘Not Supported 
Mode.’ message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

●
●

The damaged picture appears in 
the corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in 
the corner of the screen. This symptom is caused by external devices, not TV.

●

The ‘Resets all settings to 
the default values.’ message 
appears.

This appears when you press and hold the EXIT button for a while. The product settings 
are reset to the factory defaults.

●

You may see small particles if 
you look closely at the edge of 
the bezel surrounding the TV 
screen.

This is part of the product’s design and is not a defect.●

This TFT LED panel uses a panel consisting of sub pixels (6 220 800) which require sophisticated technology to produce.  
However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the product.

■
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Specifications
Model Name UE40B7000, UE40B7020 UE46B7000, UE46B7020
Screen Size 
(Diagonal) 40 inches 46 inches

Power Consumption
Standby <1W <1W

PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz

Sound
(Output) 10W X 2 10W X 2

Dimensions (WxDxH)
Without Stand
With stand

996 X 30 X 630 mm
996 X 255 X 692 mm

1129 X 30 X 705 mm
1129 X 275 X 767 mm

Weight
With Stand 19 kg 23 kg

Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Model Name UE55B7000, UE55B7020
Screen Size 
(Diagonal) 55 inches

Power Consumption
Standby <1W

PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz

Sound
(Output) 15W x 2

Dimensions (WxDxH)
Without Stand
With stand

1321 X 30 X 815 mm
1321 X 305 X 877 mm

Weight
With Stand 28 kg

Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.

■
■
■
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Warning! Important Safety Instructions

Please read the appropriate section that corresponds to the marking on your Samsung product before attempting to install the product.

CAUTION
RISK OF ELECTRIC SHOCK DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,  
DO NOT REMOVE COVER (OR BACK). THERE ARE  

NO USER SERVICEABLE PARTS INSIDE. REFER ALL  
SERVICING TO QUALIFIED PERSONNEL.

This symbol indicates that high voltage is present 
inside. It is dangerous to make any kind of contact 
with any internal part of this product.

This symbol alerts you that important literature  
concerning operation and maintenance has been 
included with this product.

The slots and openings in the cabinet and in the back or bottom are provided for necessary ventilation.  
To ensure reliable operation of this apparatus, and to protect it from overheating, these slots and openings must never be 
blocked or covered.

- Do not cover the slots and openings with a cloth or other materials.
- Do not block the slots and openings by placing this apparatus on a bed, sofa, rug or other similar surface.
- Do not place this apparatus in a confined space, such as a bookcase, or built-in cabinet, unless proper ventilation is provided.
Give your product 10 cm (4 inch) clearance from the wall.

Do not place this apparatus near or over a radiator or heat resistor, or where it is exposed to direct sunlight.
Do not place heat generating items such as candles, ashtrays, incense, flammable gas or explosive materials near the product.
Do not place a water containing vessel on this apparatus, as this can result in a risk of fire  or electric shock.
Do not expose this apparatus to rain or place it near water(near a bathtub, washbowl, kitchen sink, or laundry tub, in a wet 
basement, or near a swimming pool etc.). If this apparatus accidentally gets wet, unplug it and contact an authorized dealer 
immediately. Make sure to pull out the power cord from the outlet before cleaning.
This apparatus use batteries. In your community there might be regulations that require you to dispose of these batteries  properly 
under environmental considerations. Please contact your local authorities for disposal or recycling information.
Do not overload wall outlets, extension cords or adaptors beyond their capacity, since this can result in fire or electric shock.
Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, 
paying particular attention to cords at plug end, adaptors and the point where they exit from the appliance.
To protect this apparatus from a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the 
wall outlet and disconnect the antenna or cable system.  
This will prevent damage to the set due to lightning and power line surges.
Before connecting the AC power cord to the DC adaptor outlet, make sure the voltage designation of the DC adaptor corresponds to 
the local electrical supply.
Never insert anything metallic into the open parts of this apparatus. Doing so many create a danger of electric shock.
To avoid electric shock, never touch the inside of this apparatus. Only a qualified technician should open this apparatus.
Make sure to plug the power cord in until it is firmly inserted. When removing the power cord, make sure to hold the power plug 
when pulling the plug from the outlet. Do not touch the power cord with wet hands.
If this apparatus does not operate normally - in particular, if there are any unusual sounds or smells coming from it

unplug it immediately and contact an authorized dealer or service centre.
Be sure to pull the power plug out of the outlet if the TV is to remain unused or if you are to leave the house for an extended period 
of time (especially when children, elderly or disabled people will be left alone in the house).  

Accumulated dust can cause an electric shock, an electric leakage or a fire by causing the power cord to generate sparks and heat 
or the insulation to deteriorate.

Be sure to contact an authorized service centre, when installing your set in a location with heavy dust, high or low temperatures,high 
humidity, chemical substances and where it operates for 24 hours such as the airport, the train station etc. Failure to do so may 
cause serious damage to your set.
Use only a properly grounded plug and receptacle. 

An improper ground may cause electric shock or equipment damage. (Class l Equipment only.)
To disconnect the apparatus from the mains, the plug must be pulled out from the mains socket, therefore the mains plug shall be 
readily operable.
Do not allow children to hang onto the product.
Store the accessories (battery, etc.) in a location safely out of the reach of children.
Do not install the product in an unstable location such as a shaky self, a slanted floor or a location exposed to vibration.
Do not drop or impart any shock to the product. If the product is damaged, disconnect the power cord and contact a service centre.

  �WARNING - TO PREVENT THE SPREAD OF FIRE,  
KEEP CANDLES OR OTHER OPEN FLAMES  
AWAY FROM THIS PRODUCT AT ALL TIMES.

●

●
●
●
●

●

●
●

●

●

●
●
●

●

●

●

●

●

●
●
●
●
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Wiring the Mains Power Supply Plug (UK Only)

IMPORTANT NOTICE 
The mains lead on this equipment is supplied with a moulded plug incorporating a fuse. The value of the fuse is indicated on the pin 
face of the plug and, if it requires replacing, a fuse approved to BSI1362 of the same rating must be used.
Never use the plug with the fuse cover omitted if the cover is detachable. If a replacement fuse cover is required, it must be of the same 
colour as the pin face of the plug. Replacement covers are available from your dealer.
If the fitted plug is not suitable for the power points in your house or the cable is not long enough to reach a power point, you should 
obtain a suitabl y approved extension lead or consult your dealer for assistance. However, if there is no alternative but to cut off the 
plug, remove the fuse and then safely dispose of the plug.
Do NOT connect the plug to a mains socket as there is a risk of shock hazard from the bared flexible cord.

IMPORTANT 
The wires in the mains lead are coloured in accordance with the following code: 
BLUE - NEUTRAL BROWN - LIVE 
As these colours may not correspond to the coloured markings identifying the terminals in your plug, proceed as follows : 
The wire coloured BLUE must be connected to the terminal marked with the letter N or coloured BLUE or BLACK. The wire coloured 
BROWN must be connected to the terminal marked with the letter L or coloured BROWN or RED.

WARNING: 
DO NOT CONNECT EITHER WIRE TO THE EARTH TERMINAL, WHICH IS MARKED WITH THE 
LETTER E OR BY THE EARTH SYMBOL , OR COLOURED GREEN OR GREEN AND YELLOW.

Warranty Card

United Kingdom

This Samsung product is warranted for a period of twelve (12) months from the original date of purchase, against defective materials 
and workmanship. In the event that warranty service is required, you should return the product to the retailer from whom it was 
purchased. However, Samsung Authorised Dealers and Authorised Service Centres in other EC Countries will comply with the warranty 
on the terms issued to purchasers in the country concerned. In case of difficulty, details of our Authorised Service Centres are available 
from:

Samsung Electronics U.K. Ltd.
Customer Care Centre

PO Box 17243
Edinburgh, EH11 4YB

United Kingdom
Tel: 0845 SAMSUNG (7267864) (UK & Northern Ireland)

Tel: 0818 717 100 (EIRE Only)
Fax: +44 0845 650 8080

Web : www.samsung.com

WARRANTY CONDITIONS

1.	 The warranty is only valid if, when warranty service is required, the warranty card is fully and properly completed and is presented 
with the original invoice or sales slip or confirmation, and the serial number on the product has not been defaced.

2.	 Samsung’s obligations are limited to the repair or, at its discretion, replacement of the product or the defective part.

3.	 Warranty repairs must be carried out by Authorised Samsung Dealers or Authorised Service Centres. No re-imbursement will be 
made for repairs carried out by non Samsung Dealers and, any such repair work and damage to the products caused by such 
repair work will not be covered by this warranty.

4.	 This product is not considered to be defective in materials nor workmanship by reason that it requires adaptation in order to 
conform to national or local technical or safety standards in force in any Country other than the one for which the product was 
originally designed and manufactured.
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This product uses parts of the software from the Independent JPEG Group.
This product uses parts of the software owned by the Freetype Project (www.freetype.org).
This product uses some software programs which are distributed under the GPL/LGPL license. Accordingly, the following 
GPL and LGPL software source codes that have been used in this product can be provided after asking to vdswmanager@
samsung.com.
GPL software: Linux Kernel, Busybox, Binutils
LGPL software: Glibc, ffmpeg, smpeg, libgphoto, libusb, SDL

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007
 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to 
make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of 
our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that 
you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it 
if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you 
have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these 
terms so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License 
giving you legal permission to copy, distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both users’ and 
authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously 
to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of the software inside them, although the 
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. The 
systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. 
Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially 
in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users.
Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use 
of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free 
program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-
free.
The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. 	 Definitions.
“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” 
and “recipients” may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than 
the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the 
earlier work.

●
●
●
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A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable 
for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation 
includes copying, distribution (with or without modification), making available to the public, and in some countries other 
activities as well.
To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with 
a user through a computer network, with no transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently 
visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work 
(except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a 
copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list 
meets this criterion.

1.	 Source Code.
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any 
non-source
form of a work.
A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the 
case of interfaces specified for a particular programming language, one that is widely used among developers working in that 
language.
The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the 
normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable 
use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to 
the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window 
system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce 
the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an 
executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not 
include the work’s System Libraries, or general-purpose tools or generally available free programs which are used unmodified 
in performing those activities but which are not part of the work. For example, Corresponding Source includes interface 
definition files associated with source files for the work, and the source code for shared libraries and dynamically linked 
subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between 
those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the 
Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

2.	 Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the 
stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output 
from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. 
This License acknowledges your rights of fair use or other equivalent, as provided by copyright law. You may make, run and 
propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You 
may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide 
you with facilities for running those works, provided that you comply with the terms of this License in conveying all material 
for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on 
your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material 
outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; 
section 10 makes it unnecessary.

3.	 Protecting Users’ Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations 
under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting 
circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent 
such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any 
intention to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ 
legal rights to forbid circumvention of technological measures.

4.	 Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this 
License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence 
of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a 
fee.

5.	 Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code 
under the terms of section 4, provided that you also meet all of these conditions:
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a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
b) The work must carry prominent notices stating that it is released under this License and any conditions added under 
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This 
License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its 
parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it 
does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has 
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of 
the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or 
distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or 
legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate 
does not cause this License to apply to the other parts of the aggregate.

6.	 Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the 
machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that 
product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the 
software in the product that is covered by this License, on a durable physical medium customarily used for software 
interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) 
access to copy the Corresponding Source from a network server at no charge.
c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This 
alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, 
in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent 
access to the Corresponding Source in the same way through the same place at no further charge. You need not require 
recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network 
server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent 
copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding 
Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for 
as long as needed to satisfy these requirements.
e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and 
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d. A separable 
portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not 
be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for 
personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining 
whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product 
received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the 
status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the 
product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-
consumer uses, unless such uses represent the only significant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required 
to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding 
Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case 
prevented or interfered with solely because modification has been made.
If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying 
occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in 
perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under 
this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any 
third party retains the ability to install modified object code on the User Product (for example, the work has been installed in 
ROM).
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The requirement to provide Installation Information does not include a requirement to continue to provide support service, 
warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has 
been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the 
operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is 
publicly documented (and with an implementation available to the public in source code form), and must require no special 
password or key for unpacking, reading or copying.

7.	 Additional Terms.
“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its 
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in 
this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, 
that part may be used separately under those permissions, but the entire Program remains governed by this License without 
regard to the additional permissions.
When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or 
from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the 
work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give 
appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the 
copyright holders of that material) supplement the terms of this License with terms:

a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate 
Legal Notices displayed by works containing it; or
c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be 
marked in reasonable ways as different from the original version; or
d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified 
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions 
directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program 
as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a 
further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or 
conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the 
additional terms that apply to those files, or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as 
exceptions; the above requirements apply either way. 

8.	 Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to 
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses 
granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the 
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the 
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) 
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from 
you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new 
licenses for the same material under section 10.

9.	 Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered 
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require 
acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These 
actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you 
indicate your acceptance of this License to do so.
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10.	 Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify 
and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this 
License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing 
an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party 
to that transaction who receives a copy of the work also receives whatever licenses to the work the party’s predecessor in 
interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work 
from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, 
you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not 
initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, 
using, selling, offering for sale, or importing the Program or any portion of it.

11.	 Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is 
based. The work thus licensed is called the contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired 
or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its 
contributor version, but do not include claims that would be infringed only as a consequence of further modification of the 
contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent 
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not 
to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To 
“grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the 
party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not 
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or 
other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange 
to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have 
actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the 
covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are 
valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance 
of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, 
propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended 
to all recipients of the covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is 
conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not 
convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, 
under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) 
in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in 
connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or 
that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that 
may otherwise be available to you under applicable patent law.

12.	 No Surrender of Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not 
convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to 
whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely 
from conveying the Program.

13.	 Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work 
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting 
work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of 
the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as 
such.
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14.	 Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU 
General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of 
that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify 
a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that 
proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any 
author or copyright holder as a result of your choosing to follow a later version.

15.	 Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16.	 Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA 
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17.	 Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, 
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with 
the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it 
free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively state 
the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

<one line to give the program’s name and a brief idea of what it does.> Copyright (C) <year> <name of author>
This program is free software: you can redistribute it and/or modify it under the terms of the GNU General Public License as 
published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details.
You should have received a copy of the GNU General Public License along with this program. If not, see <http://www.gnu.
org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

<program> Copyright (C) <year> <name of author> This program comes with ABSOLUTELY NO WARRANTY; for details type 
`show w’. This is free software, and you are welcome to redistribute it under certain conditions; type `show c’ for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, your 
program’s commands might be different; for a GUI interface, you would use an “about box”.
You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer” for the program, if 
necessary.
For more information on this, and how to apply and follow the GNU GPL, see <http://www.gnu.org/licenses/>.
The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine 
library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the 
GNU Lesser General Public License instead of this License. But first, please read <http://www.gnu.org/philosophy/why-not-lgpl.html>.
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GNU Lesser General Public License (LGPL)
Version 3, 29 June 2007
 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to 
make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for most of 
our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that 
you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get it 
if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you 
have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these 
terms so they know their rights.
Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License 
giving you legal permission to copy, distribute and/or modify it.
For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both users’ and 
authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed erroneously 
to authors of previous versions.
Some devices are designed to deny users access to install or run modified versions of the software inside them, although the 
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. The 
systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable. 
Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially 
in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users.
Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use 
of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free 
program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program non-
free.
The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. 	 Definitions.
“This License” refers to version 3 of the GNU General Public License.
“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” 
and “recipients” may be individuals or organizations.
To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than 
the making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the 
earlier work.
A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable 
for infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation 
includes copying, distribution (with or without modification), making available to the public, and in some countries other 
activities as well.
To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with 
a user through a computer network, with no transfer of a copy, is not conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently 
visible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work 
(except to the extent that warranties are provided), that licensees may convey the work under this License, and how to view a 
copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list 
meets this criterion.
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1.	 Source Code.
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any 
non-source
form of a work.
A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the 
case of interfaces specified for a particular programming language, one that is widely used among developers working in that 
language.
The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the 
normal form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable 
use of the work with that Major Component, or to implement a Standard Interface for which an implementation is available to 
the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, window 
system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce 
the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an 
executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not 
include the work’s System Libraries, or general-purpose tools or generally available free programs which are used unmodified 
in performing those activities but which are not part of the work. For example, Corresponding Source includes interface 
definition files associated with source files for the work, and the source code for shared libraries and dynamically linked 
subprograms that the work is specifically designed to require, such as by intimate data communication or control flow between 
those subprograms and other parts of the work.
The Corresponding Source need not include anything that users can regenerate automatically from other parts of the 
Corresponding Source.
The Corresponding Source for a work in source code form is that same work.

2.	 Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the 
stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output 
from running a covered work is covered by this License only if the output, given its content, constitutes a covered work. 
This License acknowledges your rights of fair use or other equivalent, as provided by copyright law. You may make, run and 
propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You 
may convey covered works to others for the sole purpose of having them make modifications exclusively for you, or provide 
you with facilities for running those works, provided that you comply with the terms of this License in conveying all material 
for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on 
your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material 
outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; 
section 10 makes it unnecessary.

3.	 Protecting Users’ Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations 
under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting 
circumvention of such measures.
When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent 
such circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any 
intention to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ 
legal rights to forbid circumvention of technological measures.

4.	 Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this 
License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence 
of any warranty; and give all recipients a copy of this License along with the Program.
You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a 
fee.

5.	 Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code 
under the terms of section 4, provided that you also meet all of these conditions:

a) The work must carry prominent notices stating that you modified it, and giving a relevant date.
b) The work must carry prominent notices stating that it is released under this License and any conditions added under 
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.
c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This 
License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its 
parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it 
does not invalidate such permission if you have separately received it.
d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has 
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.
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A compilation of a covered work with other separate and independent works, which are not by their nature extensions of 
the covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or 
distribution medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or 
legal rights of the compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate 
does not cause this License to apply to the other parts of the aggregate.

6.	 Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the 
machine-readable Corresponding Source under the terms of this License, in one of these ways:

a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by the Corresponding Source fixed on a durable physical medium customarily used for software interchange.
b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied 
by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that 
product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the 
software in the product that is covered by this License, on a durable physical medium customarily used for software 
interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) 
access to copy the Corresponding Source from a network server at no charge.
c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This 
alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, 
in accord with subsection 6b.
d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent 
access to the Corresponding Source in the same way through the same place at no further charge. You need not require 
recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network 
server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent 
copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding 
Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for 
as long as needed to satisfy these requirements.
e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and 
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d. A separable 
portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not 
be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for 
personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining 
whether a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product 
received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the 
status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the 
product. A product is a consumer product regardless of whether the product has substantial commercial, industrial or non-
consumer uses, unless such uses represent the only significant mode of use of the product.
“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required 
to install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding 
Source. The information must suffice to ensure that the continued functioning of the modified object code is in no case 
prevented or interfered with solely because modification has been made.
If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying 
occurs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in 
perpetuity or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under 
this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor any 
third party retains the ability to install modified object code on the User Product (for example, the work has been installed in 
ROM).
The requirement to provide Installation Information does not include a requirement to continue to provide support service, 
warranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has 
been modified or installed. Access to a network may be denied when the modification itself materially and adversely affects the 
operation of the network or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is 
publicly documented (and with an implementation available to the public in source code form), and must require no special 
password or key for unpacking, reading or copying.

7.	 Additional Terms.
“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its 
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in 
this License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, 
that part may be used separately under those permissions, but the entire Program remains governed by this License without 
regard to the additional permissions.
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When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or 
from any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the 
work.) You may place additional permissions on material, added by you to a covered work, for which you have or can give 
appropriate copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the 
copyright holders of that material) supplement the terms of this License with terms:

a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate 
Legal Notices displayed by works containing it; or
c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be 
marked in reasonable ways as different from the original version; or
d) Limiting the use for publicity purposes of names of licensors or authors of the material; or
e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified 
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions 
directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program 
as you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a 
further restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or 
conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the 
additional terms that apply to those files, or a notice indicating where to find the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as 
exceptions; the above requirements apply either way. 

8.	 Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to 
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses 
granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the 
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the 
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) 
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from 
you under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new 
licenses for the same material under section 10.

9.	 Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered 
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require 
acceptance. However, nothing other than this License grants you permission to propagate or modify any covered work. These 
actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you 
indicate your acceptance of this License to do so.

10.	 Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify 
and propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this 
License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing 
an organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party 
to that transaction who receives a copy of the work also receives whatever licenses to the work the party’s predecessor in 
interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work 
from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, 
you may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not 
initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, 
using, selling, offering for sale, or importing the Program or any portion of it.
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11.	 Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is 
based. The work thus licensed is called the contributor’s “contributor version”.
A contributor’s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired 
or hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its 
contributor version, but do not include claims that would be infringed only as a consequence of further modification of the 
contributor version. For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent 
claims, to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not 
to enforce a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To 
“grant” such a patent license to a party means to make such an agreement or commitment not to enforce a patent against the 
party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not 
available for anyone to copy, free of charge and under the terms of this License, through a publicly available network server or 
other readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange 
to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have 
actual knowledge that, but for the patent license, your conveying the covered work in a country, or your recipient’s use of the 
covered work in a country, would infringe one or more identifiable patents in that country that you have reason to believe are 
valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance 
of, a covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, 
propagate, modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended 
to all recipients of the covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is 
conditioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not 
convey a covered work if you are a party to an arrangement with a third party that is in the business of distributing software, 
under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) 
in connection with copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in 
connection with specific products or compilations that contain the covered work, unless you entered into that arrangement, or 
that patent license was granted, prior to 28 March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that 
may otherwise be available to you under applicable patent law.

12.	 No Surrender of Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not 
convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to 
whom you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely 
from conveying the Program.

13.	 Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work 
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting 
work. The terms of this License will continue to apply to the part which is the covered work, but the special requirements of 
the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combination as 
such.

14.	 Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU 
General Public License “or any later version” applies to it, you have the option of following the terms and conditions either of 
that numbered version or of any later version published by the Free Software Foundation. If the Program does not specify 
a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that 
proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Program.
Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any 
author or copyright holder as a result of your choosing to follow a later version.
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15.	 Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16.	 Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA 
OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17.	 Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, 
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with 
the Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it 
free software which everyone can redistribute and change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively state 
the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

<one line to give the program’s name and a brief idea of what it does.> Copyright (C) <year> <name of author>
This program is free software: you can redistribute it and/or modify it under the terms of the GNU General Public License as 
published by the Free Software Foundation, either version 3 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details.
You should have received a copy of the GNU General Public License along with this program. If not, see <http://www.gnu.
org/licenses/>.

Also add information on how to contact you by electronic and paper mail.
If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

<program> Copyright (C) <year> <name of author> This program comes with ABSOLUTELY NO WARRANTY; for details type 
`show w’. This is free software, and you are welcome to redistribute it under certain conditions; type `show c’ for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, your 
program’s commands might be different; for a GUI interface, you would use an “about box”.
You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer” for the program, if 
necessary.
For more information on this, and how to apply and follow the GNU GPL, see <http://www.gnu.org/licenses/>.
The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine 
library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the 
GNU Lesser General Public License instead of this License. But first, please read <http://www.gnu.org/philosophy/why-not-lgpl.html>.
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LICENSE ISSUES
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the original SSLeay license apply 
to the toolkit. See below for the actual license texts. Actually both licenses are BSD-style Open Source licenses. In case of any license 
issues related to OpenSSL please contact openssl-core@openssl.org.
OpenSSL License
Copyright (c) 1998-2007 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are 
met:

1.	 Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 
the documentation and/or other materials provided with the distribution.

3.	 All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product 
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)”

4.	 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived from this 
software without prior written permission. For written permission, please contact openssl-core@openssl.org.

5.	 Products derived from this software may not be called “OpenSSL nor may “OpenSSL” appear in their names without prior 
written permission of the OpenSSL Project.

6.	 Redistributions of any form whatsoever must retain the following acknowledgment: “This product includes software developed 
by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS’’ AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim 
Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform 
with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions 
apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation 
included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).
Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be removed. If this package is used in 
a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual 
message at program startup or in documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are 
met:

1.	 Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2.	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in 
the documentation and/or other materials provided with the distribution.

3.	 All advertising materials mentioning features or use of this software must display the following acknowledgement: “This 
product includes cryptographic software written by Eric Young (eay@cryptsoft.com)” The word ‘cryptographic’ can be left out if 
the rouines from the library being used are not cryptographic related :-).

4.	 If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include 
an acknowledgement: “This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS’’ AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot 
simply be copied and put under another distribution licence [including the GNU Public Licence.]
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Correct Disposal of This Product (Waste Electrical & Electronic Equipment) 
(Applicable in the European Union and other European countries with separate collection systems) This marking on the product, accessories 
or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be disposed of with other 
household waste at the end of their working life. To prevent possible harm to the environment or human health from uncontrolled waste 
disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material 
resources. Household users should contact either the retailer where they purchased this product, or their local government office, for details 
of where and how they can take these items for environmentally safe recycling. Business users should contact their supplier and check the 
terms and conditions of the purchase contract. This product and its electronic accessories should not be mixed with other commercial wastes 
for disposal.

[English]
Les bons gestes de mise au rebut de ce produit (Déchets d’équipements électriques et électroniques) 
(Applicable dans les pays de l’Union Européenne et dans d’autres pays européens pratiquant le tri sélectif)
Ce symbole sur le produit, ses accessoires ou sa documentation indique que ni le produit, ni ses accessoires électroniques usagés 
(chargeur, casque audio, câble USB, etc.) ne peuvent être jetés avec les autres déchets ménagers. La mise au rebut incontrôlée des 
déchets présentant des risques environnementaux et de santé publique, veuillez séparer vos produits et accessoires usagés des autres 
déchets. Vous favoriserez ainsi le recyclage de la matière qui les compose dans le cadre d’un développement durable. Les particuliers sont 
invités à contacter le magasin leur ayant vendu le produit ou à se renseigner auprès des autorités locales pour connaître les procédures et 
les points de collecte de ces produits en vue de leur recyclage. Les entreprises et professionnels sont invités à contacter leurs fournisseurs 
et à consulter les conditions de leur contrat de vente. Ce produit et ses accessoires ne peuvent être jetés avec les autres déchets 
professionnels et commerciaux.

[Français]
Korrekte Entsorgung von Altgeräten (Elektroschrott) 
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem separaten Sammelsystem)
Die Kennzeichnung auf dem Produkt, Zubehörteilen bzw. auf der dazugehörigen Dokumentation gibt an, dass das Produkt und Zubehörteile 
(z. B. Ladegerät, Kopfhörer, USB-Kabel) nach ihrer Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll entsorgt werden dürfen.
Entsorgen Sie dieses Gerät und Zubehörteile bitte getrennt von anderen Abfällen, um der Umwelt bzw. der menschlichen Gesundheit 
nicht durch unkontrollierte Müllbeseitigung zu schaden. Helfen Sie mit, das Altgerät und Zubehörteile fachgerecht zu entsorgen, um die 
nachhaltige Wiederverwertung von stofflichen Ressourcen zu fördern. Private Nutzer wenden sich an den Händler, bei dem das Produkt 
gekauft wurde, oder kontaktieren die zuständigen Behörden, um in Erfahrung zu bringen, wo Sie das Altgerät bzw. Zubehörteile für eine 
umweltfreundliche Entsorgung abgeben können. Gewerbliche Nutzer wenden sich an ihren Lieferanten und gehen nach den Bedingungen 
des Verkaufsvertrags vor. Dieses Produkt und elektronische Zubehörteile dürfen nicht zusammen mit anderem Gewerbemüll entsorgt 
werden.

[Deutsch]
Correcte verwijdering van dit product (elektrische & elektronische afvalapparatuur)
Dit merkteken op het product, de accessoires of het informatiemateriaal duidt erop dat het product en zijn elektronische accessoires (bv. 
lader, headset, USB-kabel) niet met ander huishoudelijk afval verwijderd mogen worden aan het einde van hun gebruiksduur. Om mogelijke 
schade aan het milieu of de menselijke gezondheid door ongecontroleerde afvalverwijdering te voorkomen, moet u deze artikelen van 
andere soorten afval scheiden en op een verantwoorde manier recyclen, zodat het duurzame hergebruik van materiaalbronnen wordt 
bevorderd. Huishoudelijke gebruikers moeten contact opnemen met de winkel waar ze dit product hebben gekocht of met de gemeente 
waar ze wonen om te vernemen waar en hoe ze deze artikelen milieuvriendelijk kunnen laten recyclen. Zakelijke gebruikers moeten 
contact opnemen met hun leverancier en de algemene voorwaarden van de koopovereenkomst nalezen. Dit product en zijn elektronische 
accessoires mogen niet met ander bedrijfsafval voor verwijdering worden gemengd.

[Nederlands]
Corretto smaltimento del prodotto (rifiuti elettrici ed elettronici)
(Applicabile nell’Unione Europea e in altri paesi europei con sistema di raccolta differenziata)  
Il marchio riportato sul prodotto, sugli accessori o sulla documentazione indica che il prodotto e i relativi accessori elettronici (quali 
caricabatterie, cuffia e cavo USB) non devono essere smaltiti con altri rifiuti domestici al termine del ciclo di vita. Per evitare eventuali danni 
all’ambiente o alla salute causati dall’inopportuno smaltimento dei rifiuti, si invita l’utente a separare il prodotto e i suddetti accessori da altri 
tipi di rifiuti e di riciclarli in maniera responsabile per favorire il riutilizzo sostenibile delle risorse materiali. Gli utenti domestici sono invitati a 
contattare il rivenditore presso il quale è stato acquistato il prodotto o l’ufficio locale preposto per tutte le informazioni relative alla raccolta 
differenziata e al riciclaggio per questo tipo di materiali. Gli utenti aziendali sono invitati a contattare il proprio fornitore e verificare i termini 
e le condizioni del contratto di acquisto. Questo prodotto e i relativi accessori elettronici non devono essere smaltiti unitamente ad altri rifiuti 
commerciali.

[Italiano]
Eliminación correcta de este producto (Residuos de aparatos eléctricos y electrónicos)
(Aplicable en la Unión Europea y en países europeos con sistemas de recogida selectiva de residuos)  
La presencia de este símbolo en el producto, accesorios o material informativo que lo acompañan, indica que al finalizar su vida útil ni el 
producto ni sus accesorios electrónicos (como el cargador, cascos, cable USB) deberán eliminarse junto con otros residuos domésticos. 
Para evitar los posibles daños al medio ambiente o a la salud humana que representa la eliminación incontrolada de residuos, separe 
estos productos de otros tipos de residuos y recíclelos correctamente. De esta forma se promueve la reutilización sostenible de recursos 
materiales. Los usuarios particulares pueden contactar con el establecimiento donde adquirieron el producto o con las autoridades locales 
pertinentes para informarse sobre cómo y dónde pueden llevarlo para que sea sometido a un reciclaje ecológico y seguro. Los usuarios 
comerciales pueden contactar con su proveedor y consultar las condiciones del contrato de compra. Este producto y sus accesorios 
electrónicos no deben eliminarse junto a otros residuos comerciales.

[Español]
Eliminação Correcta Deste Produto (Resíduos de Equipamentos Eléctricos e Electrónicos)
Esta marca apresentada no produto, nos acessórios ou na literatura – indica que o produto e os seus acessórios electrónicos (por exemplo, 
o carregador, o auricular, o cabo USB) não deverão ser eliminados juntamente com os resíduos domésticos no final do seu período de 
vida útil. Para impedir danos ao ambiente ou à saúde humana causados pela eliminação incontrolada de resíduos, deverá separar estes 
equipamentos de outros tipos de resíduos e reciclá-los de forma responsável, para promover uma reutilização sustentável dos recursos 
materiais. Os utilizadores domésticos deverão contactar o estabelecimento onde adquiriram este produto ou as entidades oficiais locais 
para obterem informações sobre onde e de que forma podem entregar estes equipamentos para permitir efectuar uma reciclagem segura 
em termos ambientais. Os utilizadores profissionais deverão contactar o seu fornecedor e consultar os termos e condições do contrato de 
compra. Este produto e os seus acessórios electrónicos não deverão ser misturados com outros resíduos comerciais para eliminação.

[Português]
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Korrekt avfallshantering av produkten (elektriska och elektroniska produkter)
Denna markering på produkten, tillbehören och i manualen anger att produkten och de elektroniska tillbehören (t.ex. laddare, headset, 
USB-kabel) inte bör sorteras tillsammans med annat hushållsavfall när de kasseras. Till förebyggande av skada på miljö och hälsa bör 
dessa föremål hanteras separat för ändamålsenlig återvinning av beståndsdelarna. Hushållsanvändare bör kontakta den återförsäljare 
som sålt produkten eller sin kommun för vidare information om var och hur produkten och tillbehören kan återvinnas på ett miljösäkert sätt. 
Företagsanvändare bör kontakta leverantören samt verifiera angivna villkor i köpekontraktet. Produkten och de elektroniska tillbehören bör 
inte hanteras tillsammans med annat kommersiellt avfall.

[Svenska]

Korrekt affaldsbortskaffelse af dette produkt (elektrisk & elektronisk udstyr)
Mærket på dette produkt, på tilbehør eller i den medfølgende dokumentation betyder, at produktet og elektronisk tilbehør hertil (f.eks. 
oplader, hovedsæt, USB-ledning) ikke må bortskaffes sammen med almindeligt husholdningsaffald efter endt levetid. For at undgå skadelige 
miljø- eller sundhedspåvirkninger på grund af ukontrolleret affaldsbortskaffelse skal ovennævnte bortskaffes særskilt fra andet affald og 
indleveres behørigt til fremme for bæredygtig materialegenvinding. Forbrugere bedes kontakte forhandleren, hvor de har købt produktet, 
eller kommunen for oplysning om, hvor og hvordan de kan indlevere ovennævnte med henblik på miljøforsvarlig genvinding. Virksomheder 
bedes kontakte leverandøren og læse betingelserne og vilkårene i købekontrakten. Dette produkt og elektronisk tilbehør hertil bør ikke 
bortskaffes sammen med andet erhvervsaffald.

[Dansk]

Korrekt avhending av dette produktet (Avfall fra elektrisk og elektronisk utstyr)
Denne merkingen som vises på produktet, dets tilbehør eller dokumentasjon, indikerer at produktet eller det elektroniske tilbehøret (for 
eksempel lader, headset, USB-kabel) ikke skal kastes sammen med annet husholdningsavfall ved slutten av levetiden. For å hindre 
potensiell skade på miljøet eller helseskader grunnet ukontrollert avfallsavhending ber vi om at dette avfallet holdes adskilt fra andre 
typer avfall og resirkuleres på ansvarlig måte for å fremme bærekraftig gjenbruk av materielle ressurser. Private forbrukere bør kontakte 
enten forhandleren de kjøpte produktet av, eller lokale myndigheter, for detaljer om hvor og hvordan disse artiklene kan resirkuleres på 
en miljøvennlig måte. Forretningsbrukere bør kontakte sin leverandør og undersøke vilkårene i kjøpskontrakten. Dette produktet og det 
elektroniske tilbehøret skal ikke blandes med annet kommersielt avfall som skal kastes.

[Norsk]

Tuotteen turvallinen hävittäminen (elektroniikka ja sähkölaitteet)
Oheinen merkintä tuotteessa, lisävarusteissa tai käyttöohjeessa merkitsee, että tuotetta tai lisävarusteina toimitettavia sähkölaitteita (esim. 
laturia, kuulokkeita tai USB kaapelia) ei saa hävittää kotitalousjätteen mukana niiden käyttöiän päätyttyä. Virheellisestä jätteenkäsittelystä 
ympäristölle ja terveydelle aiheutuvien haittojen välttämiseksi tuote ja lisävarusteet on eroteltava muusta jätteestä ja kierrätettävä 
kestävän kehityksen mukaista uusiokäyttöä varten. Kotikäyttäjät saavat lisätietoja tuotteen ja lisävarusteiden turvallisesta kierrätyksestä 
ottamalla yhteyttä tuotteen myyneeseen jälleenmyyjään tai paikalliseen ympäristöviranomaiseen. Yrityskäyttäjien tulee ottaa yhteyttä 
tavarantoimittajaan ja selvittää hankintasopimuksen ehdot. Tuotetta tai sen lisävarusteita ei saa hävittää muun kaupallisen jätteen seassa.

[Suomi]

A termék hulladékba helyezésének módszere(WEEE – Elektromos és elektronikus berendezések hulladékai)
Ez a jelzés a terméken, tartozékain vagy dokumentációján arra utal, hogy hasznos élettartama végén a terméket és elektronikus tartozékait 
(pl. töltőegység, fejhallgató, USB kábel) nem szabad a háztartási hulladékkal együtt kidobni. A szabálytalan hulladékba helyezés által 
okozott környezet- és egészségkárosodás megelőzése érdekében ezeket a tárgyakat különítse el a többi hulladéktól, és felelősségteljesen 
gondoskodjon az újrahasznosításukról az anyagi erőforrások fenntartható újrafelhasználásának elősegítése érdekében. A háztartási 
felhasználók a termék forgalmazójától vagy a helyi önkormányzati szervektől kérjenek tanácsot arra vonatkozóan, hová és hogyan vihetik 
el az elhasznált termékeket a környezetvédelmi szempontból biztonságos újrahasznosítás céljából. Az üzleti felhasználók lépjenek 
kapcsolatba beszállítójukkal, és vizsgálják meg az adásvételi szerződés feltételeit. Ezt a terméket és tartozékait nem szabad az egyéb 
közületi hulladékkal együtt kezelni.

[Magyar]

Prawidłowe usuwanie produktu (zużyty sprzęt elektryczny i elektroniczny)
To oznaczenie umieszczone na produkcie, akcesoriach lub dokumentacji oznacza, że po zakończeniu eksploatacji nie należy tego produktu 
ani jego akcesoriów (np. ładowarki, zestawu słuchawkowego, przewodu USB) wyrzucać wraz ze zwykłymi odpadami gospodarstwa 
domowego. Aby uniknąć szkodliwego wpływu na środowisko naturalne i zdrowie ludzi wskutek niekontrolowanego usuwania odpadów, 
prosimy o oddzielenie tych przedmiotów od odpadów innego typu oraz o odpowiedzialny recykling i praktykowanie ponownego 
wykorzystania materiałów. W celu uzyskania informacji na temat miejsca i sposobu bezpiecznego dla środowiska recyklingu tych 
przedmiotów, użytkownicy w gospodarstwach domowych powinni skontaktować się z punktem sprzedaży detalicznej, w którym dokonali 
zakupu produktu, lub z organem władz lokalnych. Użytkownicy w firmach powinni skontaktować się ze swoim dostawcą i sprawdzić warunki 
umowy zakupu. Produktu ani jego akcesoriów nie należy usuwać razem z innymi odpadami komercyjnymi.

[Polski]

Σωστή Απόρριψη αυτού του Προϊόντος (Απόβλητα Ηλεκτρικού & Ηλεκτρονικού Εξοπλισμού) 
(Ισχύει για την Ευρωπαϊκή Ένωση και για άλλες ευρωπαϊκές χώρες με χωριστά συστήματα συλλογής) Αυτό το σήμα που εμφανίζεται επάνω 
στο προϊόν, στα εξαρτήματά του ή στα εγχειρίδια που το συνοδεύουν, υποδεικνύει ότι το προϊόν και τα ηλεκτρονικά του εξαρτήματα (π.χ. 
φορτιστής, ακουστικά, καλώδιο USB) δεν θα πρέπει να ρίπτονται μαζί με τα υπόλοιπα οικιακά απορρίμματα μετά το τέλος του κύκλου ζωής 
τους. Προκειμένου να αποφευχθούν ενδεχόμενες βλαβερές συνέπειες στο περιβάλλον ή την υγεία εξαιτίας της ανεξέλεγκτης διάθεσης 
απορριμμάτων, σας παρακαλούμε να διαχωρίσετε αυτά τα προϊόντα από άλλους τύπους απορριμμάτων και να τα ανακυκλώσετε, ώστε 
να βοηθήσετε στην βιώσιμη επαναχρησιμοποίηση των υλικών πόρων. Οι οικιακοί χρήστες θα πρέπει να έλθουν σε επικοινωνία είτε με 
το κατάστημα απ’ όπου αγόρασαν αυτό το προϊόν, είτε με τις κατά τόπους υπηρεσίες, προκειμένου να πληροφορηθούν τις λεπτομέρειες 
σχετικά με τον τόπο και τον τρόπο με τον οποίο μπορούν να δώσουν αυτά τα προϊόντα για ασφαλή προς το περιβάλλον ανακύκλωση. 
Οι επιχειρήσεις-χρήστες θα πρέπει να έλθουν σε επαφή με τον προμηθευτή τους και να ελέγξουν τους όρους και τις προϋποθέσεις του 
συμβολαίου αγοράς. Αυτό το προϊόν και τα ηλεκτρονικά του εξαρτήματα δεν θα πρέπει να αναμιγνύονται με άλλα συνηθισμένα απορρίμματα 
προς διάθεση.

[Ελληνικά]
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Правилно третиране на изделието след края на експлоатационния му живот
(Отпадъци, представляващи електрическо и електронно оборудване)(Важи за държавите на Европейския съюз и други европейски 
държави със системи за разделно сметосъбиране)
Този знак, поставен върху изделието, негови принадлежности или печатни материали, означава, че продуктът и принадлежностите 
(например зарядно устройство, слушалки, USB кабел) не бива да се изхвърлят заедно с другите битови отпадъци, когато изтече 
експлоатационният му живот. Отделяйте тези устройства от другите видови отпадъци и ги предавайте за рециклиране. Спазвайки 
това правило не излагате на опасност здравето на други хора и предпазвате околната среда от замърсяване, предизвикано от 
безконтролно изхвърляне на отпадъци. Освен това, подобно отговорно поведение създава възможност за повторно (екологично 
съобразно) използване на материалните ресурси. Домашните потребители трябва да се свържат с търговеца на дребно, от когото 
са закупили изделието, или със съответната местна държавна агенция, за да получат подробни инструкции къде и кога могат 
да занесат тези устройства за рециклиране, безопасно за околната среда. Корпоративните потребители следва да се свържат с 
доставчика си и да проверят условията на договора за покупка. Това изделие и неговите електронни принадлежности не бива да се 
сместват с другите отпадъци на търговското предприятие.

[Български]

Správná likvidace výrobku (Elektrický a elektronický odpad)
Toto označení na výrobku, jeho příslušenství nebo dokumentaci znamená, že výrobek a jeho elektronické příslušenství (například nabíječku, 
náhlavní sadu, USB kabel) je po skončení životnosti zakázáno likvidovat jako běžný komunální odpad. Možným negativním dopadům na 
životní prostředí nebo lidské zdraví způsobeným nekontrolovanou likvidací zabráníte oddělením zmíněných produktů od ostatních typů 
odpadu a jejich zodpovědnou recyklací za účelem udržitelného využívání druhotných surovin. Uživatelé z řad domácností by si měli od 
prodejce, u něhož produkt zakoupili, nebo u příslušného městského úřadu vyžádat informace, kde a jak mohou tyto výrobky odevzdat k 
bezpečné ekologické recyklaci. Podnikoví uživatelé by měli kontaktovat dodavatele a zkontrolovat všechny podmínky kupní smlouvy. Tento 
výrobek a jeho elektronické příslušenství nesmí být likvidován spolu s ostatním průmyslovým odpadem.

[Čeština]

Správna likvidácia tohoto výrobku (Elektrotechnický a elektronický odpad) 
(Platné pre Európsku úniu a ostatné európske krajiny so systémom triedeného odpadu)
Toto označenie na výrobku, príslušenstve alebo v sprievodnej brožúre hovorí, že po skončení životnosti by produkt ani jeho elektronické 
príslušenstvo (napr. nabíjačka, náhlavná súprava, USB kábel) nemali byť likvidované s ostatným domovým odpadom. Prípadnému 
poškodeniu životného prostredia alebo ľudského zdravia môžete predísť tým, že budete tieto výrobky oddeľovať od ostatného odpadu a 
vrátite ich na recykláciu. Používatelia v domácnostiach by pre podrobné informácie, ako ekologicky bezpečne naložiť s týmito výrobkami, 
mali kontaktovať buď predajcu, ktorý im ich predal, alebo príslušný úrad v mieste ich bydliska. Priemyselní používatelia by mali kontaktovať 
svojho dodávateľa a preveriť si podmienky kúpnej zmluvy. Tento výrobok a ani jeho elektronické príslušenstvo by nemali byť likvidované 
spolu s ostatným priemyselným odpadom.

[Slovensky]

Cum se elimină corect acest produs (Deşeuri de echipamente electrice şi electronice) 
(Aplicabil în ţările Uniunii Europene şi în alte ţări cu sisteme de colectare selectivă)
Acest simbol de pe produs, accesorii şi documentaţie indică faptul că produsul şi accesoriile sale electronice (încărcător, căşti, cablu USB) 
nu trebuie eliminate împreună cu alte deşeuri menajere la finalul duratei lor de utilizare. Dat fiind că eliminarea necontrolată a deşeurilor 
poate dăuna mediului înconjurător sau sănătăţii umane, vă rugăm să separaţi aceste articole de alte tipuri de deşeuri şi să le reciclaţi în 
mod responsabil, promovând astfel reutilizarea durabilă a resurselor materiale. Utilizatorii casnici trebuie să-l contacteze pe distribuitorul 
care le-a vândut produsul sau să se intereseze la autorităţile locale unde şi cum pot să ducă aceste articole pentru a fi reciclate în mod 
ecologic. Utilizatorii comerciali trebuie să-şi contacteze furnizorul şi să consulte termenii şi condiţiile din contractul de achiziţie. Acest produs 
şi accesoriile sale electronice nu trebuie eliminate împreună cu alte deşeuri comerciale.

[Română]

Izstrādājuma pareiza likvidēšana (Attiecas uz nolietotām elektriskām un elektroniskām ierīcēm) 
(Spēkā Eiropas Savienībā un pārējās Eiropas valstīs, kas izmanto atkritumu dalītu savākšanu)
Šis uz izstrādājuma un tā piederumiem vai pievienotajā dokumentācijā izvietotais marķējums norāda, ka izstrādājumu un tā elektroniskos 
piederumus (piem., uzlādes ierīci, austiņas, USB kabeli) pēc ekspluatācijas laika beigām nedrīkst likvidēt kopā ar citiem sadzīves 
atkritumiem. Lai nepieļautu atkritumu nekontrolētas likvidēšanas radītu varbūtēju kaitējumu videi un cilvēku veselībai, lūdzam minētās ierīces 
nošķirt no citiem atkritumiem un disciplinēti nodot pienācīgai pārstrādei, tā sekmējot materiālo resursu atkārtotu izmantošanu. Lai uzzinātu, 
kur un kā minētās ierīces iespējams nodot ekoloģiski drošai pārstrādei, mājsaimniecībām jāsazinās ar izstrādājuma pārdevēju vai savu 
pašvaldību. Iestādēm un uzņēmumiem jāsazinās ar izstrādājuma piegādātāju un jāiepazīstas ar pirkuma līguma nosacījumiem. Izstrādājumu 
un tā elektroniskos piederumus nedrīkst nodot likvidēšanai kopā ar citiem iestāžu un uzņēmumu atkritumiem.

[Latviešu]

Tinkamas šio gaminio išmetimas (elektros ir elektroninės įrangos atliekos)
Šis ženklas, pateiktas ant gaminio, jo priedų ar dokumentacijoje, nurodo, kad gaminio ir jo elektroninių priedų (pvz., įkroviklio, ausinių, 
USB kabelio) negalima išmesti kartu su kitomis buitinėmis atliekomis gaminio naudojimo laikui pasibaigus. Kad būtų išvengta galimos 
nekontroliuojamo atliekų išmetimo žalos aplinkai arba žmonių sveikatai ir skatinamas aplinką tausojantis antrinių žaliavų panaudojimas, 
atskirkite šiuos elementus nuo kitų rūšių atliekų ir atiduokite perdirbti. Informacijos kur ir kaip pristatyti šiuos elementus saugiai perdirbti, 
privatūs vartotojai turėtų kreiptis į parduotuvę, kurioje šį gaminį pirko, arba į vietos valdžios institucijas. Verslo vartotojai turėtų kreiptis 
į savo tiekėją ir peržiūrėti pirkimo sutarties sąlygas. Tvarkant atliekas, šio gaminio ir jo elektroninių priedų negalima maišyti su kitomis 
pramoninėmis atliekomis.

[Lietuvių]
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Õige viis toote kasutuselt kõrvaldamiseks (elektriliste ja elektrooniliste seadmete jäätmed)
Selline tähistus tootel või selle tarvikutel või dokumentidel näitab, et toodet ega selle elektroonilisi tarvikuid (nt laadija, peakomplekt, USB-
kaabel) ei tohi kasutusaja lõppemisel kõrvaldada koos muude olmejäätmetega. Selleks et vältida jäätmete kontrollimatu kõrvaldamisega 
seotud võimaliku kahju tekitamist keskkonnale või inimeste tervisele ning edendada materiaalsete vahendite säästvat taaskasutust, 
eraldage need esemed muudest jäätmetest ja suunake need vastutustundlikult taasringlusse. Kodukasutajad saavad teavet nende esemete 
keskkonnaohutu ringlussevõtu kohta kas toote müüjalt või keskkonnaametist. Firmad peaksid võtma ühendust tarnijaga ning kontrollima 
ostulepingu tingimusi ja sätteid. Toodet ega selle elektroonilisi tarvikuid ei tohi panna muude hävitamiseks mõeldud kaubandusjäätmete 
hulka.

[Eesti]
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Correct disposal of batteries in this product 
(Applicable in the European Union and other European countries with separate battery return systems.) 
This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. To protect natural resources and to promote material reuse, please separate batteries from other types of 
waste and recycle them through your local, free battery return system.

[English]
Elimination des batteries de ce produit 
(Applicable aux pays de l’Union européenne et aux autres pays européens dans lesquels des systèmes de collecte sélective sont mis en 
place.)
Le symbole sur la batterie, le manuel ou l’emballage indique que les batteries de ce produit ne doivent pas être éliminées en fin de vie avec 
les autres déchets ménagers. L’indication éventuelle des symboles chimiques Hg, Cd ou Pb signifie que la batterie contient des quantités de 
mercure, de cadmium ou de plomb supérieures aux niveaux de référence stipulés dans la directive CE 2006/66. Si les batteries ne sont pas 
correctement éliminées, ces substances peuvent porter préjudice à la santé humaine ou à l’environnement. Afin de protéger les ressources 
naturelles et d’encourager la réutilisation du matériel, veillez à séparer les batteries des autres types de déchets et à les recycler via votre 
système local de collecte gratuite des batteries.

[Français]
Korrekte Entsorgung der Batterien dieses Produkts 
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem separaten Altbatterie-Rücknahmesystem)
Die Kennzeichnung auf der Batterie bzw. auf der dazugehörigen Dokumentation oder Verpackung gibt an, dass die Batterie zu diesem 
Produkt nach seiner Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll entsorgt werden darf. Wenn die Batterie mit den 
chemischen Symbolen Hg, Cd oder Pb gekennzeichnet ist, liegt der Quecksilber-, Cadmium- oder Blei-Gehalt der Batterie über den in der 
EG-Richtlinie 2006/66 festgelegten Referenzwerten. Wenn Batterien nicht ordnungsgemäß entsorgt werden, können sie der menschlichen 
Gesundheit bzw. der Umwelt schaden. Bitte helfen Sie, die natürlichen Ressourcen zu schützen und die nachhaltige Wiederverwertung 
von stofflichen Ressourcen zu fördern, indem Sie die Batterien von anderen Abfällen getrennt über Ihr örtliches kostenloses Altbatterie-
Rücknahmesystem entsorgen.

[Deutsch]
Correcte behandeling van een gebruikte accu uit dit product
(Van toepassing op de Europese Unie en andere Europese landen met afzonderlijke inzamelingssystemen voor accu’s en batterijen.)
Dit merkteken op de accu, handleiding of verpakking geeft aan dat de accu in dit product aan het einde van de levensduur niet samen met 
ander huishoudelijk afval mag worden weggegooid. De chemische symbolen Hg, Cd of Pb geven aan dat het kwik-, cadmium- of loodgehalte 
in de accu hoger is dan de referentieniveaus in de Richtlijn 2006/66/EC. Indien de gebruikte accu niet op de juiste wijze wordt behandeld, 
kunnen deze stoffen schadelijk zijn voor de gezondheid van mensen of het milieu. Ter bescherming van de natuurlijke hulpbronnen en ter 
bevordering van het hergebruik van materialen, verzoeken wij u afgedankte accu’s en batterijen te scheiden van andere soorten afval en 
voor recycling aan te bieden bij het gratis inzamelingssysteem voor accu’s en batterijen in uw omgeving.

[Nederlands]
Corretto smaltimento delle batterie del prodotto
(Applicabile nei paesi dell’Unione Europea e in altri paesi europei con sistemi di conferimento differenziato delle batterie.)  
Il marchio riportato sulla batteria o sulla sua documentazione o confezione indica che le batterie di questo prodotto non devono essere 
smaltite con altri rifiuti domestici al termine del ciclo di vita. Dove raffigurati, i simboli chimici Hg, Cd o Pb indicano che la batteria contiene 
mercurio, cadmio o piombo in quantità superiori ai livelli di riferimento della direttiva UE 2006/66. Se le batterie non vengono smaltite 
correttamente, queste sostanze possono causare danni alla salute umana o all’ambiente. Per proteggere le risorse naturali e favorire il 
riutilizzo dei materiali, separare le batterie dagli altri tipi di rifiuti e riciclarle utilizzando il sistema di conferimento gratuito previsto nella propria 
area di residenza.

[Italiano]
Eliminación correcta de las baterías de este producto
(Aplicable en la Unión Europea y en otros países europeos con sistemas de recogida selectiva de baterías.)  
La presencia de esta marca en las baterías, el manual o el paquete del producto indica que cuando haya finalizado la vida útil de las 
baterías no deberán eliminarse junto con otros residuos domésticos. Los símbolos químicos Hg, Cd o Pb, si aparecen, indican que la batería 
contiene mercurio, cadmio o plomo en niveles superiores a los valores de referencia admitidos por la Directiva 2006/66 de la Unión Europea. 
Si las baterías no se desechan convenientemente, estas sustancias podrían provocar lesiones personales o dañar el medioambiente. Para 
proteger los recursos naturales y promover el reciclaje, separe las baterías de los demás residuos y recíclelas mediante el sistema de 
recogida gratuito de su localidad.

[Español]
Eliminação correcta das baterias existentes neste produto
(Aplicável na União Europeia e noutros países europeus com sistemas de recolha de baterias separados.)
Esta marca, apresentada na bateria, manual ou embalagem, indica que as baterias existentes neste produto não devem ser eliminadas 
juntamente com os resíduos domésticos indiferenciados no final do seu período de vida útil. Onde existentes, os símbolos químicos Hg, Cd 
ou Pb indicam que a bateria contém mercúrio, cádmio ou chumbo acima dos níveis de referência indicados na Directiva CE 2006/66. Se as 
baterias não forem correctamente eliminadas, estas substâncias poderão ser prejudiciais para a saúde humana ou para o meio ambiente. 
Para proteger os recursos naturais e promover a reutilização dos materiais, separe as baterias dos outros tipos de resíduos e recicle-as 
através do sistema gratuito de recolha local de baterias.

[Português]
Ustrezno odstranjevanje baterij v tem izdelku
(Uporabno v EU in ostalih evropskih državah s sistemi ločenega odstranjevanja baterij)
Ta oznaka na bateriji, v navodilih ali na embalaži pomeni, da baterij ob izteku njihove življenjske dobe v tem izdelku ne smete odstraniti 
skupaj z ostalimi gospodinjskimi odpadki. Oznake za kemijske elemente Hg, Cd ali Pb pomenijo, da baterija vsebuje živo srebro, kadmij ali 
svinec v količinah, ki presegajo referenčne nivoje v direktivi EC 2006/66. Če te baterije niso ustrezno odstranjene, te snovi lahko škodujejo 
zdravju ljudi oziroma okolju. Za zaščito naravnih virov in za vzpodbujanje ponovne uporabe materialov prosimo, ločite te baterije od ostalih 
odpadkov in jih oddajte na predvidenih lokalnih zbirnih reciklažnih mestih.

[Slovenščina]
Korrekt avfallshantering av batterierna i denna produkt
(Gäller EU och andra europeiska länder med särskild batteriåtervinning.) Denna markering på batteriet, i manualen eller på förpackningen 
anger att batterierna i denna produkt inte bör slängas tillsammans med annat hushållsavfall. De kemiska symbolerna Hg, Cd eller Pb 
visar i förekommande fall att batterierna innehåller kvicksilver, kadmium eller bly i mängder överstigande de gränsvärden som anges i 
EU-direktivet 2006/66. Om batterierna inte slängs på ett ansvarsfullt sätt kan dessa substanser utgöra en fara för hälsa eller miljö. Hjälp till 
att skydda naturresurser och bidra till materialåtervinning genom att sortera batterierna separat från annat avfall och lämna in dem på en 
återvinningsstation.

[Svenska]
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KKorrekt bortskaffelse af batterierne i dette produkt
(Gælder i EU og andre europæiske lande med særlige retursystemer for batterier).
Mærket på dette batteri, dokumentationen eller emballagen betyder, at batterierne i dette produkt efter endt levetid ikke må bortskaffes 
sammen med andet husholdningsaffald. Mærkning med de kemiske symboler Hg, Cd eller Pb betyder, at batteriet indeholder kviksølv, 
cadmium eller bly over grænseværdierne i EU-direktiv 2006/66. Hvis batterierne ikke bortskaffes korrekt, kan disse stoffer være skadelige 
for menneskers helbred eller for miljøet. For at beskytte naturens ressourcer og fremme genbrug, skal batterier holdes adskilt fra andre typer 
affald og genanvendes via dit lokale, gratis batteriretursystem.

[Dansk]

Korrekt avhending av batterier i dette produkt
(Kommer til anvendelse i Den europeiske union og i andre europeiske land med separate systemer for retur av batterier.)
Denne merkingen på batteriet, håndboken eller emballasjen angir at batteriene i dette produktet ikke skal kastes sammen med annet 
husholdningsavfall ved slutten av sin levetid. Der det er merket, angir de kjemiske symbolene Hg, Cd eller Pb at batteriet inneholder 
kvikksølv, kadmium eller bly over referansenivåene i EF-direktiv 2006/66. Hvis batteriene ikke avhendes på riktig måte, kan disse stoffene 
skade menneskers helse eller miljøet. For å beskytte naturressurser og for å fremme gjenbruk av materialer, ber vi deg adskille batterier fra 
andre typer avfall og resirkulere dem ved å levere dem på din lokale, gratis mottaksstasjon.

[Norsk]

Tuotteen paristojen oikea hävittäminen
(Koskee Euroopan Unionia ja muita Euroopan maita, joissa on erillinen paristojen palautusjärjestelmä.)
Pariston, käyttöoppaan tai pakkauksen tämä merkintä tarkoittaa, että tämän tuotteen sisältämiä paristoja ei saa hävittää muun 
kotitalousjätteen seassa, kun niiden käyttöikä on päättynyt. Kemiallinen symboli Hg, Cd tai Pb ilmaisee, että paristo sisältää elohopeaa, 
kadmiumia tai lyijyä ylin EU: n direktiivien 2006/66 viiterajojen. Jos paristoja ei hävitetä oikein, nämä aineet voivat vahingoittaa ihmisten 
terveyttä tai ympäristöä. Suojaa luonnonvaroja ja edistä materiaalien uusiokäyttöä - erottele paristot muusta jätteestä ja toimita ne 
kierrätettäväksi paikalliseen maksuttomaan paristojen palautusjärjestelmään.

[Suomi]

A termékhez tartozó akkumulátorok megfelelő ártalmatlanítása
(Az Európai Unió területén és más, önálló akkumulátorleadó rendszerrel rendelkező európai országok területén alkalmazandó.)
Az akkumulátoron, a kézikönyvön vagy a csomagoláson szereplő jelzés arra utal, hogy hasznos élettartama végén a terméket nem 
szabad egyéb háztartási hulladékkal együtt kidobni. Ahol szerepel a jelzés, a Hg, Cd vagy Pb kémiai elemjelölések arra utalnak, hogy 
az akkumulátor az EK 2006/66. számú irányelvben rögzített referenciaszintet meghaladó mennyiségű higanyt, kadmiumot vagy ólmot 
tartalmaz. Az akkumulátorok nem megfelelő kezelése esetén ezek az anyagok veszélyt jelenthetnek az egészségre vagy a környezetre. 
A természeti erőforrások megóvása és az anyagok újrafelhasználásának ösztönzése érdekében kérjük, különítse el az akkumulátorokat a 
többi hulladéktól és vigye vissza a helyi, ingyenes akkumulátorleadó helyre.

[Magyar]

Sposób poprawnego usuwania baterii, w które wyposażony jest niniejszy produkt
(Dotyczy obszaru Unii Europejskiej oraz innych krajów europejskich posiadających oddzielne systemy zwrotu zużytych baterii.)
Niniejsze oznaczenie na baterii, instrukcji obsługi lub opakowaniu oznacza, że po upływie okresu użytkowania baterie, w które wyposażony 
był dany produkt, nie mogą zostać usunięte wraz z innymi odpadami pochodzącymi z gospodarstw domowych. Przy zastosowaniu takiego 
oznaczenia symbole chemiczne (Hg, Cd lub Pb) wskazują, że dana bateria zawiera rtęć, kadm lub ołów w ilości przewyższającej poziomy 
odniesienia opisane w dyrektywie WE 2006/66. Jeśli baterie nie zostaną poprawnie zutylizowane, substancje te mogą powodować 
zagrożenie dla zdrowia ludzkiego lub środowiska naturalnego. Aby chronić zasoby naturalne i promować ponowne wykorzystanie 
materiałów, należy oddzielać baterie od innego typu odpadów i poddawać je utylizacji poprzez lokalny, bezpłatny system zwrotu baterii.

[Polski]

Σωστή απόρριψη των μπαταριών αυτού του προϊόντος 
(Ισχύει στην Ευρωπαϊκή Ένωση και άλλες ευρωπαϊκές χώρες με συστήματα ξεχωριστής ανακύκλωσης μπαταριών.)
Αυτή η επισήμανση πάνω στη μπαταρία, το εγχειρίδιο ή τη συσκευασία υποδεικνύει ότι οι μπαταρίες αυτού του προϊόντος δεν πρέπει να 
απορρίπτονται μαζί με άλλα οικιακά απορρίμματα στο τέλος του κύκλου ζωής τους. Όπου υπάρχουν, τα χημικά σύμβολα Hg, Cd ή Pb 
υποδεικνύουν ότι η μπαταρία περιέχει υδράργυρο, κάδμιο ή μόλυβδο πάνω από τα επίπεδα αναφοράς της Ευρωπαϊκής Οδηγίας 2006/66. 
Αν οι μπαταρίες δεν απορριφθούν σωστά, αυτές οι ουσίες ενδέχεται να προκαλέσουν βλαβερές συνέπειες στην ανθρώπινη υγεία ή το 
περιβάλλον. Παρακαλούμε διαχωρίζετε τις μπαταρίες από άλλους τύπους απορριμμάτων και ανακυκλώνετέ τις μέσω του τοπικού σας, 
δωρεάν συστήματος ανακύκλωσης μπαταριών, για την προστασία των φυσικών πόρων και την προώθηση της επαναχρησιμοποίησης 
υλικών.

[Ελληνικά]

Правилно изхвърляне на батериите в този продукт
(Приложимо в Европейския съюз и други европейски държави със самостоятелни системи за връщане на батерии.)
Това обозначение върху батерията, ръководството или опаковката, показва, че батериите в този продукт не бива да се изхвърлят 
с другите битови отпадъци в края на техния полезен живот. Където са маркирани, химическите символи Hg, Cd или Pb показват, 
че батерията съдържа живак, кадмий или олово над контролните нива в Директива 2006/66 на ЕО. Ако батериите не се изхвърлят 
правилно, тези вещества могат да предизвикат увреждане на човешкото здраве или на околната среда. За да предпазите 
природните ресурси и за да съдействате за многократната употреба на материалните ресурси, моля отделяйте батериите от 
другите видове отпадъчни продукти и ги рециклирайте посредством Вашата локална система за безплатно връщане на батерии.

[Български]
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Správná likvidace baterií v tomto výrobku
(Platí v Evropské unii a dalších evropských zemích s vlastními systémy zpětného odběru baterií.)
Tato značka na baterii, návodu nebo obalu znamená, že baterie v tomto výrobku nesmí být na konci své životnosti likvidovány společně s 
jiným domovním odpadem. Případně vyznačené symboly chemikálií Hg, Cd nebo Pb upozorňují na to, že baterie obsahuje rtuť, kadmium 
nebo olovo v množství překračujícím referenční úrovně stanovené směrnicí ES 2006/66. Pokud baterie nejsou správně zlikvidovány, mohou 
tyto látky poškodit zdraví osob nebo životní prostředí. Pro ochranu přírodních zdrojů a pro podporu opakovaného využívání materiálů 
oddělte, prosím, baterie od ostatních typů odpadu a nechte je recyklovat prostřednictvím místního bezplatného systému zpětného odběru 
baterií.

[Čeština]

Správna likvidácia batérií v tomto výrobku 
(Aplikovateľné v krajinách Európskej únie a v ostatných európskych krajinách, v ktorých existujú systémy separovaného zberu batérií.)
Toto označenie na batérii, príručke alebo balení hovorí, že batérie v tomto výrobku by sa po skončení ich životnosti nemali likvidovať spolu 
s ostatným domovým odpadom. V prípade takéhoto označenia chemické symboly Hg, Cd alebo Pb znamenajú, že batéria obsahuje ortuť, 
kadmium alebo olovo v množstve presahujúcom referenčné hodnoty smernice 2006/66/ES. Pri nevhodnej likvidácii batérií môžu tieto látky 
poškodiť zdravie alebo životné prostredie. Za účelom ochrany prírodných zdrojov a podpory opätovného použitia materiálu batérie likvidujte 
oddelene od iných typov odpadou a recyklujte ich prostredníctvom miestneho systému bezplatného zberu batérií.

[Slovensky]

Dispoziţii privind eliminarea corectă a bateriilor acestui produs 
(aplicabile în Uniunea Europeană şi în alte ţări europene cu sisteme separate de colectare a bateriilor)
Acest marcaj de pe baterie, de pe manualul de utilizare sau de pe ambalaj indică faptul că bateriile acestui produs nu trebuie eliminate 
împreună cu alte deşeuri menajere la sfârşitul ciclului lor de viaţă. Dacă sunt marcate, simbolurile chimice Hg, Cd sau Pb indică faptul că 
bateria conţine mercur, cadmiu sau plumb peste nivelurile de referinţă prevăzute în Directiva CE 2006/66. În cazul în care bateriile nu sunt 
eliminate corespunzător, aceste substanţe pot fi dăunătoare pentru sănătatea omului sau pentru mediu. În vederea protejării resurselor 
naturale şi a promovării refolosirii materialelor, vă rugăm să separaţi bateriile de celelalte tipuri de deşeuri şi să le reciclaţi prin intermediul 
sistemului gratuit de returnare a bateriilor la nivel local.

[Română]

Šī izstrādājuma bateriju pareiza utilizācija
(Piemērojama Eiropas Savienībā un citās Eiropas valstīs ar atsevišķām bateriju nodošanas sistēmām.)
Šis marķējums uz baterijas, rokasgrāmatā vai uz iepakojuma norāda, ka šī izstrādājuma bateriju pēc tās kalpošanas laika beigām nedrīkst 
izmest ar citiem sadzīves atkritumiem. Ja uz baterijas ir atzīmēti ķīmiskie simboli, piem., Hg, Cd vai Pb, tie norāda, ka baterija satur 
dzīvsudrabu, kadmiju vai svinu, kura saturs ir lielāks par EK Direktīvā 2006/66 minētajiem lielumiem. Ja baterijas tiek nepareizi likvidētas, šīs 
vielas var radīt kaitējumu cilvēku veselībai vai videi. Lai aizsargātu dabas resursus un veicinātu materiālu otrreizēju izmantošanu, šķirojiet 
baterijas atsevišķi no citiem atkritumu veidiem un nododiet tās otrreizējai pārstrādei, izmantojot bateriju vietējo bezmaksas nodošanas 
sistēmu.

[Lietuvių]

Tinkamas šio produkto akumuliatorių tvarkymas
(Taikoma Europos Sąjungoje ir kitose Europos šalyse, kuriose galioja atskiros akumuliatorių grąžinimo sistemos.)
Šis ženklas yra pateikiamas ant akumuliatoriaus, jo dokumentacijoje ar ant pakuotės nurodo, kad šio produkto akumuliatorių, pasibaigus 
jų tarnavimo laikui, negalima išmesti kartu su kitomis buitinėmis atliekomis. Cheminiai simboliai Hg, Cd arba Pb rodo, kad akumuliatoriuje 
yra gyvsidabrio, kadmio ar švino, kurio kiekis viršija normą, nurodytą ES direktyvoje 2006/66. Jei akumuliatoriai nebus tinkamai išmesti, 
šios medžiagos gali sukelti žalos žmonių sveikatai ar aplinkai. Tam, kad būtų apsaugoti gamtos ištekliai ir skatinamas antrinių žaliavų 
panaudojimas, pašome atskirti akumuliatorių nuo kitų rūšių atliekų ir atiduoti perdirbti vietinėje akumuliatorių grąžinimo sistemai.

[Lietuvių]

Őige viis toote akude kasutusest kőrvaldamiseks
(Rakendatav Euroopa Liidus ja teistes Euroopa riikides, kus on kasutusel spetsiaalsed akude kogumissüsteemid).
Selline tähistus akul, dokumentidel vői pakendil näitab, et toote akusid ei tohi kasutusaja lőppemisel kőrvaldada koos muude 
olmejäätmetega. Keemilised elemendid Hg, Cd, vői Pb näitavad, et aku elavhőbeda, kaadmiumi vői plii sisaldus on EÜ direktiivi 2006/66 
sihttasemest suurem. Kui akusid ei kőrvaldata őigel viisil, vőib nende sisu pőhjustada tervise-vői keskkonnakahjustusi. Selleks, et kaitsta 
loodusvarasid ja edendada materjalide taaskasutamist, eraldage akud muudest jäätmetest ja suunake need taaskasutusse kohaliku, tasuta 
teenusena pakutava akude tagastussüsteemi abil.

[Eesti]
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